CONTENTS

Preface ix

Document Conventions ix

Obtaining Documentation and Submitting a Service Request x

CHAPTER 1
Overview 1-1

Basic DMS Concepts and Vocabulary 1-1
Client System Requirements 1-1
Understanding DMM Modules and Features 1-2

CHAPTER 2
Managing Administrative Settings for Cisco DMS Components and Users 2-1

Starting DMS Administration Module (DMS-Admin) 2-1
Using and Understanding Dashboard Gauges for DMS-Admin 2-2
Managing Licenses for Features and Components of Cisco DMS 2-3
Obtaining and Installing License Keys for Software Features 2-3
Viewing the List of Installed Licenses 2-4
Managing User Accounts and Authentication Settings 2-4
Understanding User Management Concepts and Workflow 2-5
Configuring User Accounts Manually 2-6
Creating and Editing User Accounts 2-6
Deleting User Accounts 2-7
Understanding User Roles in DMS-Admin 2-8
Configuring Authentication Settings 2-8
Backing Up and Restoring 2-16
Managing Email, SNMP, Alerts, and Notifications 2-16
Enabling or Disabling Email 2-17
Enabling or Disabling SNMP 2-17
Configuring Alert Reports and Notification Settings 2-18
Understanding Event Types 2-19
Viewing Appliance Processes and Restarting Appliances Remotely 2-20
Managing Digital Signage and Enterprise TV  3-1

Overview  3-1
Starting Digital Signage Module (DMM-DSM)  3-2
Starting Enterprise TV Module (DMM-ETV)  3-2
Understanding Dashboard Gauges for Digital Signage and Enterprise TV  3-3
Configuring Your DMPs to Support Centralized Management  3-4
Enabling the CVBS (Composite Video) Interface on DMPs  3-5
Managing and Grouping Your DMPs  3-6
Configuring the Settings for an Enterprise TV Network  3-10
Understanding the Typical Workflow for Enterprise TV  3-11
Configuring Settings for TV Channels  3-12
Understanding the TV Channels Table  3-13
Adding New Channels  3-15
Editing Channels  3-18
Reassigning Channel Numbers  3-19
Deleting Channels  3-19
Listing Only the Defined (Active) or Undefined (Inactive) TV Channels  3-19
Configuring Subscription Settings for EPG Providers  3-20
Adding or Editing Subscriptions to Data from an EPG Provider  3-21
Deleting EPG Data Subscriptions  3-22
Synchronizing TV Channel Schedules and Program Descriptions for the EPG  3-22
Configuring Enterprise TV Settings for Video on Demand  3-23
Working With VoD Categories  3-23
Mapping a Video to a VoD Category  3-25
Organizing Videos in VoD Categories  3-25
Removing a Video from a Category  3-26
Using ‘Skins’ to Customize the Enterprise TV Main Menu  3-26
Working with Assets and Categories in Your Media Library  3-27
Working with Presentations, Templates, and Presentation Playlists for Digital Signage  3-33
Before You Start to Use Digital Media Designer  3-34
Getting Started with DMD  3-35
DMD User Interface Reference  3-37
Understanding the Menus and Their Options  3-38
Understanding the Toolbar and Its Options  3-41
Understanding the Panels and Their Options  3-42
Creating and Organizing Presentation Playlists  3-49
Understanding the Playlist Items Area and Its Options  3-51
Understanding the Content Chooser and Its Options  3-52
Managing Desktop Video 4-1

Using Features Under the Setup Tab 4-1
- Configuring Administrative and Network Settings 4-2
  - Administrative and Network Settings 4-2
- Viewing Environment Parameters 4-3
- Configuring the Settings to Use a Video Portal 4-3
  - DMM-VPM Use Settings 4-4
- Configuring the Location Settings for Deployments 4-5
  - Deployment Location Settings 4-6

Using Features Under the Users Tab 4-7
- Working with User Accounts 4-7
  - User Account Settings 4-7
- Viewing Your Profile 4-8

Using Features Under the Video Portal Tab 4-8
- Working with Programs, Videos and Video Parts 4-9
  - Content Object Settings 4-10
- Approving or Denying the Request to Approve a Video Part or Playlist 4-18
- Understanding the Live Event Module 4-18
- Understanding and Working with Synchronized Slides 4-18
  - Generating and Importing the Slides to Be Synchronized 4-19
  - Operating a Slide Show 4-21
  - What Video Portal Audiences See When You Use Synchronized Slides 4-21
- Understanding and Working with Audience Questions 4-21
  - Moderating Questions 4-22
  - Answering Questions 4-24
- Creating and Working with Playlists 4-24
- Creating and Working with Content Categories 4-26
  - Category Settings 4-27
- Creating and Working with Interstitials 4-28
  - Interstitial Settings 4-29
- Creating and Working with Interstitial Sequences 4-30
  - Interstitial Sequence Settings 4-30
- Creating and Working with Tickers 4-31
  - Ticker Settings 4-32
- Customizing Your Video Portal 4-33
  - Customization Settings 4-34
- Configuring the Settings to Manage Deployments 4-36
  - Understanding Event Types 4-37
  - Scheduling a New Deployment 4-38
<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduling a Pre-Event Listing                                        4-39</td>
</tr>
<tr>
<td>Scheduling a Live Event                                               4-40</td>
</tr>
<tr>
<td>Scheduling a Post-Event Listing                                       4-40</td>
</tr>
<tr>
<td>Scheduling an On-Demand Deployment                                   4-41</td>
</tr>
<tr>
<td>Learning the URL for a Deployed Video Part                            4-41</td>
</tr>
<tr>
<td>Using Features Under the Encoders Tab                                4-42</td>
</tr>
<tr>
<td>Adding an Encoder to DMM-VPM                                          4-42</td>
</tr>
<tr>
<td>Testing the Ability to Publish Streams                                4-43</td>
</tr>
<tr>
<td>Capturing a Live Stream and Publishing the Output File as Video On-Demand 4-44</td>
</tr>
<tr>
<td>Managing Push Configurations                                          4-45</td>
</tr>
<tr>
<td>Creating and Working with Encoding Formats                            4-46</td>
</tr>
<tr>
<td>Managing Transcoding Jobs                                            4-47</td>
</tr>
<tr>
<td>Workflows for Setting Up Live Events                                 4-48</td>
</tr>
<tr>
<td>Using Your DME 1000 or DME 2000 to Set Up a Live Event                4-49</td>
</tr>
<tr>
<td>Modifying the Scheduled Times for DME Live Events                     4-51</td>
</tr>
<tr>
<td>Setting Up Live Events Using Third-Party Live Streams                4-52</td>
</tr>
</tbody>
</table>

**APPENDIX A**

Using Video Portal Reports A-1
Preface

Revised: July 22, 2008, OL-15762-01

Cisco Digital Media System is the collective name for a product family that consists of Cisco Digital Media Manager (DMM) appliances, Cisco Video Portal appliances, Cisco Digital Media Player (DMP) endpoints, Cisco Digital Media Encoder (DME) devices, and all associated software components.

This guide tells you how to use the software modules that you licensed for your Cisco Digital Media Manager 5.0 software and how to use the Cisco Video Portal Reports 5.0 software that is preinstalled on a Video Portal appliance. Depending on the software feature module licenses that you purchase, DMM helps you to create and manage an online video portal, create and manage a digital signage network, create and manage an enterprise TV network, or do all of these.

The intended audience for this guide is DMM users who create, publish, or manage media for desktop video, digital signage, or enterprise TV. This guide is not meant for systems or network administrators who install, configure, or troubleshoot DMS products. See Cisco.com for related DMS and DMM user documentation.

Document Conventions

This guide uses these text formatting conventions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Convention</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commands and keywords</td>
<td><strong>boldface</strong> font</td>
</tr>
<tr>
<td>Variables for which you supply values</td>
<td><em>italic</em> font</td>
</tr>
<tr>
<td>Displayed session and system information</td>
<td><em>screen</em> font</td>
</tr>
<tr>
<td>Information you enter</td>
<td><strong>boldface</strong> <em>screen</em> font</td>
</tr>
<tr>
<td>Variables you enter</td>
<td><em>italic</em> <em>screen</em> font</td>
</tr>
<tr>
<td>Menu items and button names</td>
<td><strong>boldface</strong> font</td>
</tr>
<tr>
<td>Selecting a menu item in paragraphs</td>
<td>Option &gt; Network Preferences</td>
</tr>
<tr>
<td>Selecting a menu item in tables</td>
<td>Option &gt; Network Preferences</td>
</tr>
</tbody>
</table>

*Note* Means *reader take note*. Notes contain helpful suggestions or references to material not covered in the publication.
Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What's New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.
Overview

Revised: July 22, 2008, OL-15762-01

This overview contains the following sections:

- Basic DMS Concepts and Vocabulary, page 1-1
- Client System Requirements, page 1-1
- Understanding DMM Modules and Features, page 1-2

Basic DMS Concepts and Vocabulary

DMS helps organizations of any size to create, manage, organize, and deliver video content (whether live or on-demand) and digital signage content over an IP network to any general or targeted audience. With DMS, you can:

- Communicate with targeted customers, investors, press, and analysts.
- Deliver live and on-demand events to audiences in any location.
- Deliver critical information and training to employees, suppliers, and partners.
- Deliver educational content to students.

To understand some of the most commonly used DMS terms, abbreviations, and initialisms, see FAQs and Troubleshooting Guide for Cisco Digital Media System 4.x and 5.x on Cisco.com.

Client System Requirements

To understand the client system requirements to use DMS products, see Release Notes for Cisco Digital Media System 5.0 on Cisco.com.
Understanding DMM Modules and Features

DMM features are organized into modules; you purchase separately the licenses to use the modules. Depending on what you purchase, you can use DMM to:

- Manage a digital video network and deliver video content to any audience.
- Manage digital signage and enterprise TV deliver content for them through your network.
- Manage both a digital video network and a digital signage network.

DMM includes an administrative module at no additional cost that helps you to install licenses to use the other modules. To understand the modules and learn about their features, see:

- Chapter 2, “Managing Administrative Settings for Cisco DMS Components and Users.”
- Chapter 3, “Managing Digital Signage and Enterprise TV.”
- Chapter 4, “Managing Desktop Video.”
Managing Administrative Settings for Cisco DMS Components and Users

Revised: December 4, 2008, OL-15762-01

Software feature modules for Cisco DMS are purchased and licensed separately. Features are hidden from all users until you purchase and install the required license to use them, and even then remain hidden from users whose privilege levels are low. To understand feature licenses and learn how to install them, see Managing Licenses for Features and Components of Cisco DMS, page 2-3. To learn how user access to features is restricted by the combination of licenses and user privilege levels, see Understanding User Roles in DMS-Admin, page 2-8. To learn which software feature modules are available for you to purchase, see http://www.cisco.com/go/dms.

Topics in this chapter describe features of DMS-Admin that help you to create and administer user accounts, permissions, and profiles for Cisco DMS products, configure the settings for authentication, administer the licenses for software feature modules, and more.

- Using and Understanding Dashboard Gauges for DMS-Admin, page 2-2
- Managing Licenses for Features and Components of Cisco DMS, page 2-3
- Managing User Accounts and Authentication Settings, page 2-4
- Backing Up and Restoring, page 2-16
- Managing Email, SNMP, Alerts, and Notifications, page 2-16
- Viewing Appliance Processes and Restarting Appliances Remotely, page 2-20

Starting DMS Administration Module (DMS-Admin)

Step 1
Do one of the following:

- On the DMM dashboard, click Administration.
- Choose Administration from the global navigation.
### Using and Understanding Dashboard Gauges for DMS-Admin

When you start DMS-Admin after you have installed at least the license key to use one software feature module, the landing page by default is a dashboard that shows five gauges. In addition, you can choose to see and use this dashboard at any time.

The dashboard for DSM-Admin centralizes all features for system monitoring and log collection. If problems of any kind interfere with the data-collection processes that populate its gauges, they will show question marks in addition to the best data that is available. In this case, check that your systems and network are configured and working correctly.

**Step 1** Click the **Dashboard** tab.

The gauges are as follows:

<table>
<thead>
<tr>
<th><strong>Table 2-1</strong></th>
<th><strong>DMS-Admin Gauges</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Alerts</td>
<td>Shows the total count of email and SNMP notification messages delivered in the past 1 hour. To jump directly to the Alerts page, click <strong>View Alerts</strong>. To understand the View Alerts page, see <strong>Managing Email, SNMP, Alerts, and Notifications</strong>, page 2-16.</td>
</tr>
<tr>
<td>License Features</td>
<td>Lists software feature module licenses that are installed on your DMM appliance and describes any constraints that these licenses impose.</td>
</tr>
</tbody>
</table>
| Status          | Summarizes the current state of your Video Portal appliance and of all registered DMPs in your network, assuming that you set up the hardware and installed the separately licensed software features for these device types. This gauge organizes data in these subsections:  
  • Digital Media Players—Counts the total number of registered DMPs and specifies how many were reachable or unreachable when you loaded this gauge in your browser. To jump directly to the DMP Manager page, click **View All DMPs and DMP Groups**. To understand DMP grouping and management practices, see **Managing and Grouping Your DMPs**, page 3-6.  
  • Video Portal Appliance—Shows you whether your Video Portal appliance\(^1\) was unreachable at any time in the past 1 hour. Counts the number of Video Portal deployments that were pending or completed when you loaded this gauge in your browser. To jump directly to the live HTTP URL of your Video Portal, click **Go to Video Portal**. To jump directly to the DMM-VPM landing page, click **Manage Video Portal**. To understand the management and configuration options for desktop video, see **Chapter 4, “Managing Desktop Video.”** |
| System Information| This gauge:  
  • Tells you the installed release version of your DMM server software.  
  • Shows free disk space and used disk space on your DMM appliance\(^2\) and Video Portal\(^3\) appliance.  
  • Tells you whether the most recent replication of data succeeded between your Cisco DMS appliances. |
| Users Logged In (Past 1 Hour) | Counts the total number of users who logged in to each of your DMS appliances over the past 1 hour. To jump directly to the Users page in DMS-Admin, click **View All Users**. To understand user account settings and authentication settings for Cisco DMS products, see **Managing User Accounts and Authentication Settings**, page 2-4. |

---

1. This DMM release supports your use of only one Video Portal appliance.
Managing Licenses for Features and Components of Cisco DMS

This section contains these topics:

- Obtaining and Installing License Keys for Software Features, page 2-3
- Viewing the List of Installed Licenses, page 2-4

Obtaining and Installing License Keys for Software Features

When you log in to DMM before you have installed the license key to use any software feature module, the landing page by default is the page in DMS-Admin (at Licensing > Install/Upgrade Licensing) where you can install a license key.

To obtain a license key and use it to activate the DMM software feature modules that you have purchased, do the following:

**Step 1** Confirm that you know the serial number and IP address for your DMM appliance. If you do not know the serial number or IP address, do the following:

a. At the login prompt on your DMM appliance, use the admin username and its associated password to log in to AAI. In the displayed menu, the SHOW_INFO option is highlighted by default.

b. Press Enter, and then write down these values that AAI shows to you:
   - The IP address for your DMM appliance.
   - The 10-character serial number for your DMM appliance.

**Step 2** Compose an email message that includes or identifies all of the following:

- All Cisco sales order numbers that were associated with your Cisco DMS purchase (such as, appliances, software modules for DMM, and DMPs), including even the sales order numbers for all purchased products and services that are not components of Cisco DMS.
- The 10-character DMM appliance serial number that AAI showed to you in Step 1-b.
- Your email address.
- The name of your organization.
- The department name within your organization.
- The DMM software feature module (or modules) that you purchased.
- If you purchased DMM software feature modules for digital signage or enterprise TV, include the number of DMPs that you will manage centrally. Permitted increments for the number of DMPs are multiples of 10.

**Step 3** Send the email message to dms-softwarekeys@cisco.com.

**Step 4** After you receive the license key file from Cisco, save a local copy of it.
Chapter 2    Managing Administrative Settings for Cisco DMS Components and Users

Managing User Accounts and Authentication Settings

Step 5   To load DMM in a web browser, use the DMM appliance IP address that you saw in AAI
(http://<DMM_IP_address>:8080/).

Step 6   To use DMS-Admin, do one of the following:
   • On the DMM dashboard, click Administration.  
   • Choose Administration from the global navigation.

Step 7   Choose Licensing > Install/Upgrade Licensing.

Step 8   Click Browse, find and click the license file where you saved it, and then click Open.

Note  The format for licenses in Cisco DMS 5.x differs from the obsoleted format that was used in
earlier DMS releases. This release does not support license files that use the obsoleted format,
and will reject such licenses as invalid if you try to install them.

Step 9   Click Install License.  

The pertinent software feature module is now enabled.

Tip  If you receive multiple license key files, repeat the procedure until all of your licenses are installed.

Viewing the List of Installed Licenses

To see which DMS features you have licensed:

Step 1   Choose Licensing > View Licensing.  

Alternatively, the License Features gauge on the DMS-Admin dashboard also lists software feature
module licenses that are installed on your DMM appliance. See Using and Understanding Dashboard
Gauges for DMS-Admin, page 2-2.

Managing User Accounts and Authentication Settings

Features of DMS-Admin help you to:
   • Assign differing levels of access and permissions to users of DMM feature modules, Video Portal
   Reports, and Video Portal, depending on their roles and responsibilities.
   • Make choices to enable or disable user authentication.  
   • Choose and configure an authentication method, such as LDAP (Active Directory). Optionally,
   import from your LDAP server the basic settings for any of its user accounts and user groups.

This section contains these topics:
   • Understanding User Management Concepts and Workflow, page 2-5
   • Configuring User Accounts Manually, page 2-6
Understanding User Management Concepts and Workflow

This worksheet will help you to understand the expected sequence of user management tasks as well as the important concepts that underlie them:

✓ Task

1. Work with any preexisting user accounts that you migrated from an earlier Cisco DMS release.
   - If you upgraded to Cisco DMS 5.0.x from any 4.1.x release on which you had licensed the features for digital signage networks, it is possible that some formerly redundant usernames from your licensed software modules are now unique. This will have occurred if an identical username was configured for use in both DMM-VPM and DMM-DSM. As just one possible example, you might have configured the username admin to work in both of these software modules. Migration during your upgrade will have consolidated all user accounts into DMS-Admin, and any redundant usernames from your preexisting DMM-DSM configuration now have a suffix appended to them. The suffix is exactly: _dsm. So, where this scenario supposes that the twice-used username was admin in Cisco DMS 4.1.x, the two migrated usernames in this newer Cisco DMS release would be:
     - admin (for the user account that you migrated from DMM-VPM).
     - admin_dsm (for the user account that you migrated from DMM-DSM).
   - You might now want to assign sufficient access rights and permissions to one of the migrated accounts so that you can delete the other account safely, without disrupting the approvals workflow or other established practices in your organization. In this example scenario, the ideal result might be that you are left with only one user account called admin, whose assigned rights and permissions across all of your installed Cisco DMS products are at least sufficient to manage all suitable features for desktop video and digital signage.
     - To understand at a high-level tasks what you must do to assign rights and permissions to user accounts in Cisco DMS 5.0.x, see Task 4.
     - To understand what you must do to delete an obsoleted user account that was formerly redundant, see Deleting User Accounts, page 2-7.

2. Create new user accounts. To create user accounts manually for DMM software modules, Video Portal Reports, and your Video Portal, you use DMS-Admin. Any user accounts that you create manually will be in addition to those whose creation you automate by importing user account data from an Active Directory server. To understand how to create user accounts manually, see Configuring User Accounts Manually, page 2-6.
   - By default, each new user account that you create has the DMS-Admin user role of “Other” until you assign access rights and privileges to it in at least one DMM software module. User accounts are severely limited in their access when they have this user role. See Understanding User Roles in DMS-Admin, page 2-8.

3. Create user groups. To create a new user group, choose Administration > Users > Create Group, and then enter the required values. To save your work, click Save.
Chapter 2    Managing Administrative Settings for Cisco DMS Components and Users

Managing User Accounts and Authentication Settings

Configuring User Accounts Manually

This section contains these topics:

- Creating and Editing User Accounts, page 2-6
- Deleting User Accounts, page 2-7

Creating and Editing User Accounts

Tip

You cannot create any new user accounts manually while your authentication method is LDAP. To understand the authentication options for Cisco DMS products, see Configuring Authentication Settings, page 2-8.

To create a new user account or to edit the settings manually for an account:

Step 1 Click the Users tab, and then do one of the following:
- To create a new account, click Add New User, and then enter the required values in the Add New User dialog box.
- To edit an account, click its entry in the untitled table that describes all user accounts, choose Options > Edit User, and then make changes to its values in the Edit User dialog box.

If you do not understand your options in the Add New|Edit User dialog box, see Table 2-2 on page 2-7.

Step 2 (Optional) Enter contact information and assign the user to a user group.

Step 3 Click Save.

Assign access rights and permissions.

After you create user accounts, you assign access rights and privileges separately for these users in the DMM software modules that pertain to them. The access rights and privileges that you assign to a user account are always specific to an environment for desktop video or digital signage (the latter of which includes enterprise TV). Therefore, you assign access rights and privileges to users in the individually licensed and separately installed DMM software modules that are applicable per user:

- For desktop video, choose Video Portal > Users > User Accounts. To understand user access settings and permission levels for desktop video, see Chapter 4, “Managing Desktop Video.”
- For digital signage or enterprise TV, choose Digital Signage > Settings > User Accounts. To understand user access settings and permission levels in a digital signage network, see Chapter 3, “Managing Digital Signage and Enterprise TV.”

Assign users to user groups.

When you first create a user account in DMS-Admin, you can associate the account with a user group immediately or you can do so after you assign access rights and permissions to the user.

1. To learn how to import user accounts from an Active Directory server, see Configuring Authentication Settings, page 2-8.
Managing User Accounts and Authentication Settings

Deleting User Accounts

You cannot delete the superuser account. To delete any other user account:

**Step 1**
Click the Users tab and then, in the untitled table, click the user account that should be deleted.
To mark multiple user accounts for deletion, Ctrl-click.

**Step 2**
Choose Options > Delete User.

<table>
<thead>
<tr>
<th>Table 2-2</th>
<th>Elements for Creating and Editing User Accounts Manually</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>First Name</td>
<td>This required value might be identical for multiple users.</td>
</tr>
<tr>
<td>Last Name</td>
<td>This required value might also be identical for multiple users.</td>
</tr>
<tr>
<td>Email Address</td>
<td>The email address to be associated with this user account.</td>
</tr>
<tr>
<td>Username</td>
<td>A unique username. The name is unique in the sense that you have not used it as the name for any other user account for any component of Cisco DMS. You must enter the username.</td>
</tr>
<tr>
<td>Password</td>
<td>The password for the user account. You must enter a password, then reenter it.</td>
</tr>
<tr>
<td>Re-enter password</td>
<td></td>
</tr>
<tr>
<td>Active list</td>
<td>Signifies whether the account holder is an active or inactive user of Cisco DMS. Alternatively, signifies whether the account holder is active in your organization.</td>
</tr>
</tbody>
</table>

**Optional Contact Info**

<table>
<thead>
<tr>
<th><strong>Element</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>The agency, corporation, nonprofit organization, or other such institution to be associated with this user account.</td>
</tr>
<tr>
<td>Department</td>
<td>The department within the institution.</td>
</tr>
<tr>
<td>Phone</td>
<td>The telephone number to be associated with this user account.</td>
</tr>
</tbody>
</table>

**Optional Group Selection**

<table>
<thead>
<tr>
<th><strong>Element</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlabeled check box</td>
<td>Marks the groups to which this user should belong.</td>
</tr>
<tr>
<td>Groups column</td>
<td>Shows the group name.</td>
</tr>
<tr>
<td>Description column</td>
<td>Optional, brief description of the group and its purpose.</td>
</tr>
</tbody>
</table>
Understanding User Roles in DMS-Admin

User roles in DMS-Admin are the automatic result of a logical operation. You cannot use DMS-Admin to assign a user role directly to any user.

In some cases, users who are authorized to log in to one DMM software module will be authorized also to log in to at least one additional software module. The DMS-Admin user role that you see for a user account is based on all privileges and access settings that the user has, combined across all of your licensed and installed DMM software modules. The logic that determines the DMS-Admin user role is as follows:

- The “Admin” user role is assigned automatically to any user who is an administrator in any DMM software module. These users have full read/write access to all users and user groups in DMS-Admin and can manage settings for them.
- The “Group Admin” user role is assigned automatically to any user who is a content author for desktop video but is not an administrator in any DMM software module. These users cannot see information about user accounts and groups in DMS-Admin, nor can they create, edit, or delete them. However, these users can create user groups as part of the workflow in DMM-VPM when they assign the rights to view a new or preexisting video part.
- The “Read-Only” user role is assigned automatically to any user who is neither a content author for desktop video nor an administrator in any DMM software module. These users can see information about users and user groups in DMS-Admin but cannot create, edit, or delete them.
- The “Other” user role in DMS-Admin is assigned automatically to any user who has not been granted any explicit access settings or privileges in any DMM software module, or who is part of the audience for a Video Portal but has no other privileges. These users are prevented from logging in to any DMM software module.

Configuring Authentication Settings

Two types of user authentication are available in Cisco DMS. Embedded authentication is completely native to DMM, while LDAP authentication causes Cisco DMS products to rely on a Microsoft Active Directory server.

Although Cisco DMS always requires one kind of authentication or the other, you can enable or disable authentication for users of Video Portal and Video Portal Reports. In addition, you can choose the user authentication method for DMM-DSM, DMM-ETV, DMM-VPM, Video Portal, and Video Portal Reports.

**Step 1** Choose Settings > Authentication.

The Authentication page contains four tabbed property sheets: Select Mode, Define Filter, Synchronize Users, and Manage Attributes. In most production environments, you can expect to use the Select Mode property sheet only one time. Nonetheless, your choices on the Select Mode property sheet determine whether you have access to the other three property sheets. Therefore, Select Mode is by default the only active tab.

**Step 2** Use elements on the Select Mode property sheet to enable or disable authentication and to choose an authentication mode. See Table 2-3 on page 2-9.
### Table 2-3  
**Elements for the Authentication Mode**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Authentication</td>
<td>Requires users who log in to authenticate (enter a username and password) against the user account database for DMM, but does not impose any authentication restrictions for access to Video Portal or Video Portal Reports.</td>
</tr>
<tr>
<td>Embedded Authentication</td>
<td>Requires users who log in to DMM-DSM, DMM-ETV, DMM-VPM, Video Portal, and Video Portal Reports to authenticate against a user account database that is native to DMM and is independent of every other type of authentication that you might use in your network.</td>
</tr>
<tr>
<td>LDAP Authentication</td>
<td>Automatically deletes all user accounts, except the superuser account. Requires future users to authenticate against the user account data from your Active Directory server when they log in to DMM-DSM, DMM-ETV, DMM-VPM, Video Portal, and Video Portal Reports.</td>
</tr>
</tbody>
</table>

Although the user account data originates from your Active Directory server, Cisco DMS does not synchronize (replicate) the data automatically, in real time. Instead, you must resynchronize the user account data whenever you think it is appropriate to do so. You can resynchronize manually or you can schedule synchronizations to recur in the future at intervals that you specify. To learn how to synchronize manually and how to schedule the automated recurrence of synchronizations, see the “Synchronization Mode” row in Table 2-5 on page 2-12.

**Note**  
Lightweight Directory Access Protocol (LDAP) is a highly complex data model and communications protocol for user authentication. The LDAP features in Cisco DMS are meant for use by qualified and experienced administrators of Microsoft Active Directory. Unless you are an Active Directory and LDAP expert, we recommend that you choose another option than LDAP.

Even though it is possible in Active Directory to use a blank value for a password, Cisco DMS does not allow it. Therefore, when you use LDAP authentication, any user whose Active Directory password is blank will be prevented from logging in to DMM-DSM, DMM-ETV, DMM-VPM, Video Portal, and Video Portal Reports until the password is changed on the Active Directory server. There is no requirement to resynchronize the affected user account in DMS-Admin after you change its password on your Active Directory server.

DMS-Admin synchronizes all user accounts in the Active Directory user base that you specify in a filter, **excluding the users whose accounts are marked as disabled** on your Active Directory server.

<table>
<thead>
<tr>
<th>Anonymous</th>
<th>Enables or disables an anonymous LDAP connection between your DMM appliance and your Active Directory server. An anonymous connection is suitable when you want to see or use public information on the Active Directory server. In contrast, if you want to see or use privileged information on your Active Directory server, the server will require you to enter login credentials to prove that you have sufficient access rights. In the latter case, your Active Directory server will reject any attempt to use an anonymous login. This check box is available to you only if you chose LDAP Authentication.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>Enter the routable IP address or DNS-resolvable hostname for the Active Directory server. This field is available to you only if you chose LDAP Authentication.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter the TCP port number that your Active Directory server uses for its LDAP communications. This field is available to you only if you chose LDAP Authentication. The Active Directory port number by default is 389 for LDAP communications and 636 for LDAPS (Secure LDAP or LDAP over SSL) communications.</td>
</tr>
</tbody>
</table>
### Table 2-3  Elements for the Authentication Mode (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SSL Encryption</td>
<td>A check box, by which you enable or disable LDAPS connections between your DMM appliance and your Active Directory server. To enable LDAPS, check the check box; to disable LDAPS, uncheck it. An LDAPS connection is suitable when you want the communications between your DMM appliance and your Active Directory server to be encrypted, so that untrusted third parties are prevented from reading credentials that the servers exchange. This check box is available to you only if you chose LDAP Authentication.</td>
</tr>
<tr>
<td>Active Directory Certificate File</td>
<td>The method by which to upload the digital certificate that your Active Directory server uses for LDAPS communications. This field is available to you only if you checked the Use SSL Encryption check box.</td>
</tr>
<tr>
<td></td>
<td>The X.509 certificate that you provide must be DER-encoded and can be supplied in binary or printable (Base64) encoding. If you use Base64 encoding, the certificate file must include the -----BEGIN CERTIFICATE----- and -----END CERTIFICATE----- lines.</td>
</tr>
<tr>
<td></td>
<td>To open and use the Upload Certificate File dialog box:</td>
</tr>
<tr>
<td></td>
<td>1. Click <strong>Upload</strong>, then, click <strong>Add</strong>.</td>
</tr>
<tr>
<td></td>
<td>2. Browse to the file on a local volume.</td>
</tr>
<tr>
<td></td>
<td>3. Click the filename and press <strong>Enter</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. To save your work and dismiss the dialog box, click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Current Certificate File</td>
<td>Identifies the digital certificate that is installed in DMS-Admin for use during LDAPS communication with your Active Directory server.</td>
</tr>
<tr>
<td>Administrator DN</td>
<td>Enter the Active Directory server administrator distinguished name. This field is available to you only if you chose LDAP Authentication and unchecked the Anonymous check box.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password that is associated with the Administrator DN. This field is available to you only if you chose LDAP Authentication and unchecked the Anonymous check box.</td>
</tr>
<tr>
<td>Tip</td>
<td>If an error message tells you that your Active Directory password is not valid, confirm on your Active Directory server that you have not set the “User must change password at next login” flag. DMS-Admin cannot change your password on an Active Directory server. Instead, you must use the user interface that your Active Directory server provides for that purpose. While this flag is set, you are prevented from logging in to any Cisco DMS component until you have changed your password on the Active Directory server.</td>
</tr>
<tr>
<td>Update</td>
<td>Saves and applies your work on the Authentication Mode property sheet.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards your work on the Authentication Mode property sheet and resets all values to their previous configuration.</td>
</tr>
</tbody>
</table>
Step 3  Click **Update**, and then consider which of the following scenarios applies to you.

- **No Authentication**
  - If you disabled authentication—where you had not used *any* authentication mode previously—you are done with this procedure. You did not change anything.
  - If you disabled authentication—where you had used LDAP authentication previously—you must explicitly choose whether Cisco DMS should keep a local copy of the user account data that originated from your Active Directory server. If you want to save the local copy, check the **Save LDAP Users** check box. Otherwise, the local copy is discarded. You are done with this procedure.

- **Embedded Authentication**
  - If you enabled embedded authentication—where you had not used *any* authentication mode previously—you are done with this procedure.
  - If you enabled embedded authentication—where you had used LDAP authentication previously—you must explicitly decide whether Cisco DMS should keep a local copy of the user account data that originated from your Active Directory server. If you want to save the local copy, the **Save LDAP Users** check box. (When you save a local copy, DMS-Admin changes all of the user passwords in it automatically to CiscoDMMvp99999. This security feature protects your network and user data if anyone gains unauthorized access to the exported file, because your Active Directory server recognizes that the password as incorrect if anyone attempts to use it.) Otherwise, the local copy is discarded. You are done with this procedure.

- **LDAP Authentication**
  If you enabled LDAP authentication, the three tabs—*Define Filter*, *Synchronize Users*, and *Manage Attributes*—that were previously dimmed are now available for you to click and use. To actually use LDAP authentication after you choose it as the mode, you must also use features under the Define Filter tab to configure and add a new agreement, and then use features under the Synchronize Users tab to submit the new agreement for synchronization.

Step 4  *(Optional)* Click **Define Filter**, and then use elements on the Define Filter property sheet to define, validate, and add one LDAP filter at a time. See Table 2-4 on page 2-11.

**Table 2-4  Elements for Filters**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a human-readable description for the filter.</td>
</tr>
<tr>
<td>User Base DN</td>
<td>Enter the distinguished name of the Active Directory user base that you will search.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Never use a filter in which you define the user base at the domain level. As one example, the following filter would be unacceptable: dc=cisco, dc=com. Instead, you should use filters that define the user base at a lower level, like this example does: ou=sanjose, dc=cisco, dc=com.</td>
</tr>
<tr>
<td>User Filter</td>
<td>Enter a user filter to limit the number of matching user accounts to import from the user base that you specified.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds the filter, exactly as entered, without first validating it.</td>
</tr>
<tr>
<td>Validate</td>
<td>Validates the filter to confirm, before you add it, that it will return meaningful results.</td>
</tr>
<tr>
<td><strong>Tip</strong></td>
<td>If an error message tells you that filter validation failed, confirm on your LDAP server that your filter did not make any reference to an empty organizational unit (OU) container. Filters fail when they point to empty containers.</td>
</tr>
<tr>
<td>Clear</td>
<td>Clears all entries from the Define Filters property sheet.</td>
</tr>
</tbody>
</table>
### Step 5
Do both of the following:

**a.** Choose **Synchronize Users > LDAP Bookmarks**, and then use elements on the LDAP Bookmarks property sheet to do any or all of the following:

- Choose the synchronization type for, and specify the default access privileges that you will assign to, user accounts that you will import to Cisco DMS because they correspond to a defined Active Directory filter.
- Use the synchronization type that you chose, so that Cisco DMS synchronizes user accounts that correspond to a defined Active Directory filter.
- Delete from Cisco DMS all of the user accounts that correspond to a defined Active Directory filter and delete the entry for that filter from DMS-Admin.

**b.** Choose **Synchronize Users > Scheduling**, and then use elements on the Scheduling property sheet to choose between manual synchronization and automatic synchronization.

See Table 2-5 on page 2-12.

---

**Note**
Until you have defined at least one filter on the Define Filter property sheet (as described in Step 4), you will not see any of the elements that Table 2-5 describes.

---

### Table 2-5 Elements for Synchronization

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LDAP Bookmarks property sheet</strong></td>
<td></td>
</tr>
<tr>
<td>Synchronization <strong>Tip</strong></td>
<td>We recommend that you use the Initial synchronization option and the Overwrite synchronization option during <strong>off-peak</strong> hours only. These synchronization types are CPU-intensive for your DMM appliance and might cause its performance to drop temporarily to an unacceptable level.</td>
</tr>
</tbody>
</table>

One of the following:

- **Initial**—Runs a one-time synchronization for a new filter that you never synchronized previously.
- **Update**—Runs an incremental, fast update to find and make up for any differences between user accounts that match your Active Directory filter and your local copy of those user accounts.
- **Overwrite**—Overwrites your local copy of user accounts that correspond to your Active Directory filter with new copies of those user accounts. In addition, deletes your local copy of each user account that has been deleted from Active Directory since the last time that you ran a synchronization.
- **Delete**—Deletes your local copy of user accounts that correspond to a defined Active Directory filter and deletes the entry for that filter from DMS-Admin.
Table 2-5  Elements for Synchronization (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access Rights</td>
<td>One or both of the following:</td>
</tr>
<tr>
<td></td>
<td>• VP — When checked, this check box enables login access to your Video Portal for users who</td>
</tr>
<tr>
<td></td>
<td>match the corresponding Active Directory filter. When you uncheck the check box, those same</td>
</tr>
<tr>
<td></td>
<td>users are prevented from logging in to your Video Portal.</td>
</tr>
<tr>
<td></td>
<td>• VPR — When checked, this check box enables login access to see and use Video Portal Reports</td>
</tr>
<tr>
<td></td>
<td>for users who match the corresponding Active Directory filter. When you uncheck this check box,</td>
</tr>
<tr>
<td></td>
<td>those same users are prevented from seeing and using Video Portal Reports.</td>
</tr>
<tr>
<td>Update</td>
<td>Submits your selections for the type of synchronization and the scope of access that you chose</td>
</tr>
<tr>
<td></td>
<td>and configured. Synchronization of the specified type starts immediately.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Discards any changes you made to the configuration of behaviors for synchronizations and the</td>
</tr>
<tr>
<td></td>
<td>scope of access, and resets all entries to their previous values on the LDAP Bookmarks</td>
</tr>
<tr>
<td></td>
<td>property sheet and the Scheduling property sheet.</td>
</tr>
</tbody>
</table>
Managing User Accounts and Authentication Settings

Step 6  Click Update.

### Table 2-5  Elements for Synchronization (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Scheduling property sheet | Enables one or the other of two possible modes, which are mutually exclusive, to receive updated user account information from your Active Directory server. Click one radio button:  
  - **Manual Synchronization** — Mode that requires during each subsequent synchronization of each configured LDAP bookmark that you must choose Administration > Settings > Authentication > Synchronize Users > LDAP Bookmarks; then, click Update. When you choose this mode, you delete any schedule that you configured previously to define automatic synchronizations.  
  - **Automatic Synchronization** — Mode that automates and schedules the recurrence of incremental updates of all user accounts that correspond to your defined Active Directory filters in DMS-Admin. As soon as you click this radio button, fields and elements that were hidden from you become available for your use, so that you can complete this required procedure:  
    1. Click the calendar icon ( ) to choose the start date for synchronization.  
    2. Choose the hour and minute when synchronization should begin, and then choose either AM or PM as the period.  
    3. From the Repeat Interval list, choose the interval of recurrence:  
       - **Never** — Synchronization will occur one time and will not recur.  
       - **Every Day** — Synchronization will recur once every 24 hours, starting at the specified hour and minute.  
       - **Every Week** — Synchronization will recur once every 7 days, starting at the specified hour and minute.  
       - **Every Month** — Synchronization will recur once each month, starting at the specified hour and minute.  
       - **Custom** — Synchronization will recur at the interval you define, starting at the specified hour and minute. Choose whether the interval type is Days, Weeks, or Months. If the interval type is Days, choose a day of the month from 1 to 30. If the interval type is Weeks, choose the day of the week. If the interval type is Months, choose an interval of recurrence from 1 to 6.  
    4. (Optional) If, in addition to the start date and time that you specified, a one-time synchronization should also start immediately, check the Synchronize users immediately check box. This check box is available to you only if you clicked the Automatic Synchronization radio button.  
| Update                | Submits your selections for the type of synchronization and the scope of access that you chose and configured. Synchronization of the specified type starts immediately. |
| Cancel                | Discards any changes you made to the configuration of behaviors for synchronizations and the scope of access, and resets all entries to their previous values on the LDAP Bookmarks property sheet and the Scheduling property sheet. |
Step 7  **(Optional)** Click **Manage Attributes**, and then use elements on the Manage Attributes property sheet to:

- Set the associations between DMS-Admin attribute names and their corresponding Active Directory attribute names.
- Use the predefined and typical names for Active Directory attributes (shown in grey text) or edit those attribute names so they match the names that your Active Directory server uses.
- Enter the values to use by default in DMS-Admin when a user account attribute is not defined on your Active Directory server.

You must enter a value for each mandatory attribute. You cannot enter a value to use by default for user names, because each user name is unique. See Table 2-6 on page 2-15.

<p>| <strong>Table 2-6 Elements for Attributes Management</strong> |</p>
<table>
<thead>
<tr>
<th><strong>Element</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>DMM Attribute Name</td>
<td>Values that DMS-Admin uses to describe and identify various attributes that it associates with each user account. You cannot change the values in this column. They are for your reference only, to help you enter suitable values (and recognize suitable values when you see them) in the LDAP Attribute Name column and the Values to Use by Default column.</td>
</tr>
<tr>
<td>LDAP Attribute Name</td>
<td>Values that your Active Directory server uses—which correspond one-to-one with values in the DMM Attribute Row column—to describe and identify attributes of each user account. In its factory-default configuration, DMS-Admin prepopulates all fields in this column with the most commonplace values that Active Directory servers use for this purpose. If the values for these attributes differ on your Active Directory server or if you prefer to import objects that use other Active Directory attributes, you can edit the values in this column. Ordinarily, DMS-Admin will not import any user account from your Active Directory server when the value in it is blank for any of these attributes:</td>
</tr>
<tr>
<td></td>
<td>• Login User Name—This required value always must be unique.</td>
</tr>
<tr>
<td></td>
<td>• First Name—This required value might be identical for multiple users.</td>
</tr>
<tr>
<td></td>
<td>• Last Name—This required value might also be identical for multiple users.</td>
</tr>
<tr>
<td></td>
<td>However, you can import and synchronize all of the Active Directory user accounts that match your filters, even if some of the user accounts are incomplete because one or more of their attributes have blank values. To prevent these undefined attributes from blocking the import of the user accounts they are meant to describe, you can enter generic values for most attributes in the Values to Use by Default column. DMS-Admin takes the generic values that you enter, and then inserts them automatically where they are needed. Nonetheless, you cannot ever enter a value to use by default for the Login User Name attribute, because each username is unique.</td>
</tr>
<tr>
<td>Values to Use by Default</td>
<td>Enter text to insert automatically when the value is blank for the corresponding attribute in an Active Directory user account that you import or synchronize. To ensure that DMS-Admin imports each valid user account that matches a filter, we recommend that you enter values for these attributes:</td>
</tr>
<tr>
<td></td>
<td>• First Name</td>
</tr>
<tr>
<td></td>
<td>• Last Name</td>
</tr>
<tr>
<td></td>
<td>For your convenience, you can also enter values to insert automatically when the values are blank for other attributes—such as Company, Department, or Phone Number—but this is optional.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>You cannot enter a value to use by default as the Login User Name value.</td>
</tr>
</tbody>
</table>
Table 2-6  Elements for Attributes Management (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset to Factory Default</td>
<td>Returns all values in the LDAP Attribute Name column to the most commonplace values that Active Directory servers use. If you entered different values manually because the labels for these attributes differ on your Active Directory server or because you prefer to import user accounts that use other Active Directory attributes, DMS-Admin deletes what you entered.</td>
</tr>
<tr>
<td>Update</td>
<td>Saves and applies your work in the Manage Attributes property sheet.</td>
</tr>
</tbody>
</table>

Step 8  Click **Update**.

The authentication settings that you changed are now in effect.

---

**Backing Up and Restoring**

*Note*  Backups that you generate from DMS-Admin in this release do not include any media assets that are stored on any device for any purpose. We recommend that you use another method to create backups of these files.

You can save backups of data on your DMM appliance and your Video Portal appliance (if you have one), and restore from backups that you saved.

Step 1  Click **Backup**.

Step 2  Do one of the following:

- To save an encrypted, local copy of the XML data, metadata, database records, and license keys for all of your Cisco DMS components, click **Download**.
- To restore your DMS components from an encrypted backup file that you saved previously, click **Browse**; then, find and select that file in its subdirectory, press **Enter**, and click **Submit**.

---

**Managing Email, SNMP, Alerts, and Notifications**

DMS-Admin supports email (SMTP) natively; in addition, you can purchase and install a license key to activate SNMP. In the context of this basic framework for notifications and queries, you can associate alarms with system events and configure the settings to use email or SNMP for the delivery of notification messages.

This section contains these topics:

- Enabling or Disabling Email, page 2-17
- Enabling or Disabling SNMP, page 2-17
- Configuring Alert Reports and Notification Settings, page 2-18
- Understanding Event Types, page 2-19
Enabling or Disabling Email

You can enable or disable the email service (SMTP) on your DMM appliance. When this service is enabled, DMS-Admin can send email notifications automatically to you or other interested parties whenever system events of predefined types occur.

**Before You Begin**

To see and use the Settings tab, you must be logged in as an administrator.

**Step 1**

Choose **Settings > SMTP Server** and then enter the required values so that your DMM appliance can run or will stop the email service. You must enter these values or you cannot send notification messages:

- **Server Status** — Click the radio button to enable or disable the email service.
- **Host** — The routable IP address or DNS-resolvable hostname.
- **Port** — The number to identify which TCP port is reserved for SMTP traffic.

**Step 2**

Click **Save**.

Enabling or Disabling SNMP

**Caution**

SNMPv1 and SNMPv2c are not secure protocols. You cannot use a firewall to secure SNMP traffic.

After you purchase and install a license key to use the SNMP Notification Module, your copy of DMS-Admin can use either the **SNMPv1** protocol or the **SNMPv2c** protocol to respond to Cisco DMS MIB schema-compliant queries from your NMS and send notification messages automatically to your NMS whenever system events of predefined types occur for:

- The MCS hardware platform that underlies DMM and Video Portal appliances.
- Digital Media Manager software modules and Video Portal.
- DMPs (in the sense that, when your DMPs report their events to your DMM appliance, it forwards the appropriate SNMP alerts).

**Note**

In this release, the SNMP Notification Module does not support:

- The SNMPv3 protocol.
- Any monitoring of Cisco Digital Media Encoders (DMEs). However, you can use the DME console in DMM-VPM for this purpose.

After you purchased a license key to use the SNMP Notification Module, you received (or were told how to obtain) a network management MIB file called **CISCO-DIGITAL-MEDIA-SYSTEMS-MIB.my**, and you received the *agent capabilities* file that describes which MIB objects are supported in this release of
Cisco DMS. You can load the MIB file into the MIB browser for any dedicated NMS that supports SNMP, such as CiscoWorks or HP OpenView. Your NMS can then send SNMP queries to DMS-Admin and represent the responses correctly. The supported MIB objects in this release allow monitoring of:

- **DMS Systems Group** — Models all distributed component parts of this Cisco DMS installation as a single, abstract system.
- **DMS Features Group** — Categorizes licensed and unlicensed features.
- **DMS Inventory Group** — Lists the devices that constitute this Cisco DMS installation and describes their operational status.

SNMP features in this release are read-only; your NMS can use SNMP to submit queries to DMS-Admin but cannot use SNMP to edit the configuration of any Cisco DMS component.

Use the following checklist to track your work with the separately licensed features for SNMP:

### Task

1. **Configure SNMP server settings for your DMM appliance.**
   
   a. Choose **Settings > SNMP**, and then enter the required values so that your DMM appliance can run or will stop the SNMP server service:
      
      - **Server Status** — Click the radio button to enable or disable SNMP monitoring.
      - **Host** — The routable IP address or DNS-resolvable hostname of the NMS.
      - **Port** — The number to identify which UDP port is reserved for SNMP traffic.
      - **Community String** — A password that identifies the community of the external SNMP server to which DMS conveys notifications. By default, the entry is `public`.
   
   b. Click **Save**.

2. **Load both the CISCO-DIGITAL.MEDIA-SYSTEMS-MIB.my file and its corresponding “agent capabilities” file into the MIB browser for your NMS.** Manufacturer documentation for your NMS should tell you how to load these files. When your NMS prompts you to enter the SNMP port number for your DMM appliance, use the port number **161**.

### Note

You cannot edit the (default) community string of your DMM appliance.

### Configuring Alert Reports and Notification Settings

**Step 1**

Click the **Alerts** tab.

**Step 2** *(Optional)*

To define the parameters for an alert report:

a. Click **Alert Reports**, then click the radio button to use either Live Event Mode or Snapshot Mode:
   
   - **Live Event Mode** —
   - **Snapshot Mode** —

b. Choose the range of dates,

c. Choose an event type from the Type list, and then click **Apply**.
Step 3  *(Optional)* To define the settings for notifications:

a. For each event type, choose a notification method. The methods are:

- **No Notification** — Disables notifications for all events of the corresponding type.
- **Email** — Enables automatic delivery of email notification messages for all events of the corresponding type. Activates the Recipient field, so that its email address value is editable; enter the email address that should receive notification messages. You can enter a unique recipient address for each of the notification event types. Requires that you have enabled SMTP.
- **SNMP** — Enables automatic delivery of notification messages to your NMS for all events of the corresponding type, using SNMPv2c. Requires that you have purchased, installed, and enabled the SNMP Notification Module.
- **Both** — Enables automatic delivery of email notification messages and automatic delivery of notification messages to your NMS for all events of the corresponding type. Activates the Recipient field, so that its email address value is editable; enter the email address that should receive notification messages. You can enter a unique recipient address for each of the notification event types. Requires that you have enabled SMTP and that you have purchased, installed, and enabled SNMP.

b. Do one of the following:

- To save all settings that you have defined for notifications and put them into effect immediately, click **Save**.
- To clear your selections, so that you can start over again, click **Reset**.

---

**Understanding Event Types**

Alarms and notifications use these event types:

- **All Notifiable Events** — All of the following.
- **DMP Outages** — Messages list all registered but inaccessible DMPs
- **DMP Restarts** — Messages list all registered DMPs that restarted recently.
- **DMP IP Conflicts** — Messages list all registered DMPs with IP address conflicts. An address conflict occurs when a DHCP server assigns to one registered DMP the exact dynamic IP address that some other registered DMP used previously. If the DMP that previously used the address is no longer in active use, you should delete the record of it in DMM-DSM; see *Managing and Grouping Your DMPs*, page 3-6. If the DMP that previously used the address is one that should still be active, confirm that it is still running and still connected to the network, then restart it and confirm that its DHCP server does not assign IP addresses with expiration dates.
- **DMP IP Registrations** — Messages list all newly registered DMPs.
- **Video Portal Outages** — Messages list registered but inaccessible Video Portal appliances.
- **Video Portal Restarts** — Messages list registered Video Portal appliances that restarted recently.
- **Deployment Failures** — Messages list recently failed deployments of content for use on a Video Portal.
- **Deployment Successes** — Messages list recently successful deployments of content for use on a Video Portal.
- **All Internal Events** — Messages list all signals exchanged between and among the internal components of Cisco DMS. Most users attribute little or no significance to these events.
Viewing Appliance Processes and Restarting Appliances Remotely

Step 1  Click the Services tab.

Step 2  To see which processes are running on a DMS appliance, do one of the following:
   • For a DMM appliance, click **DMM Server**.
   • For a Video Portal appliance, click **VP Server**.

Step 3  *(Optional)* To restart the appliance remotely, choose **Options > Restart Server**.
Managing Digital Signage and Enterprise TV

Overview

Digital signage and enterprise TV consolidate certain features in Cisco DMS and interoperate in other important ways. Moreover, the features that you are permitted to see and use will also vary according to privileges that your Cisco DMS administrator has granted to your username.

- Starting Digital Signage Module (DMM-DSM), page 3-2
- Starting Enterprise TV Module (DMM-ETV), page 3-2
Starting Digital Signage Module (DMM-DSM)

Features of DMM-DSM provide a flexible environment in which to create, manage, and run a digital signage network. Simple but powerful design and publishing features help you to deliver presentations for digital signage, while centralized management features help you to manage a global network of on-premise DMP displays for any purpose. Common use cases for DMM-DSM include:

- Marketing — Describe products and services directly to your in-store customers.
- Customer experience — Deliver entertainment and information to reduce perceived wait times.
- Messaging — Broadcast executive and internal communications in real time.
- Training — Deliver cost-effective, flexible training.
- Information — Deliver real-time schedules, news, and way-faring information where people need it.
- Advertising — Sell advertising time and space to third parties.
- Branding — Communicate about your brand consistently.

**Step 1**

If you just logged in to DMM or if you have been using features of a software module that is not related to digital signage, do one of the following:

- On the DMM dashboard, click **Digital Signage**.
- Choose **Digital Signage** from the global navigation.

Starting Enterprise TV Module (DMM-ETV)

Features of DMM-ETV can help your organization to deliver video-on-demand and live broadcast TV channels over an IP network to DMP displays that are attached to DMP 4400G and 4305G endpoints (DMP 4300G endpoints are not supported). You can show live news, financial information, sales and marketing messages, educational content for classrooms, corporate communications, entertainment, or any other type of content that is suitable for your purpose. Alternatively, hospitality and healthcare providers might use enterprise TV features in support of in-room IPTV.

See Configuring the Settings for an Enterprise TV Network, page 3-10.

**Step 1**

If you just logged in to DMM or if you have been using features of a software module that is not related to enterprise TV, do one of the following:

- On the DMM dashboard, click **Enterprise TV**.
- Choose **Enterprise TV** from the global navigation.

The TV Channels tab is preselected by default. To understand elements on this tab, see Understanding the TV Channels Table, page 3-13.
Understanding Dashboard Gauges for Digital Signage and Enterprise TV

When you start DMM-DSM or DMM-ETV, the landing page by default is a dashboard that shows four gauges. This dashboard centralizes all features for monitoring DMPs, schedules, assets, and settings for content delivery. (Gauge data is not updated in real time; you must refresh your browser to refresh the dashboard.) If problems of any kind interfere with the data-collection processes that populate these gauges, they will show question marks in addition to the best data that is available. The gauges are as follows:

Table 3-1 Digital Signage and Enterprise TV Gauges

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| Media and Schedules       | The left side of the Media and Schedules gauge shows a read-only version of the unified deployment schedule for digital signage and enterprise TV. To exit from this dashboard and go to the editable schedule, click **View All Schedules** (to see the editable schedule, you must be logged in as an administrator or as a user who has at least read-only permissions for the schedule). The right side of the Media and Schedules gauge shows the following categorized links, which are shortcuts to related pages and features of DMM.  
  - All Digital Signage — To see and use the entirety of this portion of the Media and Schedules gauge, you must be logged in as an administrator or as a user with at least read-only permissions to see presentations and playlists.  
    - Presentations — A shortcut that is equivalent to selecting Digital Signage > Presentations. To see and use this one shortcut specifically, you must be logged in as an administrator or as a user with sufficient permissions to see presentations.  
    - Playlists — A shortcut that is equivalent to selecting Digital Signage > Playlists. To see and use this one shortcut specifically, you must be logged in as an administrator or as a user with sufficient permissions to see playlists.  
    - Create Presentation — A shortcut that starts Digital Media Designer. See **Getting Started with DMD, page 3-35**. To see and use this one shortcut specifically, you must be logged in as an administrator or as a user with sufficient permissions to create presentations.  
  - All Assets — To see and use the entirety of this portion of the Media and Schedules gauge, you must be logged in as an administrator or as a user with sufficient permissions to see assets in the shared media library for digital signage and enterprise TV.  
    - Shortcuts (HTML, Images, UDP, Firmware, Flash, and Video) that each open the unified media library for digital signage and enterprise TV, filtering the result to include assets of only the corresponding type.  
    - Add Asset — Opens the Add Asset dialog box, from which you can add assets to your shared media library. To see and use this one element specifically, you must be logged in as an administrator or as a user with sufficient permissions to add assets to at least one category within the shared media library for digital signage and enterprise TV. |

User Guide for Cisco Digital Media Manager 5.0
Configuring Your DMPs to Support Centralized Management

You must configure your DMPs to recognize the authority of your DMM appliance, so that you can manage them centrally in DMM-DSM. This process occurs automatically when you autoregister DMPs, but if autoregistration is somehow not suitable, such as for testing purposes, you can also perform the required steps manually.

- To understand autoregistration, see Managing and Grouping Your DMPs, page 3-6.
- To learn how to use autoregistration, see the “{Add New | Edit} DMP Group” row in Table 3-2 on page 3-7.

DMM-DSM and your DMPs communicate over TCP port 7777 when centralized management is enabled.

Caution

To stop untrusted DMM appliances from being able to seize control of your DMPs, you must configure your network firewall to restrict which devices you will permit to send inbound traffic to your DMP over TCP port 7777. If you do not know how to work with access control lists, see the manufacturer documentation for your firewall.
Caution
The DMPDM login username by default is admin and the password by default is default. However, we urged you to change both of these when you set up your DMPs, because they are well known and constitute a security vulnerability in your network. To learn how to change the login credentials if you skipped that essential step during setup, see the quick start guide for your DMP model type on Cisco.com.

Do the following for each DMP that you will manage centrally.

**Step 1** To log in to DMPDM, point your browser to the DMP IP address.

**Step 2** At the DMPDM login prompt, enter the username and the password that you configured for the DMP.

**Note** All DMPs that you manage centrally in DMM-DSM must share one identical set of login credentials for DMPDM. To learn how to reconfigure your DMPs so that they all share identical credentials, see the quick start guide for your DMP model type on Cisco.com.

**Step 3** In the Settings area, click Centralized Management, then enter the required values:
- **DMM Appliance IP Address** — The IP address of your DMM appliance.
- **DMM-DSM Server Timeout (in seconds)** — The maximum number of seconds that your DMP should wait for a response from your DMM appliance.

**Step 4** To confirm your entries and to implement them until you change them or until you restart the DMP, click Apply.

**Step 5** In the Administration area, to make your configuration changes permanent even after you restart your DMP, click Save Configuration, then (after you see the Save Configuration page) click Save.

**Step 6** Click Restart DMP, then (after you see the Restart DMP page) click Restart.

---

**Enabling the CVBS (Composite Video) Interface on DMPs**

To take advantage of the latest features, options, and modern technologies, most digital signage environments use digital displays. However, some networks might include legacy devices and technologies, including analog displays. If you use analog displays or have any other reason to use Composite Video cables when you connect your DMPs to their displays (and if your DMPs use firmware release 5.0.0 or 5.0.1) you must first enable the CVBS interface on your DMPs.

**Tip** This procedure is not necessary for DMPs that use firmware release 5.0.2, where DMPDM includes Composite as a selectable video signal type.

**Step 1** Choose Digital Media Players > Advanced Tasks, then click the System Tasks row in the Application Types list.

**Step 2** Click Add New Application.
Managing and Grouping Your DMPs

Managing and Grouping Your DMPs

You can organize your DMPs in groups and manage them collectively instead of managing only one DMP at a time. We recommend that you create DMP groups to organize your DMPs according to other characteristics that they also have in common, such as where or how you will use them, but you can group your DMPs according to whatever logic works best for you. For example, the logical basis for your DMP groups might be geographic (by state, province, or metropolitan area) or corporate (by product team, sales region, time zone, primary spoken language, or type of facility), as in this illustration:

- ALL DMPs
  - london
  - san jose
  - finance
  - marketing

DMM-DSM includes a feature to autoregister your DMPs so that you do not have to register each DMP manually. We recommend that you avoid manual registration of DMPs, except for testing purposes. Autoregistration finds every DMP in the subnets that you specify, configures those DMPs to know and trust the IP address for your DMM appliance, restarts the DMPs, and registers them in DMM-DSM for centralized management. To learn how to use autoregistration, see the “{Add New | Edit} DMP Group” row in Table 3-2 on page 3-7.

Autoregistration requires that all of the DMPs in your digital signage network share identical user credentials for their DMP Web Account and identical user credentials for their DMP Service Account. For more information, see Quick Start Guide for Cisco Digital Media Player 4305G on Cisco.com, or see Quick Start Guide for Cisco Digital Media Player 4400G.

TCP port 7777 is open on DMPs and you cannot close it. DMM-DSM uses TCP port 7777 to communicate with DMPs.

Step 1
Choose Digital Media Players > DMP Manager.

Step 2
Select the options and enter the values that meet your requirements.

If you do not understand your options, see Table 3-2 on page 3-7. When you make selections anywhere on the DMP Manager page, it is updated automatically to show the options and features that are relevant to your selection.
Note

Important considerations apply to your digital signage network if any of your DMPs uses an HTTP proxy server. It is unusual and not scalable to manage many DMPs that share one HTTP proxy server. We recommend that your DMPs should not use HTTP proxy servers.

- If your DMPs must use proxied connections, we recommend that you configure them to use Web Cache Communication Protocol (WCCP) instead of using a proxy server. WCCP reroutes HTTP requests transparently. To learn how to use WCCP if you do not already know how, see Cisco.com.
- To configure one DMP to use one proxy server, use DMPDM, not DMM-DSM. See the “Adjusting Basic Network Settings” topic in User Guide for Cisco Digital Media Player Device Manager 5.0 on Cisco.com.
- To configure many DMPs to share one proxy server, even though we recommend that you do not, Select Digital Media Players > Advanced Tasks, click System Tasks in the list of defined tasks, then click Add New Application. Enter a name and description, then select Set from the Request Type list and use this syntax in the Request field:

  \[
  \text{init.BROWSER\_PROXY}=\langle\text{on|off}\rangle&\text{init.BROWSER\_PROXY\_IP}=\langle\text{proxy\_server\_IP\_address}\rangle&\text{init.BROWSER\_PROXY\_PORT}=\langle\text{proxy\_server\_logical\_port}\rangle. 
  \]

  For example, if the proxy server uses 192.168.12.12 as its IP address and delivers proxy services through port 5678, the Request string would look like this: init.BROWSER_PROXY=on&init.BROWSER_PROXY_IP=192.168.12.12&init.BROWSER_PROXY_PORT=5678&mib.save=1&mng.reboot=1.

  To remove that example proxy, you would select Set from the Request type list, then enter this Request string: init.BROWSER_PROXY_IP=&init.BROWSER_PROXY_PORT=&init.BROWSER_PROXY=off &mib.save=1&mng.reboot=1.

---

### Table 3-2 Elements for Managing DMPs

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMP Groups</td>
<td>A hierarchical tree (an object selector) of DMP groups, subgroups, and DMPs. From the object selector, you can add or remove group assignments for registered DMPs, create new groups, edit existing groups, and make selections for which DMPs the DMP List pane should describe. One group can contain another and the choices that you make for centralized management propagate from parent (DMP group), to child (DMP subgroup or DMP), to grandchild (DMP). There is no maximum number of levels that you can add to the hierarchy, but a simpler organization is more scalable than an unreasonably complex one would be. We recommend that you do not assign any DMP to the root level in the hierarchy, due to the complexity of management, but you can do this if you choose to.</td>
</tr>
<tr>
<td>Add New DMP Group</td>
<td>Shows the Add New DMP Group pane. You can save a named group for use in the future, even if you have not yet assigned any DMPs to it. See the “(Add New</td>
</tr>
<tr>
<td>Edit DMP Group</td>
<td>Shows the Edit DMP Group pane, where you can edit attributes of the group that you highlighted. See the “(Add New</td>
</tr>
<tr>
<td>Delete DMP Group</td>
<td>Deletes the group that you highlighted.</td>
</tr>
<tr>
<td>Opened Group</td>
<td>Shows the list of group members until you click to hide them.</td>
</tr>
<tr>
<td>Closed Group</td>
<td>Hides the list of group members until you click to show them.</td>
</tr>
<tr>
<td>DMP</td>
<td>A DMP that you assigned to the relevant parent group.</td>
</tr>
</tbody>
</table>
### Chapter 3      Managing Digital Signage and Enterprise TV

#### 3-8 User Guide for Cisco Digital Media Manager 5.0

**Table 3-2   Elements for Managing DMPs (continued)**

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
</table>
| DMP List      | A list of all DMPs contained in (or under) the level that you clicked in the DMP Groups object selector. To see a list of every registered DMP, click the group that represents the root level. (By default, its name is “All DMPs,” but this name is editable.) The interval between polling cycles is 5 minutes, so any newly added DMP might report temporarily that it is unavailable; if this happens to you, wait a few minutes, then check again. Autoregistration of 5,000 DMPs takes approximately 4 minutes in a fast network and does not use polling. **Actions**—List from which to select a presentation that you designed and saved in DMD, a VoD that you saved for use with enterprise TV, a task that you configured and saved on the Advanced Tasks page, or a task that DMM-DSM generated for you. The corresponding action will occur on the DMPs that you select. After you select the DMPs and the action, click **Go**. The specified action starts immediately. **Add New DMP**—Shows the Add New DMP pane, where you enter a name, IP address, MAC address, and description for the DMP. **Edit DMP**—Shows the Edit DMP pane. A registered DMP might become unavailable if it receives a new dynamic IP address from the DHCP server at its deployment site. In this case, you should restart the DMP or edit the IP address record that DMM-DSM maintains for the DMP. **Delete DMP**—Deletes the DMP that you highlighted. **LCD Control**—Opens the LCD Control popup window, where you can configure parameters (for some display types manufactured by NEC and DMTECH.1) for a DMP display. **Assign DMP to Group**—Creates an association between at least one DMP and at least one group. Do the following: 1. Click . 2. In the DMP List pane, click one or more DMPs to select them. 3. In the object selector, click one or more DMP groups that the selected DMPs should join. 4. Click  again. **Remove DMP from Group**—Deletes the association between at least one DMP and at least one group. Do the following: 1. Click . 2. In the DMP List pane, click one or more DMPs to select them. 3. In the object selector, click one or more DMP groups from which to disassociate the selected DMPs. 4. Click  again. **Filter**—Select a filter type2 from the list, then click **Go** to see only the DMPs that match your filter. **Display Number**—The maximum number of rows that the table should show per page if it straddles multiple pages. **Status**—Says whether a DMP is reachable. A green icon (✔️) tells you that the DMP is connected to a power source, uses a known IP address, and is reachable. A red icon (❌) tells you that the DMP is unreachable. **Name**—A unique and human-readable name that you entered or that DMM-DSM chose; If DMM-DSM chose the name, it is either the DMP IP address or MAC address. **IP**—The public IP address at which the DMP receives instructions and data from DMM-DSM. **Version**—The release number for the installed firmware version on the DMP. **Description**—The description that you entered.
Managing and Grouping Your DMPs

You can create or edit a DMP group. You must specify the group name and description. In addition, you can populate the group automatically with all of the DMPs in any NMAP address range that you specify. The address range can span one subnet or multiple subnets. You can schedule multiple DMP autoregistration operations to run simultaneously if they all search the same one subnet. If the DMP autoregistration operations that you configure do not all search the same one subnet, you should not schedule them to run simultaneously. If you do, only the first such operation will run and DMM-DSM will not show any error message to explain why the other autoregistration operations failed to find any DMPs. If you must run DMP autoregistration tasks that search different subnets, schedule a 35-minute interval between the start time for one autoregistration and the start time for the next autoregistration. In a very large network that contains thousands of DMPs, the required interval might be longer than 35 minutes. When you autoregister a DMP, it restarts immediately even if it is already centrally managed by a different DMM appliance than the one that you are using, and even if it is showing a presentation on its DMP display. Therefore, we recommend that you be careful to autoregister only those DMPs that you are not already managing from any of your DMM appliances. Otherwise, you might temporarily disrupt the deployment of presentations and their assets in your digital signage network. Autoregistration operations follow this sequence:

1. DMM-DSM scans every device in the specified address range, looking for devices where TCP port 7777 is open. This phase fails if you have disabled the “Enable TAC Troubleshooting Access” option in DMPDM (which is enabled by default) and unless your firewall allows ICMP traffic to pass from your DMM appliance to your DMPs.
2. DMM-DSM confirms which of the devices with port 7777 open are DMPs.
3. Those that are DMPs receive information about your DMM server, and are then instructed to restart.
4. Upon restarting, DMPs transmit updated information about themselves to DMM-DSM and set their own status as “Up.”
   DHCP servers at your deployment sites should be configured to expire leased IP addresses for DMPs only when DMPs are restarted. A registered DMP might become unavailable if it receives a new dynamic IP address from the DHCP server at its deployment site. In this case, you should restart the DMP or edit the IP address record that DMM-DSM maintains for the DMP.
5. DMM-DSM generates new database records for all DMPs that are newly autoregistered, assigns these DMPs to any DMP groups corresponding to the address range that you entered, and assigns them to the “All DMPs” group.

---

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{ Add New</td>
<td>Edit } DMP Group</td>
</tr>
<tr>
<td>— Name — A unique and human-readable name for the group.</td>
<td></td>
</tr>
<tr>
<td>— Description — A brief description of the group and its purpose.</td>
<td></td>
</tr>
<tr>
<td>— Add New Range — IP address subnet ranges in which to find and autoregister DMPs. The netmask typically is /24. To find every DMP in a subnet, use 0 (zero) as the only digit in the fourth quad, such as 192.0.2.0/24. To find one DMP whose address is already known to you, enter its IP address and the netmask but use a comma instead of the fourth dot, like 192.0.2,50/24.</td>
<td></td>
</tr>
<tr>
<td>— Delete a Range — Deletes the range that you highlighted.</td>
<td></td>
</tr>
<tr>
<td>— Automatic Grouping Ranges — Shows a list of all the defined NMAP address ranges. Click a range to edit it.</td>
<td></td>
</tr>
<tr>
<td>— Range (CIDR) — The field where you edit one CIDR address range at a time. For DMP autoregistration to succeed, the routers, switches, and firewalls that pass packets between your DMM appliance and the specified CIDR address range must allow TCP port 7777 to send and receive packets, and must allow ICMP traffic to pass from your DMM appliance to your DMPs.</td>
<td></td>
</tr>
</tbody>
</table>
Configuring the Settings for an Enterprise TV Network

### Table 3-2  Elements for Managing DMPs (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Add New</td>
<td>Edit} DMP</td>
</tr>
<tr>
<td>— DMP Name —</td>
<td>A unique and human-readable name for the DMP.</td>
</tr>
<tr>
<td>— DMP IP —</td>
<td>The public IP address that receives instructions and data from DMM-DSM.</td>
</tr>
<tr>
<td>— DMP MAC —</td>
<td>The MAC address that the DMP NIC uses.</td>
</tr>
<tr>
<td>— DMP Description —</td>
<td>Optional, brief description of the DMP, its deployment site, or anything that is relevant or meaningful to you.</td>
</tr>
</tbody>
</table>

1. The DMP display properties that you can select and configure in the LCD Control popup window are as follows:
   - **TV Type** — Select the manufacturer and the model type {DMTECH | NEC_3210 | NEC_4010 | NEC_4610 | NEC_5710}.
   - **Contrast** — Select or enter a contrast value from 0 to 100.
   - **Brightness** — Select or enter a brightness value from 0 to 100.
   - **Sharpness** — Select or enter a sharpness value from 0 to 100.
   - **Color** — Select or enter a color value from 0 to 100.
   - **Tint** — Select or enter a tint value from 0 to 100.
   - **TV Channel** — Select or enter the analog television signal frequency for a channel from 0 to 99.
   - **Audio Volume** — Select or enter a volume level from 0 to 100.
   - **Mute** — Select whether to mute the display {on | off}.
   - **Input** — Select the input type {TV | RGB | RGB1 (DVI-D) | RGB2 (D-SUB) | RGB3 (BNC) | DVD/HDTV | Video (Composite) | Video 1 | Video 2 | Video 3 | S-Video | None (DVD) | Component | PC | HDMI | None (DVB-T)}. Options vary according to the manufacturer and device model.
   - **Power** — Select whether the television should be turned on {on | off}.

To save your work in the LCD Control popup window, click **Submit**. Otherwise, to discard your work, click **Cancel**.

2. The filter types are as follows: ()
   - **Status** — Select **Up** or **Down** to limit matches by DMP availability.
   - **Name** — Enter the text string to limit matches by DMP name.
   - **IP** — Enter any part of the “dotted quad” to limit matches by DMP IP address.
   - **MAC** — Enter the text string to limit matches by DMP MAC address.
   - **Description** — Enter the text string to limit matches by DMP descriptions.
   - **Version** — Enter the text string to limit matches by DMP firmware release version number.

### Configuring the Settings for an Enterprise TV Network

#### Activation

Software feature modules for Cisco DMS are purchased and licensed separately. Features are hidden from all users until you purchase and install the required license to use them, and even then remain hidden from users whose privilege levels are low. To understand feature licenses and learn how to install them, see *Managing Licenses for Features and Components of Cisco DMS, page 2-3*. To learn how user access to features is restricted by the combination of licenses and user privilege levels, see "Understanding User Roles in DMS-Admin, page 2-8." To learn which software feature modules are available for you to purchase, see [http://www.cisco.com/go/dms](http://www.cisco.com/go/dms).

#### Note

Video-on-demand (VoD) features for enterprise TV depend upon the media library features for digital signage. Therefore, even though the DMM-ETV and DMM-DSM software modules are licensed separately and can operate independently of one another in most ways, you cannot use the VoD features for enterprise TV unless you have installed the licenses for both DMM-ETV and DMM-DSM.
• An administrator uses DMM-ETV to:
  – Customize on-screen menus with a logo and a skin.
  – Configure video channel assignments.
  – Specify what channels and programs should be available to the DMP displays where your organization will deploy its enterprise TV, and when each program should be available.

• An on-premise operator uses a remote control to navigate through live video channel menus, change channels, and select from video-on-demand categories.

The features for enterprise TV in this release support deployments of fewer than 100 live broadcast channels. Any digital encoders that you use for these channels must adhere to the MPEG2-TS standard for streaming and must support at least one of these codecs: MPEG1, MPEG2 or MPEG4/h.264. We recommend that you use a Scientific Atlanta 9032SD encoder or 9050HD encoder to encode the video streams that your DMPs should use for enterprise TV channels.

This section contains these topics:

- Understanding the Typical Workflow for Enterprise TV, page 3-11
- Configuring Settings for TV Channels, page 3-12
- Configuring Subscription Settings for EPG Providers, page 3-20
- Configuring Enterprise TV Settings for Video on Demand, page 3-23
- Using ‘Skins’ to Customize the Enterprise TV Main Menu, page 3-26

### Understanding the Typical Workflow for Enterprise TV

The checklist in this topic describes the ordinary workflow for enterprise TV.

**Before You Begin**

Complete these prerequisite tasks, in any order:

- Install the license for enterprise TV on your DMM appliance.
- Deploy DMPs and DMP displays to the sites where you will show enterprise TV.
Negotiate with a cable or satellite TV service in your region for the right to redistribute their package of TV channel signals.

Configure one Scientific Atlanta 9032SD encoder or 9050HD encoder apiece for each TV channel signal that you will stream in real time.

### Configuring Settings for TV Channels

This section includes the following topics:

- Understanding the TV Channels Table, page 3-13
- Adding New Channels, page 3-15
- Editing Channels, page 3-18
- Reassigning Channel Numbers, page 3-19
- Deleting Channels, page 3-19
- Listing Only the Defined (Active) or Undefined (Inactive) TV Channels, page 3-19
### Understanding the TV Channels Table

When you select Enterprise TV > TV Channels, a table is shown that describes the defined and undefined TV channels for your network. You can work with this table in many ways.

#### Table 3-3  Elements of the TV Channels Table

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel View list</td>
<td>Enables or disables a filtered view of which channels this table describes, based on which option you select:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All Channels</strong>—Shows the combination of all defined and undefined channels.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Active Channels</strong>—Shows only the defined channels.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Inactive Channels</strong>—Shows only the channels that are not yet defined.</td>
</tr>
<tr>
<td>Channel Number</td>
<td>One numeral per row, in the range from 0 (zero) to 99, where any numeral can be the TV channel number that you associate with a particular multicast stream. The default behavior for this table is that it shows all 100 possible channel numbers, one per row. Your selection from the Channel View list might limit how many rows the table contains, and this can affect indirectly how many channel numbers you see. If you sort the table by clicking a column heading, channel numbers might be rearranged temporarily into an unrecognizable sequence. To sort channels back into the expected sequence if their sequence has become unrecognizable, click the Channel Number column heading.</td>
</tr>
<tr>
<td>Channel Name</td>
<td>Blank when the corresponding row describes an undefined TV channel. Otherwise, shows a value that you entered or an option that you chose from a list when you defined the channel. To understand these values, see Table 3-4 on page 3-15.</td>
</tr>
<tr>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>Multicast Address: Port</td>
<td></td>
</tr>
<tr>
<td>Call Letters for Channel</td>
<td></td>
</tr>
</tbody>
</table>
Table 3-3 Elements of the TV Channels Table (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Reassign to Nearest Unused Channel | Two buttons, either of which can change the association between a channel definition and a channel number. The channel definition in the corresponding row becomes associated instead with the closest channel (of a higher number or a lower number, respectively) that is undefined. These buttons have no effect when every channel is already defined. The first row and last row of this table will only ever show one of these buttons apiece. These rows differ from all other rows in the table because you cannot use any channel number that is lower than the lowest supported channel number or higher than the highest supported channel number. The first row shows only , while the last row shows only .

- Associates the channel definition that the corresponding row describes with whichever lower-numbered channel is nearest among the undefined channels. The arrow points up because table rows above this row are reserved for lower-numbered channels.

- Associates the channel definition that the corresponding row describes with whichever higher-numbered channel is nearest among the undefined channels. The arrow points down because table rows above this row are reserved for higher-numbered channels.

See Reassigning Channel Numbers, page 3-19.

<table>
<thead>
<tr>
<th>Actions</th>
<th>One of these:</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Set Up Channel</td>
<td>Opens the dialog box where you can enter values and define attributes for a TV channel. See Adding New Channels, page 3-15. This button is visible only in rows that describe undefined TV channels.</td>
</tr>
<tr>
<td>- Edit Channel Settings</td>
<td>Opens the dialog box where you can edit the values and attributes of a channel that is already defined. See Editing Channels, page 3-18.</td>
</tr>
<tr>
<td>- Reassign to Any Unused Channel</td>
<td>Associates the channel definition that the corresponding row describes with whichever channel is nearest among the undefined channels. The new channel number might be higher or lower than whichever channel number was in effect until you changed it. See Reassigning Channel Numbers, page 3-19.</td>
</tr>
<tr>
<td>- Delete This Channel</td>
<td>Deletes all entries and attribute values from the definition of the channel that the corresponding row describes. The relevant channel number will not be associated with any defined channel unless or until you define a new channel for it or associate an existing channel with it. See Adding New Channels, page 3-15. See also Reassigning Channel Numbers, page 3-19.</td>
</tr>
</tbody>
</table>
Adding New Channels

You can define many attributes for a new TV channel in your lineup. Permitted channel assignments range from 1 to 99.

**Step 1**  Click the TV Channels tab. To understand elements on this tab, see Understanding the TV Channels Table, page 3-13.

**Step 2**  In the Channel Number column, identify the channel to be defined and, in the corresponding row, click Set Up Channel in the Actions column. To understand behaviors of the Set Up Channel button, see the “Actions” row in Table 3-4 on page 3-15.

The Add a New Channel dialog box opens.

**Step 3**  Choose the options or enter the values that meet your requirements, as described in Table 3-4 on page 3-15.

**Step 4**  Do one of the following:

- To save your entries, click Add a Channel.
- To discard your entries, click Cancel.

---

### UI Reference: Channel Settings

**Table 3-4  Elements for Channel Definitions**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your Name for This Channel</td>
<td>A meaningful, brief, and unique description of the channel that the corresponding row describes, such as China Central Television, Univision, Al-Jazeera, BBC-1, Star Cricket, HBO, or CNN.</td>
</tr>
<tr>
<td>Address Type</td>
<td>The method (multicast or HTTP) that your DMPs will use to receive the video stream for this channel. Select an option from the list to enter the correct kind of address. Your selection determines which other fields appear on this page. The options are:</td>
</tr>
<tr>
<td></td>
<td>- Multicast Address — The routable IP address and UDP port for a streaming server. See the “Multicast Address: Port” row, elsewhere in this table.</td>
</tr>
<tr>
<td></td>
<td>- HTTP URL — The full HTTP URL for one video file of a supported type. See the “HTTP URL” row, elsewhere in this table.</td>
</tr>
<tr>
<td>Multicast Address: Port</td>
<td>The IP address and port number of the streaming server from which your DMPs will receive the multicast stream for this channel. You must specify the port number. This field is visible only when you have selected Multicast Address from the Address Type list. (If you later select any other option from the Address Type list, DMM-ETV will ignore the values in this field.)</td>
</tr>
<tr>
<td>HTTP URL</td>
<td>The exact URL and path that points to one MPEG video file on an HTTP server. You must use HTTP as the protocol and the filename extension must be MPG. This field is visible only when you have selected HTTP URL from the Address Type list.</td>
</tr>
<tr>
<td>Text to Show if Program Guide is Not Available</td>
<td>Text that describes this channel. The electronic program guide (EPG) shows this text when no other information is available. When the EPG uses this text, it does not describe individual programs for this channel.</td>
</tr>
</tbody>
</table>
### Configuring the Settings for an Enterprise TV Network

#### EPG Provider
Episodic Provider Associates or disassociates this channel with one EPG data source and specifies the nature of that source if you associate one with this channel. You can choose between two source types or choose not to use any data source. The options are:

- **Tribune Media Services** — Before your channel can use any EPG data from TMS, you must enter your subscription details and synchronize data on the EPG Providers tab, as described in Configuring Subscription Settings for EPG Providers, page 3-20. Then, you must configure the channel on the TV Channels tab. For more information about these prerequisites, see the “Adding or Editing Subscriptions to Data from an EPG Provider” section on page 3-21.

- **Upload CSV** — It is also possible to have and use an EPG without entering into a subscription contract with TMS. Instead, you can create and upload a CSV file that contains program descriptions that you have entered. However, to populate your EPG completely, you must create and upload a separate CSV file for every channel that your EPG should include. (The TMS prerequisites do not apply if your channel will use programming data from a CSV file that you upload.) There are strict requirements for what constitutes a valid CSV file for this purpose. We strongly recommend that you derive your CSV files from the free template that we provide. See the “Download the CSV Template” row, elsewhere in this table.

- **None** — Alternatively, you can choose to disassociate this channel from all EPG data sources. In this case, the only information that the EPG will show about this channel will be exactly the text that you enter in the Text to Show if Program Guide is Not Available field.

**Note**

EPG data is not required for enterprise TV to work. You can enable or disable the EPG for Cisco DMS. You are not required to subscribe to any EPG data service. To learn how to use enterprise TV without any on-screen program guide, see Using ‘Skins’ to Customize the Enterprise TV Main Menu, page 3-26.

### Table 3-4 Elements for Channel Definitions (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPG Provider</td>
<td>Associates or disassociates this channel with one EPG data source and specifies the nature of that source if you associate one with this channel. You can choose between two source types or choose not to use any data source. The options are:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Tribune Media Services</strong> — Before your channel can use any EPG data from TMS, you must enter your subscription details and synchronize data on the EPG Providers tab, as described in Configuring Subscription Settings for EPG Providers, page 3-20. Then, you must configure the channel on the TV Channels tab. For more information about these prerequisites, see the “Adding or Editing Subscriptions to Data from an EPG Provider” section on page 3-21.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Upload CSV</strong> — It is also possible to have and use an EPG without entering into a subscription contract with TMS. Instead, you can create and upload a CSV file that contains program descriptions that you have entered. However, to populate your EPG completely, you must create and upload a separate CSV file for every channel that your EPG should include. (The TMS prerequisites do not apply if your channel will use programming data from a CSV file that you upload.) There are strict requirements for what constitutes a valid CSV file for this purpose. We strongly recommend that you derive your CSV files from the free template that we provide. See the “Download the CSV Template” row, elsewhere in this table.</td>
</tr>
<tr>
<td></td>
<td>- <strong>None</strong> — Alternatively, you can choose to disassociate this channel from all EPG data sources. In this case, the only information that the EPG will show about this channel will be exactly the text that you enter in the Text to Show if Program Guide is Not Available field.</td>
</tr>
<tr>
<td>CSV File (Browse)</td>
<td>The method to find and select a CSV file that you have stored locally and will upload to your DMM appliance. The file must use syntax and formatting that are perfectly consistent with output from the template that we provide for your use. We strongly recommend that you derive your CSV files from the template. See the “Download the CSV Template” row, elsewhere in this table. This field is visible only when you have selected Upload CSV from the EPG Provider list.</td>
</tr>
</tbody>
</table>
Table 3-4    Elements for Channel Definitions (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| Download the CSV Template| A downloadable template file in Microsoft Excel format that you can use to define the EPG attributes for programs on one channel. You can define the attributes for only a few programs or for as many as 14 days of programs. You populate fields in the template as follows, where each table row contains the attributes for one program in the EPG for the corresponding TV channel:   
  - **Date** — The date and time of day when one described program will start. Start times for programs in your CSV file must use the format MM/DD/YY HH:mm.  
  - **Duration** — The total running time for the described program. Duration values for programs must use numerals, which indicate the total duration in minutes.  
  - **Title** — The title that the program guide should show for the described program. Program titles are limited to a maximum of 23 characters. If the text to be displayed in a program title should show any visible quotation marks, you must enter exactly " for each quotation mark that should be visible.  
  - **Description** — The actual description that the program guide should show for the program. Descriptions are limited to a maximum of 50 characters. If the text to be displayed in your program guide should show any visible quotation marks, you must enter exactly " for each quotation mark that should be visible.  

After you populate the Microsoft Excel template file with the EPG attributes for programs on one channel, save your work as a CSV file that you can upload for use in your EPG. This link is visible only when you have selected Upload CSV from the EPG Provider list.
Configuring the Settings for an Enterprise TV Network

**Editing Channels**

**Step 1** Click the **TV Channels** tab. To understand elements on this tab, see [Understanding the TV Channels Table](#), page 3-13.

**Step 2** In the Channel Number column, identify the channel to be edited; then, click the arrow (▲) in the Actions column for that row.

The Actions menu expands so that you can see and choose among its options.

**Step 3** Click **Edit Channel Setting**.

The Edit an Existing Channel dialog box opens.

**Step 4** Choose the options or enter the values that meet your requirements, as described in [Table 3-4](#) on page 3-15.

---

**Table 3-4 Elements for Channel Definitions (continued)**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Letters for Channel</td>
<td>A list of call letters for TV channels that your EPG subscription includes. The list is variable according to your location in the United States, the package of channels that you receive from your cable or satellite TV provider, the nature of your contract with TMS, and possibly other factors. Your list might include some or all of these call letters, possibly among others:</td>
</tr>
<tr>
<td></td>
<td>• ABC — American Broadcasting Company</td>
</tr>
<tr>
<td></td>
<td>• AZA — Azteca América</td>
</tr>
<tr>
<td></td>
<td>• CBC — Canadian Broadcasting Corporation</td>
</tr>
<tr>
<td></td>
<td>• CBS — CBS Broadcasting</td>
</tr>
<tr>
<td></td>
<td>• CW — The CW Television Network</td>
</tr>
<tr>
<td></td>
<td>• FOX — Fox Broadcasting Company</td>
</tr>
<tr>
<td></td>
<td>• MNT — MyNetworkTV</td>
</tr>
<tr>
<td></td>
<td>• NBC — National Broadcasting Company</td>
</tr>
<tr>
<td></td>
<td>• PAX — ION Television</td>
</tr>
<tr>
<td></td>
<td>• PBS — Public Broadcasting Service</td>
</tr>
<tr>
<td></td>
<td>• SRC — SRC</td>
</tr>
<tr>
<td></td>
<td>• TEL — Telemundo</td>
</tr>
<tr>
<td></td>
<td>• TLF — TeleFutura</td>
</tr>
<tr>
<td></td>
<td>• TQS — Télévision Quatre Saisons</td>
</tr>
<tr>
<td></td>
<td>• TVA — Tele Vida Abundante</td>
</tr>
<tr>
<td></td>
<td>• UNI — Univision</td>
</tr>
<tr>
<td></td>
<td>This list is visible only when you have selected Tribune Media Services from the EPG Provider list.</td>
</tr>
</tbody>
</table>
Step 5  Do one of the following:
  • To save your entries, click **Update Channel**.
  • To discard your entries, click **Cancel**.

### Reassigning Channel Numbers

**Step 1**  Click the **TV Channels** tab. To understand elements on this tab, see **Understanding the TV Channels Table, page 3-13**.

**Step 2**  In the Channel Number column, identify the channel to be edited.

**Step 3**  To reassign this channel to the nearest unused number, click the up (↑) or down (↓) arrow. To understand this method, see the “Reassign to Nearest Unused Channel” row in Table 3-4 on page 3-15.

Alternatively, to specify a number for a channel, do the following:

a. In the Channel Number column, identify the channel to be edited; then, click the arrow (↑) in the Actions column for that row.
   
   The Actions menu expands so that you can see and choose among its options.

b. Click **Reassign to Any Unused Channel**.

c. From the list in the Actions column, choose the channel number to assign to this channel.

### Deleting Channels

**Step 1**  Click the **TV Channels** tab. To understand elements on this tab, see **Understanding the TV Channels Table, page 3-13**.

**Step 2**  In the Channel Number column, identify the channel to be deleted; then, click the arrow (↑) in the Actions column for that row.

The Actions menu expands so that you can see and choose among its options.

**Step 3**  Click **Delete This Channel**.

The Delete Confirmation dialog box opens.

**Step 4**  Do one of the following:

  • To delete the channel, click **Yes**.
  • To retain the channel, click **No**.

### Listing Only the Defined (Active) or Undefined (Inactive) TV Channels

You can filter the TV Channels table so that it describes defined channels only or undefined channels only. By default, the table describes all channels.
Step 1 Click the **TV Channels** tab. To understand elements on this tab, see **Understanding the TV Channels Table, page 3-13**.

Step 2 From the Channel View list above the column headings, choose one of the following options:
- All Channels (default) — Shows the combination of all defined and undefined channels.
- Active Channels — Shows only the defined channels.
- Inactive Channels — Shows only the channels that are not yet defined.

---

**Configuring Subscription Settings for EPG Providers**

Electronic program guide (EPG) data is *not required* for enterprise TV to work. You can enable or disable the EPG for Cisco DMS. You are not required to subscribe to any EPG data service.

**Note**

If you want to start a subscription with a commercial provider of EPG data, it is important for you to understand that Cisco DMS 5.0.0 and 5.0.1 support only one data format for subscriptions. This supported format is available only within the United States and its sole provider is Tribune Media Services (TMS) of Chicago, Illinois.

- The TMS product name is *TV Schedules, United States*.
- The TMS product scope is *Fourteen (14) rolling days*.

Other EPG subscription products from TMS use data formats that we do not support in this release.

If you are already a TMS customer and you have a preexisting subscription contract that authorizes you to obtain and use TMS data in the format that this release supports, check with your TMS representative whether the terms of your contract authorize you to use TMS data with Cisco Enterprise TV.

Data from TMS is proprietary, copyrighted, and licensed. Although TMS compiles this licensed data in good faith, neither Cisco nor TMS makes any express or implied warranties regarding the data or its merchantability or fitness for any particular purpose.

To learn more about this exact format or to negotiate the commercial contract for a subscription, contact Amy Mann, the director of new media sales at Tribune Media Services. Her toll-free telephone number is 800 833-9581, ext. 2333, and her email address is aamann@tribune.com. To ensure that your contract includes sufficient permissions, be sure to say that you intend to use TMS data for Cisco Enterprise TV.

**Tip**

- You might have to adjust security settings in your network so that you can receive EPG data from TMS. The ftp server on your DMM appliance must be able to reach the TMS ftp server.
- If you want to have and use an EPG without entering into a subscription contract with TMS, you can create and upload a CSV file that contains program descriptions that you have entered. See the CSV instructions in **Adding New Channels, page 3-15**.
This section includes the following topics:

- Adding or Editing Subscriptions to Data from an EPG Provider, page 3-21
- Deleting EPG Data Subscriptions, page 3-22
- Synchronizing TV Channel Schedules and Program Descriptions for the EPG, page 3-22

Adding or Editing Subscriptions to Data from an EPG Provider

You use elements on the EPG Providers page to define the settings for your EPG data subscriptions, view a summary of all subscriptions that you have defined and, optionally, choose whether to edit, delete, or synchronize a subscription.

For information about associating a subscription with a channel, see Adding New Channels, page 3-15.

**Step 1** Click the EPG Providers tab.

**Step 2** Do one of the following:

- To define the settings for a new subscription, click Add an EPG Provider.
- To edit a subscription that you defined previously:
  1. In the EPG Provider Name column, identify the subscription to be edited; then, click the corresponding arrow () in the Actions column.
  2. The Actions menu expands so that you can see and choose among its options.
  3. Click Edit.

A dialog box opens, in which you can define or edit the attributes for this subscription.

**Step 3** Choose the options or enter the values that meet your requirements, as described in Table 3-5 on page 3-21.

**Step 4** Do one of the following:

- To save your entries, do one of the following:
  1. If you are defining a new subscription, click Add a Provider.
  2. If you are editing a subscription that you defined previously, click Update Provider.
- To discard your entries, click Cancel.

UI Reference: EPG Provider Settings

**Table 3-5** Elements for Defining EPG Subscription Settings

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Provider Name</td>
<td>The name that you use to distinguish this provider from all other providers.</td>
</tr>
<tr>
<td>Data Format</td>
<td>The only supported data format in this release is Tribune Media Services - TV Schedules.</td>
</tr>
<tr>
<td>Host or IP Address</td>
<td>The routable IP address or DMS-resolvable hostname of the ftp server where you obtain EPG data from your subscription provider.</td>
</tr>
<tr>
<td>Username</td>
<td>Your username to log in to the specified ftp server.</td>
</tr>
<tr>
<td>Password</td>
<td>The password to authenticate your username to the specified ftp server.</td>
</tr>
</tbody>
</table>
Deleting EPG Data Subscriptions

You can delete the settings that define your subscription to data from an EPG provider.

Step 1  Click the EPG Providers tab.

Step 2  In the EPG Provider Name column, identify the subscription to be deleted; then, click the corresponding arrow ( ) in the Actions column.

The Actions menu expands so that you can see and choose among its options.

Step 3  Click Delete.

Step 4  When prompted to confirm your choices, do one of the following:

- To delete the subscription, click Yes.
- To retain the subscription, click No.

Synchronizing TV Channel Schedules and Program Descriptions for the EPG

Step 1  Click the EPG Providers tab.

Step 2  In the EPG Provider Name column, identify the subscription whose TV channel schedules and program descriptions should be synchronized to your EPG; then, click the corresponding arrow ( ) in the Actions column.

The Actions menu expands so that you can see and choose among its options.

Step 3  Click Synchronize.

The Performing EPG Synchronization dialog box opens. It shows a progress indicator ( ) that spins until synchronization has finished. The dialog box then closes itself automatically.

Step 4  (Optional) To dismiss the dialog box and perform synchronization in the background so that you can continue your work, click Run in Background.
Configuring Enterprise TV Settings for Video on Demand

**Activation**

Video-on-demand (VoD) features for enterprise TV depend upon the media library features for digital signage. Therefore, even though the DMM-ETV and DMM-DSM software modules are licensed separately and can operate independently of one another in most ways, **you cannot use VoD features for enterprise TV unless you have installed the licenses for both DMM-ETV and DMM-DSM.**

This section contains these topics:

- Working With VoD Categories, page 3-23
- Mapping a Video to a VoD Category, page 3-25
- Organizing Videos in VoD Categories, page 3-25
- Removing a Video from a Category, page 3-26

**Working With VoD Categories**

Categories help you to manage how VoDs are organized for the interactive main menu at sites where you deploy enterprise TV. To learn about adding a VoD to a category, see Mapping a Video to a VoD Category, page 3-25.

**Step 1**

Click the Video on Demand tab. To understand elements on this tab, see VoD Categories, page 3-24.

The Video on Demand listing page opens. The Categories area is on the left, and after you click a category, a table on the right describes the videos that are mapped to that category.
To add, modify or delete a category, complete one of the following tasks:

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This</th>
</tr>
</thead>
</table>
| Add a new category | 1. Click Categories.  
2. Click Actions > Add a Category.  
3. Enter a descriptive name for the category.  
4. Click Save, or click Cancel to discard the entry. |
| Add a new subcategory | 1. Click the category to which you want to add a subcategory.  
2. Click Actions > Add a Category.  
3. Enter a descriptive name for the category.  
4. Click Save, or click Cancel to discard the entry. |
| Delete a category | 1. Click the name of the category that you want to delete.  
2. Click Actions > Delete Category.  
The Delete Confirmation dialog box opens.  
3. Click Yes, or click No to retain the category. |
| Modify a category | 1. Click the name of the category that you want to modify.  
2. Click Actions > Modify Category.  
3. Enter a descriptive name for the category.  
4. Click Save, or click Cancel to discard the entry. |

---

**VoD Categories**

**Table 3-6 Elements for Managing VoD Categories**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Categories selector</td>
<td>A hierarchical tree (an object selector) of VoD categories. Highlight the name of a category to designate it as the one that should contain a VoD that you will map to it.</td>
</tr>
</tbody>
</table>
| Actions options | Options that you can select, whose effect is relative to the category you have selected.  
• Create a Category  
• Edit Category  
• Delete Category |
| untitled table   | Each row describes one VoD asset that is mapped to a category for enterprise TV. Asset attributes that these columns describe are derived from records in your media library:  
• Title  
• Description  
• Duration  
• Source |
| Map Videos to Category | Opens a dialog box in which you can select the videos to be mapped. |
Mapping a Video to a VoD Category

Each video that you map to a category will be listed as a VoD in the interactive main menu at sites where you deploy enterprise TV.

**Before You Begin**
- Add the video to your unified Media Library for digital signage and enterprise TV.
- Create the category. See *Working With VoD Categories*, page 3-23.

**Step 1** Click the *Video on Demand* tab.

**Step 2** In the Categories area, click the name of the category to which you will add a video.

**Step 3** In the area that lists videos, click *Map Videos to Category*.

The VoD Mapping dialog box opens. A tree on the left shows the hierarchy of categories for assets in your unified Media Library and, after you click a category, an untitled table on the right describes each asset in that category.

**Step 4** Click the Media Library category that contains the video that you want to use as a VoD.

The videos in this category are described in the untitled table on the right.

**Step 5** Click the name of the video, and then drag and drop it to the area below.

**Tip** To choose more than one video, press the Shift key while clicking the names of videos.

**Step 6** Do one of the following:
- To add the video, click *Submit Mapping*. The category that you chose is now part of the categories tree on the Video on Demand page. When you select that category in the tree, the untitled table on the left side of the page describes each video that you added as a VoD.
- To discard your entries, click *Cancel*.

Organizing Videos in VoD Categories

When you organize the videos in a VoD category, you set the order in which Enterprise TV shows the videos at your deployment sites.

**Step 1** Click the *Video on Demand* tab.

**Step 2** In the Categories area, click the name of the category that includes the videos to be organized.

The videos in this category are described in the untitled table on the right.

**Step 3** Click the name of the video; then, drag and drop it to its new location in the list. Videos that are higher in the list will be shown before videos that are lower in the list.
Removing a Video from a Category

When you remove a video from a category on the Video on Demand page, you remove it also from the interactive main menu at sites where you deploy enterprise TV.

Step 1  Click the **Video on Demand** tab.

Step 2  In the area that lists videos, click **Map Videos to Category**.

The VoD Mapping dialog box opens. A tree on the left shows the hierarchy of categories for assets in your unified Media Library and, after you click a category, an untitled table on the right describes each asset in that category.

Step 3  Click the Media Library category that contains the VoD to be removed.

The videos in this category are described in the untitled table on the right.

Step 4  Identify the video to be removed from the category.

Step 5  Click the name of the video, and then click **Remove**.

Step 6  Do one of the following:

- To remove the video, click **Submit Mapping**.
- To retain the video, click **Cancel**.

Using 'Skins' to Customize the Enterprise TV Main Menu

You can customize the interactive main menu that is presented to viewers at your deployment sites and choose which features the menu should include.

Step 1  Click the **Skin Customization** tab.

Step 2  To customize the main menu, complete the following tasks, as needed:

<table>
<thead>
<tr>
<th>To...</th>
<th>Do This</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose colors for the main menu</td>
<td>In the Choose a Skin area, click the radio button for the color scheme that you want.</td>
</tr>
</tbody>
</table>
| Specify which features to include | In the Features to Include in the Enterprise TV Main Menu area, check the check box for each feature that the main menu should include:  
  - Electronic Programming Guide  
  - Video on Demand  
  - Live TV Channels |
| Display a custom logo | 1. In the Upload a Custom Logo area, click **Browse**.  
  2. Select the file to be uploaded, and then click **Open**.  
  3. Click **Preview** to view the logo file.  
  4. Check the **Display Custom Logo** check box.  
The logo appears in the upper left of the main menu. |
| Display the Cisco logo | Check the **Display Cisco Logo** check box.  
The logo appears in the lower right of the main menu. |
Working with Assets and Categories in Your Media Library

**Activation**

Software feature modules for Cisco DMS are purchased and licensed separately. Features are hidden from all users until you purchase and install the required license to use them, and even then remain hidden from users whose privilege levels are low. To understand feature licenses and learn how to install them, see Managing Licenses for Features and Components of Cisco DMS, page 2-3. To learn how user access to features is restricted by the combination of licenses and user privilege levels, see Understanding User Roles in DMS-Admin, page 2-8. To learn which software feature modules are available for you to purchase, see http://www.cisco.com/go/dms.

To simplify management, you can organize your assets for digital signage and enterprise TV. We recommend that you create categories for sets of characteristics that your assets have in common—such as their file type, intended audience, or genre.

**Note**

This release does not support audio in Shockwave Flash media. If your media library contains any Shockwave Flash files that use audio, their playback will be silent on your DMP displays.

**Before You Begin**

To see and use the Media Library, you must be:

- Using a DMM appliance on which valid licenses are installed for DMM-DSM and DMM-ETV.
- Logged in as a user with at least read-only permissions for at least one category.

**Step 1**

Click the **Media Library** tab.

A tree on the left side of the Media Library page names the types of media that are supported and shows the hierarchy of categories that you have created to organize your assets without regard for their media type. When you click the name of a media type or of a category, an untitled table on the right side of the page is updated automatically to describe assets of the relevant type that your library contains. Furthermore, you can filter the untitled table so that it describes only a narrow subset of your assets, based on criteria such as the title, file type, or duration.

**Step 2**

Enter the values and select the options that meet your requirements. To understand the options, see Table 3-7 on page 3-28.
Table 3-7  
Elements for Managing Media Files

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
</table>
| Media Types | A complete list of the types of assets that are supported. The supported assets are:  
  - DMP Firmware  
  - HTML  
  - Images  
  - Shockwave Flash  
  - UDP  
  - Video  
When you click the name of a media type, an un-titled table on the right side of the page is updated automatically to describe assets of the relevant type that your library contains. |
| Categories | A hierarchical list (an object selector) of all categories in your media library. A category can contain assets or it might be empty. You can create new categories, edit existing categories, delete categories, or click a category whose assets the un-titled table should describe. You can add almost any number of nested categories to your media library. Options—A menu from which you can choose among these options:  
  - Create Category — Opens the Add Category dialog box. See UI Reference: {Add | Edit} Category Dialog Box, page 3-29.  
  - Rename Category — Opens the Edit Category dialog box. See UI Reference: {Add | Edit} Category Dialog Box, page 3-29.  
  - Delete Category — Deletes the category that you highlighted.  
Create Category — Opens the Add Category dialog box. See UI Reference: {Add | Edit} Category Dialog Box, page 3-29. |
| Filter by | Methods by which you can cause the untitled table to describe only the assets from your media library that match parameters you have specified. Select the filtering method, specify the parameters, and then click Go. You can use only one filter per query. You cannot apply a second filter to results that are already filtered. The methods are:  
  - Title—Enter at least one word that the title contains.  
  - Filename—Enter a string of characters that the filename contains.  
  - Description—Enter at least one word that the description contains.  
  - File Type—Enter the file type to be matched.  
  - Estimated Duration—Enter in hours, minutes, and seconds, the duration to be matched.  
  - Date Modified—Click the first calendar icon to choose the start date for the range of modification dates to be matched, then click the second calendar icon to choose the end date for the range.  
  - Owner—Enter the DMM username for the asset owner to be matched.  
  - Source—Choose whether the asset is stored locally (File) or remotely (URL).  
  - Path—Enter a string of characters that the path contains. |
Working with Assets and Categories in Your Media Library

Table 3-7  Elements for Managing Media Files (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>untitled table</td>
<td>Describes all assets contained in the category, or of the media type, that you clicked in the object selector. The table sorts information into these columns:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Asset Title</strong> — A unique and human-readable title that you entered.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Filename</strong> — The filename for this asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>File Type</strong> — Identifies the format of the asset that the corresponding row describes.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Size</strong> — The file size in bytes.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Estimated Duration</strong> — The duration value that you entered when you added this asset to your media library, or when you edited attributes of this asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Date Last Modified</strong> — Time stamp (in the format DD-MM-YYYY hh:mm:ss) that says when the file was last modified.</td>
</tr>
<tr>
<td>pagination controls</td>
<td>Buttons and fields clustered under a table, by which you:</td>
</tr>
<tr>
<td></td>
<td>- Set how many rows a table should show per page before it starts to span multiple pages.</td>
</tr>
<tr>
<td></td>
<td>- Move from one page to another in a table that spans multiple pages.</td>
</tr>
<tr>
<td></td>
<td>- Cause the table to show refreshed data.</td>
</tr>
<tr>
<td>Options</td>
<td>Choose the option, if any, that meets your requirements:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Add Media Asset</strong> — Opens the Add Asset dialog box. See UI Reference: {Add</td>
</tr>
<tr>
<td></td>
<td>- <strong>View Media Asset</strong> — Opens the View Asset dialog box.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Edit Media Asset</strong> — Opens the Edit Asset dialog box. See UI Reference: {Add</td>
</tr>
<tr>
<td></td>
<td>- <strong>Remove Media Asset</strong> — Deletes the asset that you highlighted.</td>
</tr>
<tr>
<td>Add Media Asset</td>
<td>Opens the Add Asset dialog box. See UI Reference: {Add</td>
</tr>
<tr>
<td>Create Playlist</td>
<td>Opens the New Playlist dialog box in a popup window.</td>
</tr>
</tbody>
</table>

UI Reference: {Add | Edit} Category Dialog Box

Make selections and enter required values to add or edit categories in your unified media library for digital signage and enterprise TV.

Table 3-8

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique and human-readable name for a category.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the category and its purpose.</td>
</tr>
</tbody>
</table>

UI Reference: {Add | Edit} Asset Dialog Box

Table 3-9 on page 3-30 describes the dialog box where you add or edit assets in your unified media library for digital signage and enterprise TV. Options for this dialog box are sorted under two tabs, *Single* and *Batch*. To see and use the options on a tab, click its name.
The amount of time that a batch download operation requires depends on the speed of your connection, the number of directory levels that you search for downloadable files, and the total combined file size of all files that you transfer.

Before you add any asset, confirm that its file size is not more than 1.9 GB, which is the maximum stream size for any asset that you include in the layout for a DMD presentation. For purposes of stage-one failover, the combined size of all assets cannot exceed the capacity of the SD card in a DMP. To understand failover, see the “Understanding Content Substitution (Failover)” topic in User Guide for Cisco Digital Media Player Device Manager 5.0 on Cisco.com.

**Note**
- After you start to import an asset, do not click any browser button or navigate away from this page until the import is finished. If you do, the import will not finish successfully.
- We recommend that you do not use your DMM appliance as if it is a storage server. It has limited capacity to store files and DMM might not function as designed if space runs low.

**Table 3-9 Elements for Adding Assets to the Media Library**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single tab</td>
<td>Elements to add or edit one asset. Make selections and enter values to add one asset to your library, and then click <strong>Save</strong>. Alternatively, to discard your selections, click <strong>Cancel</strong>.</td>
</tr>
<tr>
<td>Source</td>
<td>The full local pathname or remote HTTP URL of the asset. We do not support any use of spaces in filenames or URLs. Do one of the following:</td>
</tr>
<tr>
<td></td>
<td>- Click <strong>URL</strong>, enter the URL, then check or uncheck the <strong>Download URL</strong> check box to control whether you download a local copy of the asset or use the version of it that is stored remotely. The URL must be encoded properly (using “%20” instead of spaces, for example), according to the principles set forth in RFC 2396.</td>
</tr>
<tr>
<td></td>
<td>- Click <strong>Local File</strong>, then click <strong>Browse</strong> or enter the full local pathname.</td>
</tr>
</tbody>
</table>
### Working with Assets and Categories in Your Media Library

#### File Type
Select the type that best describes the asset:
- **Video** — A video file in MPEG-1, MPEG-2, or MPEG-4 format. Our support for MPEG-4 requires that you use the MPEG-4 Part 2 or Part 10 (H.264) codec and that you multiplex audio and video in an MPEG-2 Transport Stream. If your DMP is a 4400G, we support MPEG-4 Part 10/H.264 video in MPEG-2 TS. (Neither the 4300G nor the 4305G supports MPEG-4 Part 10/H.264.) The filename extension must be MPG or MPEG and you must enter the estimated duration.
- **Shockwave Flash** — An Adobe Shockwave Flash 6, or 7 file if your DMP is a 4300G or a 4305G. Alternatively, if your DMP is a 4400G, then a file in the format of Shockwave Flash 6, 7, 8, or 9. The filename extension must be SWF and you must enter the estimated duration. This release does not support audio in Shockwave Flash media. If your media library contains any Shockwave Flash files that use audio, their playback will be silent on your DMP displays.
- **Images** — A standard image file, such as a nonprogressive JPEG image. The filename extension must be JPG, JPEG, GIF, or PNG.
- **HTML** — A web page. The filename extension must be HTM or HTML.
- **Firmware** — A firmware image for the DMP. The filename extension must be FWIMG or BIN. See Table 3-19 on page 3-57.
- **UDP** — The routable IP address and UDP port for a streaming server.

#### Title
A unique and human-readable name for the asset.

#### Estimated Duration
The estimated duration for playback, counted in hours, minutes, and seconds.

#### Category
Describes each of the categories that should contain this asset. To add a category to the list, click **Select Category**.

#### Description
Optional, brief description of the asset.

#### Owner
Your name or the name of the person who added the asset.

### Bulk tab

**Elements to add or edit multiple assets simultaneously. Make selections and enter values to add assets to your library, and then click **Save**. Alternatively, to discard your selections, click **Cancel**.**

#### Base URL
An HTTP URL that points to a directory on a server. The directory that you point to serves as the root-level URL for the batch download operation; every file that you download is retrieved from this directory or from one of its children at a lower level. We do not support any use of spaces in URLs.

#### Pattern
The filename pattern that identifies which files to download. For example, to download every file that uses the three-letter MPG filename extension, the pattern is *.MPG. We do not support any use of spaces in filenames.

**Note** Do not enter the filename pattern to use any unsupported file type.
Working with Assets and Categories in Your Media Library

UI Reference: View Asset Dialog Box

Describes the attributes of one asset in your Media Library and, in some cases, shows a preview. Attribute information is sorted under two tabs, Overview and Usage. Click a tab to see the asset attributes that it describes. To close the View Asset dialog box, click Close.

Table 3-9     Elements for Adding Assets to the Media Library (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Type</td>
<td>Select the type that best describes these assets:</td>
</tr>
<tr>
<td></td>
<td>• Video — A video file in MPEG-1, MPEG-2, or MPEG-4 format. Our support for MPEG-4 requires that you use the MPEG-4 Part 2 or Part 10 (H.264) codec and that you multiplex audio and video in an MPEG-2 Transport Stream. If your DMP is a 4400G, we support MPEG-4 Part 10/H.264 video in MPEG-2 TS. (Neither the 4300G nor the 4305G supports MPEG-4 Part 10/H.264.) The filename extension must be MPG or MPEG and you must enter the estimated duration.</td>
</tr>
<tr>
<td></td>
<td>• Shockwave Flash — Any Adobe Shockwave Flash 6, 7, or 8 file if your DMP is a 4300G or a 4305G. Alternatively, if your DMP is a 4400G, then a file in the format of Shockwave Flash 6, 7, 8, or 9. The filename extension must be SWF and you must enter the estimated duration. This release does not support audio in Shockwave Flash media. If your media library contains any Shockwave Flash files that use audio, their playback will be silent on your DMP displays.</td>
</tr>
<tr>
<td></td>
<td>• Images — Any standard image file, such as a nonprogressive JPEG image. The filename extension must be JPG, JPEG, GIF, or PNG.</td>
</tr>
<tr>
<td></td>
<td>• HTML — Any web page. The filename extension must be HTM or HTML.</td>
</tr>
<tr>
<td></td>
<td>• Firmware — Any firmware image for the DMP. The filename extension must be FWIMG or BIN. See Table 3-19 on page 3-57.</td>
</tr>
<tr>
<td></td>
<td>• UDP — The routable IP address and UDP port for a streaming server.</td>
</tr>
<tr>
<td>Levels</td>
<td>The number of levels below the specified base URL to search for (and download) files with filenames that match the specified pattern.</td>
</tr>
<tr>
<td>Category</td>
<td>Click the name of the one category that should contain these assets.</td>
</tr>
</tbody>
</table>

Table 3-10     Elements for Viewing Asset Attributes

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overview tab</td>
<td>Attributes that are derived from information in your media library include the elements with these field labels: Title, Description, File Type, Estimated Duration, Owner, Category Names, and Source. To understand these elements, see UI Reference: [Add</td>
</tr>
<tr>
<td>Preview</td>
<td>Either a generic icon that represents the asset type or a thumbnail that you can click to view this asset, assuming that its file type is viewable in your browser.</td>
</tr>
<tr>
<td>Path</td>
<td>The full HTTP pathname for this asset.</td>
</tr>
<tr>
<td>Size</td>
<td>The file size.</td>
</tr>
<tr>
<td>Playlist Count</td>
<td>The total count of playlists that contain and are dependent upon this asset. To learn more about these playlists, click the Usage tab.</td>
</tr>
</tbody>
</table>
Working with Presentations, Templates, and Presentation Playlists for Digital Signage

DMM-DSM provides two types of playlists for use in your digital signage network. These two playlist types are wholly separate and are not synchronized. The first type is simply called a playlist, while the second type is called a presentation playlist. Presentation playlists are reserved for use with your work in Digital Media Designer (DMD), and these are the only playlists that DMD recognizes.

Digital Media Designer (DMD) is a powerful, drag-and-drop design tool that helps you to create customized presentations for digital signage. Cisco provides predesigned assets that you can use as a jumping-off point for your designs or you can create designs that are entirely your own. DMD supports horizontal and vertical screen orientations. With DMD, you:

- Subdivide the screen space on a DMP display into rectangular areas called screen zones.
- Select the media objects, called assets, to play back in those screen zones—including media from digital video files, JPEG files, SWF files, RSS feeds, ordinary web pages, and other popular media types.
- Add assets to, and configure the timeline for, any screen zone that represents a presentation playlist.

Although you use your browser to start DMD, it runs outside your browser, in Java Web Start. You can open and work with only one template or one presentation at a time. Presentations for digital signage most commonly divide screen space into two, three, or four screen zones, but you can create more zones for a presentation in DMD if you need more.

After you create, edit, and save a presentation, you can deploy it to your DMPs from the scheduler. Each affected DMP then restarts automatically before it starts to show the presentation. To learn how to deploy a presentation to your DMPs, see Scheduling Time Slots for Media and Events on DMPs, page 3-73.

This section contains these topics:

- Before You Start to Use Digital Media Designer, page 3-34
- Getting Started with DMD, page 3-35
- DMD User Interface Reference, page 3-37

---

Table 3-10  Elements for Viewing Asset Attributes (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation Count</td>
<td>The total count of presentations that contain and are dependent upon this asset. To learn more about these presentations, click the Usage tab.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>Time stamp (in the format DD-MM-YYYY hh:mm:ss) that says when the file was last modified.</td>
</tr>
</tbody>
</table>

Usage tab

Shows either the Playlists for Asset table or the Presentations for Asset table, depending on whether you click Playlist or Presentation, respectively. The table sorts information into the following columns.

<table>
<thead>
<tr>
<th>Name</th>
<th>The name of the presentation or the playlist that is dependent upon this asset.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Referenced</td>
<td>The total count of instances when the described presentation or playlist includes this asset.</td>
</tr>
<tr>
<td>Date Modified</td>
<td>Time stamp (in the format DD-MM-YYYY hh:mm:ss) that says when the described presentation or playlist was last modified.</td>
</tr>
</tbody>
</table>
Before You Start to Use Digital Media Designer

Use the following checklist to track your compliance with the requirements and recommended best practices for using DMD successfully.

<table>
<thead>
<tr>
<th>Requirements and Recommendations</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prerequisites</strong></td>
</tr>
<tr>
<td>1. Ensure that Java Runtime Engine (JRE) 1.6.0 or later is installed on your PC. Also confirm that it is configured to use English as its language, and that it is working correctly. The JRE 1.6.0 release is part of Java Version 6.</td>
</tr>
<tr>
<td>• To learn exactly which JRE release you are using and to confirm that it is working correctly, go to <a href="http://java.com/en/download/help/testvm.xml">http://java.com/en/download/help/testvm.xml</a>.</td>
</tr>
<tr>
<td>• To understand the Java release naming conventions, which have changed over time, see <a href="http://java.sun.com/javase/6/namechange.html">http://java.sun.com/javase/6/namechange.html</a>.</td>
</tr>
<tr>
<td>• To obtain the required JRE, go to <a href="http://javasoft.com">http://javasoft.com</a>, click <a href="http://javasoft.com">Java SE</a>, then download the latest JRE version.</td>
</tr>
<tr>
<td>• Apple maintains and distributes its own implementations of Java software for Mac OS users. To learn if Apple has made available any JRE that is based on JRE 1.6.0, see <a href="http://www.apple.com/java">http://www.apple.com/java</a>. Alternatively, registered Apple Developer Connection (<a href="http://connect.apple.com/">http://connect.apple.com/</a>) members might find that Apple has released a preview version of a compatible JRE. We make no claims about the suitability of such software for any purpose and recommend that you test all software thoroughly before you rely on it.</td>
</tr>
<tr>
<td>2. If you use Windows, select Start &gt; Settings &gt; Control Panel &gt; Internet Options, then click the Advanced tab. Scroll to the Browsing area, deselect the Enable third party browser extensions (requires restart) check box, then click OK.</td>
</tr>
<tr>
<td>3. Ensure that your DMPs use firmware version 5.00 or 5.0.1.</td>
</tr>
<tr>
<td>• To check the firmware version on a DMP, log in to its local instance of DMPDM, then click About.</td>
</tr>
<tr>
<td>• If you learn that you must obtain new firmware, log in to your Cisco.com account and then go to <a href="http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=281723656">http://tools.cisco.com/support/downloads/pub/Redirect.x?mdfid=281723656</a>.</td>
</tr>
<tr>
<td>• To learn how to install firmware for a DMP, see the “DMP Firmware Upgrade” row in Table 3-19 on page 3-57.</td>
</tr>
<tr>
<td>4. You must enable popup windows in your web browser. See the manufacturer documentation for your browser and for any installed third-party browser extensions, such as toolbars that provide popup-blocking features.</td>
</tr>
<tr>
<td>5. You must already have created and saved the media files that your presentation will show. See Working with Assets and Categories in Your Media Library, page 3-27.</td>
</tr>
<tr>
<td>6. Confirm that none of the individual assets that you will show has a file size any larger than 1.9 GB. If any file has a larger file size, the presentation that should show the file shows nothing and your DMP device logs will describe many errors. This size is constrained by the limits of streaming.</td>
</tr>
</tbody>
</table>
Getting Started with DMD

You can create the layout for a new presentation or edit a presentation that you created previously.

Step 1
To start Digital Media Designer so that you can define a set of screen zones, click the Designs tab, then click Start Digital Media Designer.

Step 2
When prompted, select the option to use Java Web Start.
DMD opens.
In DMD, select the options and enter the values that meet your requirements. To understand the options, see DMD User Interface Reference, page 3-37.

Step 3
To save your work in DMD when you are done, select File > Save.

Step 4
To close DMD when you are done, select File > Exit.

Step 5
(Optional) Deploy the presentation to a DMP group. See Scheduling Time Slots for Media and Events on DMPs, page 3-73.
To show a presentation during stage-one failovers on a DMP, you must first create and deploy a “File Transfer to DMP or Server” task that saves copies of the presentation and its assets to the SD memory card inside the DMP. When you do this, DMM-DSM automatically creates a “Go to URL” task. The name by default for this generated task is “failover - <name_of_presentation>.” If a DMP should show its locally stored presentation at any time other than during stage-one failover, you must deploy the corresponding Go to URL task to the DMP. See Scheduling Time Slots for Media and Events on DMPs, page 3-73.

After you delete a presentation for which DMM-DSM automatically generated a corresponding Go to URL task, you must also delete that Go to URL task.
DMD User Interface Reference

Figure 3-1 on page 3-37 shows the Digital Media Designer user interface as it looks when you first open it in Java Web Start.

In Digital Media Designer, the workspace is the largest part of the user interface. After you enter values for it so that it has the same height and width in pixels as the screen on your DMP display, the workspace is the canvas where you design your presentations and presentation templates for digital signage.

In addition to its workspace, the user interface in Digital Media Designer consists of four menus, a toolbar, and four dockable panels.

- Understanding the Menus and Their Options, page 3-38
- Understanding the Toolbar and Its Options, page 3-41
- Understanding the Panels and Their Options, page 3-42
Understanding the Menus and Their Options

Table 3-11 on page 3-38 describes the menus in Digital Media Designer.

<table>
<thead>
<tr>
<th><strong>Table 3-11</strong></th>
<th><strong>Digital Media Designer Menus</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>File Menu</strong></td>
<td></td>
</tr>
<tr>
<td>New</td>
<td>Shows the New Design/Template dialog box, which lists all of the templates that you have saved as well as all of the presentation templates that Cisco provides with DMD, minus any presentation templates that you have deleted. Click the template that meets your requirements, such as the template that contains only a blank canvas. To start work on your design, click <strong>OK</strong>. Alternatively, click <strong>Cancel</strong> to discard your selections and return to the canvas.</td>
</tr>
<tr>
<td></td>
<td>• [<em>Landscape</em></td>
</tr>
<tr>
<td></td>
<td>• <em>untitled table</em> — Most rows describe one presentation template apiece that you can use as the basis for a new presentation or as the basis for a new presentation template. Alternatively, you can select the blank canvas that one row describes. (The blank canvas is described, by default, in the first row.) To re-sort the table by the attributes that the Thumbnail, Screen Resolution, Name, or Description columns show, click the corresponding column heading. Click a row to select the presentation template or the blank canvas that the row describes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Filter</strong> — Enter any part of a presentation template name to filter out from the table all presentation templates whose descriptions do not match your text string. The filtering occurs in real time as you enter text.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Resolution</strong> — Enter the resolution width and height in pixels that your presentation design will use. This feature is available only when you have selected to use a blank canvas. To learn the native resolution for a display, see its manufacturer documentation.</td>
</tr>
<tr>
<td>Open</td>
<td>Shows the Open dialog box, which lists all of the presentations and presentation templates that you have saved, in addition to the presentation templates that Cisco provides with DMD, minus any presentations or presentation templates that you have deleted. To open a design so that you can review or change it, select it, then click <strong>OK</strong>. Alternatively, to return to the canvas without opening a design, click <strong>Cancel</strong>.</td>
</tr>
<tr>
<td></td>
<td>• [<em>Presentations</em></td>
</tr>
<tr>
<td></td>
<td>• <em>untitled table</em> — Each row describes one design. To re-sort the table by the attributes that the Thumbnail, Screen Resolution, Name, or Description columns show, click the corresponding column heading. Click a row to select the presentation or the presentation template that the row describes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Filter</strong> — Enter any part of a design name to filter out from the table all of the saved designs whose descriptions do not match your text string. The filtering occurs in real time as you enter text.</td>
</tr>
</tbody>
</table>
### Table 3-11  Digital Media Designer Menus (continued)

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save</strong></td>
<td>One of these:</td>
</tr>
<tr>
<td></td>
<td>- If you are designing a layout that you have not yet saved and named, opens the Save Presentation dialog box. Select the options and enter or confirm the values that meet your requirements:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Name</strong> — A unique and human-readable name for the layout. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Description</strong> — A brief description of the layout and its purpose.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Resolution</strong> — Shows in pixels the width and height that your design will require as a supported resolution on your DMP display. Uses this syntax: (N\times N). For example, (1366\times 768) would specify a display that can show as many as 1,366 pixels horizontally and as many as 768 pixels vertically. Confirm that the values you see are not any greater than what your DMP display can actually show.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Presentation</strong> — Identifies the layout as a one-time design. A presentation is a design that uses a freeform layout or a layout derived from a presentation template.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Presentation Template</strong> — Identifies the layout as a foundational design. A presentation template is the basis, potentially, for multiple presentations that you expect to create in the future, which all will share a common look and feel.</td>
</tr>
<tr>
<td></td>
<td>When you are done, click <strong>OK</strong> to save your work or click <strong>Cancel</strong> to discard your work.</td>
</tr>
<tr>
<td><strong>Save As</strong></td>
<td>Opens the “Save As Presentation or Presentation Template” dialog box, so that you can save multiple variants of a presentation or a template, or so you can overwrite a saved presentation or saved presentation template that you no longer need. Select the options and enter or confirm the values that meet your requirements:</td>
</tr>
<tr>
<td></td>
<td>- **{Presentations</td>
</tr>
<tr>
<td></td>
<td>- <strong>Name</strong> — A unique and human-readable name for the design. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Description</strong> — A brief description of the design and its purpose.</td>
</tr>
<tr>
<td></td>
<td>- **{Resolution</td>
</tr>
<tr>
<td></td>
<td>- <strong>Presentation</strong> — Select this radio button to identify the layout as a one-time design that uses a freeform layout or a layout that you will derive from a presentation template.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Presentation Template</strong> — Select this radio button to identify the layout as a foundational design. A presentation template is the basis, potentially, for multiple presentations that you expect to create in the future, which all will share a common look and feel.</td>
</tr>
<tr>
<td></td>
<td>When you are done, click <strong>Save</strong> to save your work or click <strong>Close</strong> to discard your work.</td>
</tr>
</tbody>
</table>
Table 3-11  Digital Media Designer Menus (continued)

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Presentation/Template</td>
<td>Shows the Delete Presentation(s) and/or Presentation Template(s) dialog box, which lists all of the presentations and presentation templates that you have saved, in addition to the presentation templates that Cisco provides with DMD, minus any presentations or presentation templates that you have already deleted.</td>
</tr>
<tr>
<td></td>
<td>- (Presentations</td>
</tr>
<tr>
<td></td>
<td>- untitled table — Each row describes one design. To re-sort the table by the attributes that the Thumbnail, Screen Resolution, Name, or Description columns show, click the corresponding column heading. Click a row to select the presentation or the presentation template that the row describes.</td>
</tr>
<tr>
<td></td>
<td>- Filter — Enter any part of a design name to filter out from the table all of the saved designs whose descriptions do not match your text string. The filtering occurs in real time as you enter text.</td>
</tr>
</tbody>
</table>

To delete a design, select it, and then click Delete Selected Presentation. To return to the canvas whether or not you have deleted any designs, click Close.

Exit  Closes DMD.

Edit Menu

Whole Screen  Expands the selected object so that its height and width become the same as the total height and width of your layout. To reduce its dimensions again if you prefer to use smaller dimensions, edit the height and width values that the Properties panel shows for the selected object. This feature is not available for you to use unless at least one object is selected on the workspace or in the Layouts panel.

Safe Area  Expands the selected object so that its height and width become the same as the height and width of the safe area in your layout. To change its dimensions again, edit the height and width values that the Properties panel shows for the selected object. This feature is not available for you to use unless at least one object is selected on the workspace or in the Layouts panel.

Delete  Deletes the selected object or action from the workspace. This feature is not available for you to use unless at least one object or action is selected on the workspace or in the Layouts panel.

Up  Moves the selected object up by one layer, in the sense that your layout might position overlapping screen zones as if they are stacked or piled on top of each other. When you use this option, you make the selected screen zone more prominent than it was before you moved it. This feature is not available for you to use unless at least one object is selected on the workspace or in the Layouts panel.

Down  Moves the selected object down by one layer. When you use this option, you make the selected screen zone less prominent than it was before you moved it. This feature is not available for you to use unless at least one object is selected on the workspace or in the Layouts panel.

Top  Moves the selected object to the top layer. When you use this option, the effect is that you make the selected screen zone more prominent than every other screen zone. This feature is not available for you to use unless at least one object is selected on the workspace or in the Layouts panel.

Bottom  Moves the selected object to the bottom layer. When you use this option, the effect is that you make the selected screen zone least prominent of all your screen zones. This feature is not available for you to use unless at least one object is selected on the workspace or in the Layouts panel.
Table 3-11  Digital Media Designer Menus (continued)

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Menu</td>
<td>Expands or collapses the respective panel. To understand the panels, see Understanding the Panels and Their Options, page 3-42.</td>
</tr>
<tr>
<td>Tools Menu</td>
<td>As described in the “Understanding the Objects/Actions Panel and Its Options” section of Table 3-13 on page 3-43:</td>
</tr>
<tr>
<td>Add Action &gt;</td>
<td>•  {Static</td>
</tr>
<tr>
<td></td>
<td>•  Synchronize Playlists</td>
</tr>
<tr>
<td>Add Object &gt;</td>
<td>•  Screen</td>
</tr>
<tr>
<td></td>
<td>•  Box</td>
</tr>
<tr>
<td></td>
<td>•  Video Playlist</td>
</tr>
<tr>
<td></td>
<td>•  Nonvideo Playlist</td>
</tr>
</tbody>
</table>

Understanding the Toolbar and Its Options

The toolbar in DMD contains buttons that you click and controls for the degree of workspace magnification. To understand the toolbar, see Table 3-12.

Table 3-12  Digital Media Designer Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save Changes</td>
<td>Saves your work.</td>
</tr>
<tr>
<td></td>
<td>Delete Selected Object</td>
<td>Deletes from your design the one object or action that is selected on the workspace.</td>
</tr>
<tr>
<td></td>
<td>Zoom In</td>
<td>Increases the degree of magnification by 10 percentage points per click.</td>
</tr>
<tr>
<td></td>
<td>Incremental Zoom</td>
<td>Increases or decreases the degree of magnification by 1 percentage point per click, depending respectively on whether you click the arrow head that points up or the arrow head that points down. Alternatively, you can do either or both of the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>•  Use the scroll wheel on your mouse to increase or decrease the degree of magnification.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>•  Enter any percentage value in the unlabeled field, then press Enter.</td>
</tr>
<tr>
<td></td>
<td>Zoom Out</td>
<td>Decreases the degree of magnification by 10 percentage points per click.</td>
</tr>
<tr>
<td></td>
<td>View Workspace</td>
<td>Increases or decreases the degree of magnification by whatever percentage amount is necessary to fit the entire screen object inside the visible workspace.</td>
</tr>
</tbody>
</table>
Understanding the Panels and Their Options

Panels are dockable controls in the Digital Media Designer user interface that you can move, resize, expand, or collapse, which contain features to help you design layouts for digital signage. All panels are opened by default. To understand how to use the features of a particular panel, see:

- Understanding the Objects/Actions Panel and Its Options, page 3-43
- Understanding the Layers Panel and Its Options, page 3-47
- Understanding the Navigator Panel and Its Options, page 3-48
- Understanding the Properties Panel and Its Options, page 3-48

Moving Panels

To move a panel so that its location is more convenient to you, drag it by its title bar to the location that you prefer. The only constraint when you move a panel is that one side of it will always be pinned to the workspace. DMD rearranges and resizes the other panels automatically to create an open space for the panel that you are moving.

Resizing Panels

To change the width or height of a panel, click and drag the vertical or the horizontal border between it and the workspace. The width or height of nearby panels changes automatically in response.

Collapsing and Expanding Panels

- To collapse a panel, click the square button at the right end of its title bar. In its collapsed form, the entirety of a panel is reduced to button form, where the button shows nothing except the panel name in very small type and is pinned to one edge of the DMD window.
- To reopen a panel temporarily after you collapse it, click where you see its name pinned to the edge of the DMD window. After you move your mouse away from the panel, it closes again automatically.
- To reopen a panel that you collapsed, click where you see its name pinned to the edge of the DMD window, then click the square button at the right end of its title bar.
Understanding the Objects/Actions Panel and Its Options

An action is a behavior that you can add to an object in your layout. Each object occupies a layer.

Table 3-13  Digital Media Designer — The Objects/Actions Panel

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Box Icon]</td>
<td>Box</td>
<td>Creates a new screen zone and a new layer where you can show:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• One bitmapped image in JPEG, GIF, or PNG format. (Other file types are not supported.) If you place a bitmapped image in a box object, be sure that the box object uses the same height and width in pixels that the bitmapped file uses. If the box object is too small, the displayed image will be cropped. It will not be resized or scaled automatically.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• One text string. The string can be completely motionless and presented without any visual effects when you show it on a DMP display or you can show it in the form of a ticker.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• One background color.</td>
</tr>
</tbody>
</table>

To start using a box object, drag it to the workspace from the Objects/Actions panel or select Tools > Add Object > Box. To populate and configure a box object, click it on the workspace, then make selections and enter values in the Properties panel. To understand the Properties panel, see Understanding the Properties Panel and Its Options, page 3-48.

When you choose which layer to use for a box object in your layout, ensure that you choose a layer that is lower than any layer that your playlist objects use in the same layout. Otherwise, your DMP displays will not show the screen zone that the box object represents. To understand the use of layers in DMD, see Understanding the Layers Panel and Its Options, page 3-47.

If you right-click a box object after it is part of your layout, a shortcut menu appears. To understand its options, see the “Edit Menu” section in Table 3-11 on page 3-38.

Note  The Properties panel values that you see might be misleading for a box object after you select it on the workspace, if you have associated it with a ticker action. Furthermore, box object attributes that you see in the Properties panel can differ according to the type of ticker action that you use. If you use a static ticker, there are two possible scenarios. In the first scenario, you enter Properties panel text for the box object but not for the ticker action, so the ticker shows the text that you entered for the box object because it has no alternative. In the second scenario, you enter Properties panel text separately for both the box object and the ticker action, and the ticker ignores the text that you entered for the box object because instead, it shows the text that you entered for the ticker action. In that case, even though you can see in the Properties panel that you entered text for your box object, DMD ignores that text. There is only one relevant scenario if you use an RSS ticker, assuming that the server for your RSS feed is reachable and configured correctly. The RSS ticker always shows what it receives from the RSS server, without regard for any text that you might have entered in the Properties panel after you selected your box object on the workspace or in the Layouts panel. Even though you can see in the Properties panel that you entered text for your box object, DMD ignores that text.
Nonvideo Playlist

Creates a new screen zone and a new layer where you can arrange and play back in any combination an ordered sequence of JPEG, GIF, and PNG files, SWF files, and pages on web servers. If you place a bitmapped image in a playlist object, be sure that the playlist object uses the same height and width in pixels that the bitmapped file uses. If the playlist object is too small, the displayed image will be cropped. It will not be resized or scaled automatically.

To start using a nonvideo playlist object, drag it to the workspace from the Objects/Actions panel or select **Tools > Add Object > Nonvideo Playlist**. A layout can contain any number of nonvideo playlist objects at a time.

To populate and configure the object, click it on the workspace or in the Layouts panel, then make selections in the Properties panel. For example, the Properties panel is where you define the playback sequence for a playlist and define the playback duration for each entry that it contains. To understand the Properties panel, see **Understanding the Properties Panel and Its Options, page 3-48**.

You can place this object on any layer in your layout. To understand layers in Digital Media Designer, see **Understanding the Layers Panel and Its Options, page 3-47**.

If you right-click a playlist object after it is part of your layout, a shortcut menu appears. To understand its options, see the “Edit Menu” section in **Table 3-11 on page 3-38**.

**Note**  The Properties panel values that you see for a selected playlist object might be misleading if you have used a synchronize playlists action to override the natural timing of transitions between assets in the playlist. See the “Synchronize Playlists” row elsewhere in this table.

---

**Table 3-13  Digital Media Designer — The Objects/Actions Panel (continued)**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Nonvideo Playlist</td>
<td>Creates a new screen zone and a new layer where you can arrange and play back in any combination an ordered sequence of JPEG, GIF, and PNG files, SWF files, and pages on web servers. If you place a bitmapped image in a playlist object, be sure that the playlist object uses the same height and width in pixels that the bitmapped file uses. If the playlist object is too small, the displayed image will be cropped. It will not be resized or scaled automatically. To start using a nonvideo playlist object, drag it to the workspace from the Objects/Actions panel or select <strong>Tools &gt; Add Object &gt; Nonvideo Playlist</strong>. A layout can contain any number of nonvideo playlist objects at a time. To populate and configure the object, click it on the workspace or in the Layouts panel, then make selections in the Properties panel. For example, the Properties panel is where you define the playback sequence for a playlist and define the playback duration for each entry that it contains. To understand the Properties panel, see <strong>Understanding the Properties Panel and Its Options, page 3-48</strong>. You can place this object on any layer in your layout. To understand layers in Digital Media Designer, see <strong>Understanding the Layers Panel and Its Options, page 3-47</strong>. If you right-click a playlist object after it is part of your layout, a shortcut menu appears. To understand its options, see the “Edit Menu” section in <strong>Table 3-11 on page 3-38</strong>. <strong>Note</strong>  The Properties panel values that you see for a selected playlist object might be misleading if you have used a synchronize playlists action to override the natural timing of transitions between assets in the playlist. See the “Synchronize Playlists” row elsewhere in this table.</td>
</tr>
</tbody>
</table>
Video Playlist

Creates a new screen zone and a new layer where you can arrange and play back in any combination an ordered sequence of video files (MPEG-1 and MPEG-2 files for all DMP model types and MPEG-4 part 10 H.264 files on the DMP 4400G model exclusively), SWF files, JPEG, GIF, and PNG files, multicast video streams, and pages on web servers.

Tip

When you use a video playlist object, it becomes the topmost layer automatically in your presentation. Other object types (nonvideo playlist objects and box objects) are rendered in back of the video playlist object, which means that you cannot use them to create an overlay or mask for video. To use an overlay of that kind, we recommend that you encode the video file itself so that it includes an overlay before you add it to your media library. Alternatively, you can use JavaScript to create a presentation outside of DMD.

If you place a bitmapped image in a playlist object, be sure that the playlist object uses the same height and width in pixels that the bitmapped file uses. If the playlist object is too small, the displayed image will be cropped. It will not be resized or scaled automatically.

To start using a video playlist object, drag it to the workspace from the Objects/Actions panel or select Tools > Add Object > Video Playlist. A layout cannot contain any more than one video playlist object at a time.

To populate and configure the object, click it on the workspace, then make selections in the Properties panel. For example, the Properties panel is where you define the playback sequence for a playlist and define the playback duration for each entry that it contains. To understand the Properties panel, see Understanding the Properties Panel and Its Options, page 3-48.

You can place this object on any layer in your layout. To understand layers in Digital Media Designer, see Understanding the Layers Panel and Its Options, page 3-47.

If you right-click a playlist object on the workspace, a shortcut menu appears. To understand its options, see the “Edit Menu” section in Table 3-11 on page 3-38.

Note

The Properties panel values that you see might be misleading for a playlist object after you select it on the workspace, if you have used a synchronize playlists action to override the natural timing of transitions between assets in the playlist. See the “Synchronize Playlists” row elsewhere in this table.

New Screen

Restarts your design process by closing the open layout—discarding any design work in it that you have not saved—and showing to you a completely new representation of a blank DMP display as your workspace. Because each presentation and each presentation template can contain only one screen, the new workspace does not have any objects, actions, or playlists associated with it—even if the closed layout used them.

To start using a new screen, drag it to the workspace from the Objects/Actions panel or select Tools > Add Object > Screen. DMD asks you if you really want to proceed. By proceeding, you will discard any unsaved work in the layout that you close.
Working with Presentations, Templates, and Presentation Playlists for Digital Signage

Chapter 3      Managing Digital Signage and Enterprise TV

Table 3-13    Digital Media Designer — The Objects/Actions Panel (continued)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Static Text Ticker](Image) | Static Text Ticker | Places a static ticker action on your workspace. Its size and placement on the workspace do not matter because actions do not, by themselves, occupy any space on a screen. A ticker action will not produce a visible ticker on your DMP displays until you finish configuring the association between the action and the object, save your work, and deliver your presentation to a DMP as part of a scheduled deployment. You can use only one ticker per box object. The workflow for this action is as follows:  
1. To add the potential for a static text ticker to your layout, drag its action type to the workspace from the Objects/Actions panel or select its type from the Tools menu.  
2. Select the action on your workspace.  
3. In the Properties panel:  
   a. Enter text for your ticker in the Text field.  
   b. From the Assign to Object list, select the box object that should contain the ticker. |

| ![RSS Text Ticker](Image) | RSS Text Ticker | Places an RSS ticker action on your workspace. Its size and placement on the workspace do not matter because actions do not, by themselves, occupy any space on a screen.  
A ticker action will not produce a visible ticker on your DMP displays until you finish configuring the association between the action and the object, save your work, and deliver your presentation to DMPs as part of a scheduled deployment. Your DMPs will check the RSS feed and update the ticker every 15 minutes. You can use only one ticker per box object. The workflow for this action is as follows:  
1. To add the potential for an RSS ticker to your layout, drag its action type to the workspace from the Objects/Actions panel or select its type from the Tools menu.  
2. Select the action on your workspace.  
3. In the Properties panel:  
   a. Enter the RSS feed source URL for your ticker in the RSS URL field.  
   The feed that you specify should be one that does not include any file enclosures. We recommend as a best practice that you use only RSS feeds over which you have direct editorial control.  
   b. From the Assign to Object list, select the box object that should contain the ticker. |
Understanding the Layers Panel and Its Options

The Layers panel lists all of the objects that you have dragged to your workspace, sorted by their placement on different layers. Each layer holds one object only, and each object represents one screen zone.

- The object at the bottom of the list is also the screen zone that is behind or under all of your other screen zones in this layout.
- The object at the top of the list is also the screen zone that is in front of or on top of all of your other screen zones in this layout.
- If you select an object in the list, you can use buttons in the Properties panel to manipulate the selected object.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Tool Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗑️</td>
<td>Remove</td>
<td>Deletes the selected object.</td>
</tr>
<tr>
<td>🔹️</td>
<td>Bring to Front</td>
<td>Moves the selected object to the absolute top layer.</td>
</tr>
<tr>
<td>🔹️</td>
<td>Move Up</td>
<td>Moves the selected object up by one layer per click.</td>
</tr>
<tr>
<td>🔻️</td>
<td>Move Down</td>
<td>Moves the selected object down by one layer per click.</td>
</tr>
<tr>
<td>🔷️</td>
<td>Send to Back</td>
<td>Moves the selected object to the absolute bottom layer.</td>
</tr>
</tbody>
</table>

Note: If you plan ahead, you can keep in mind the eventual synchronization of two playlists when you populate them and configure the playback duration for each asset. If you do not plan ahead, synchronization might truncate the playback for one or more assets in the secondary playlist.
Understanding the Navigator Panel and Its Options

The Navigator panel shows a wireframe thumbnail view of, and scrolling controller for, your workspace in DMD. The Navigator panel is especially useful when you design presentations for high-definition DMP displays, because you might not be able to see the entire design all at one time in the workspace area.

To scroll the workspace vertically and horizontally, click and move the small gray rectangle from place to place inside the Navigator panel.

Understanding the Properties Panel and Its Options

Shows the editable and uneditable properties of the selected object or action. The type of properties that you see depend on the type of object or action that you select on the workspace or in the Layouts panel.

Table 3-15 Digital Media Designer — The Properties Panel

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Border {Style</td>
<td>Width</td>
</tr>
<tr>
<td>Assign to Object</td>
<td>Select the box object that represents the screen zone where the selected ticker action should show its ticker.</td>
</tr>
<tr>
<td>Duration</td>
<td>Shows the playback duration for each asset in the selected playlist. If you use the Synchronize Playlists action to make the selected playlist secondary, the duration values shown here might not have any bearing on how long an asset plays back before the playlist transitions to the next asset. There is no factory default duration value for nonvideo assets, so you must enter all such duration values manually.</td>
</tr>
<tr>
<td>Type</td>
<td>Signifies the type of playlist. This value is not editable.</td>
</tr>
<tr>
<td>Name</td>
<td>An editable field or an uneditable column in a table:</td>
</tr>
<tr>
<td></td>
<td>• Enter a unique and meaningful name in the Name field to identify the selected object or action.</td>
</tr>
<tr>
<td></td>
<td>• Click the Name column heading to sort the table by the values in that column.</td>
</tr>
<tr>
<td>Playlist Items</td>
<td>To understand the elements in the Playlist Items area, see Understanding the Playlist Items Area and Its Options, page 3-51.</td>
</tr>
<tr>
<td></td>
<td>To learn about the workflow to create a playlist, see Creating and Organizing Presentation Playlists, page 3-49.</td>
</tr>
<tr>
<td>Primary Playlist</td>
<td>Select the playlist object whose transition timing between assets during playback should override the equivalent transition timing of a secondary playlist.</td>
</tr>
<tr>
<td>RSS URL</td>
<td>Enter the source URL for the RSS feed.</td>
</tr>
<tr>
<td>Effect</td>
<td>Choose whether the ticker should fade or scroll and, for scrolling, choose the direction of motion. For a DMP 4300G or 4305G, only the fading effect is supported. For a DMP 4400G, all effects are supported.</td>
</tr>
<tr>
<td>Secondary Playlist</td>
<td>Select the playlist object whose transition timing between assets during playback should be overridden by the equivalent transition timing from the primary playlist.</td>
</tr>
</tbody>
</table>
Chapter 3  Managing Digital Signage and Enterprise TV

Working with Presentations, Templates, and Presentation Playlists for Digital Signage

Creating and Organizing Presentation Playlists

Presentations that you design in DMD can contain playlists that you configure. A presentation playlist contains assets from one or more media library categories or remote servers and shows these assets in the sequence that you specify. The only way to save a presentation playlist and deploy it to your DMPs is inside a presentation.

Caution

Important considerations apply to your presentation playlists when you use ACNS. Before you delete a channel from ACNS, you must first remove from the shared schedule for DMM-DSM and DMM-ETV every presentation playlist that calls upon the channel. Then, you must edit all affected presentation playlists so that they do not use the channel. Otherwise, if a presentation playlist is scheduled for deployment but you delete an ACNS channel that it uses for content distribution, you will be prevented from deleting the playlist manually even though your DMPs cannot obtain its assets successfully from the deleted channel.

Before You Begin

- You must add assets to your media library before you can organize them in a playlist. See the “UI Reference: {Add | Edit} Asset Dialog Box” row in Table 3-7 on page 3-28.
- You must add a DMP to DMM-DSM before you can deploy any presentations to it, and you must organize your DMPs into groups before you can deploy any presentation to a group. The DMP Groups list does not show any DMPs until you add at least one. See Managing and Grouping Your DMPs, page 3-6.
- You must add an external deployment server to DMM-DSM before you can deploy any presentations to it. The DMP Groups list does not show any external servers until you add at least one. You cannot use the Schedules > Immediate Deployment feature with external deployment servers. All deployments to your external deployment servers require that you use the Schedules > Play in Future feature. See Configuring DMM-DSM to Deploy to External Servers, page 3-88.

Table 3-15  Digital Media Designer — The Properties Panel (continued)

| Text {Size | Color | Horizontal Alignment | Vertical Alignment | Text} | All of the following:
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Increases or decreases the text size (in pixels), depending respectively on whether you click the arrow head that points up or the arrow head that points down.</td>
</tr>
<tr>
<td></td>
<td>• Changes the text size (in pixels) to the numeric value that you enter.</td>
</tr>
<tr>
<td></td>
<td>• Changes the text color to match a color that you select after you click ... or to match a hexadecimal color value that you enter.¹</td>
</tr>
<tr>
<td></td>
<td>• Changes the horizontal or vertical alignment of text to match the alignment types that you select.</td>
</tr>
<tr>
<td></td>
<td>• Shows exactly the text that you enter in the Text field.</td>
</tr>
<tr>
<td>URL</td>
<td>An uneditable column in a table, where each row shows the URL for one remote playlist asset.</td>
</tr>
<tr>
<td>{Width</td>
<td>Height}</td>
</tr>
<tr>
<td>{X</td>
<td>Y}</td>
</tr>
</tbody>
</table>

¹. The text color that you use should be one that results in clear and legible text against the background color that you specified; if there is not enough difference between the two colors, your audience might not see information clearly when you use this layout to show text on a DMP display.
Tip

We recommend that you use the advanced task called DMP Startup URL and enter a value for either the Video URL or the Browser URL. If both values are blank, you might find that your DMP sometimes loses its ability to play even the Shockwave Flash files that it has played successfully in the past. To learn how to use advanced tasks, see Using Advanced Tasks, page 3-56. To understand this advanced task, see the “DMP Startup URL” row in Table 3-19 on page 3-57.

Step 1

In DMD, do any of the following:

- Drag a playlist object (video or nonvideo) to the workspace from the Objects/Actions panel.
- Click a playlist object that you already placed on your workspace.
- Click a playlist object in the Layers panel.

The Properties panel now contains an area called “Playlist Items,” where you can make selections that add, remove, or rearrange assets in a presentation playlist. To understand how presentation playlists for DMD differ from other playlists in DMM-DSM, see Working with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33.

Step 2

In the Playlist Items area, enter values and select options that meet your requirements. To understand the Playlist Items area, see Table 3-16 on page 3-51.

Step 3

To open the Content Chooser dialog box, where you configure a presentation playlist, click \:\. To understand the Content Chooser dialog box, see Table 3-17 on page 3-53.

Step 4

To save a presentation playlist after you have populated and organized it and set the playback duration for each of its assets, click Submit in the Content Chooser dialog box.

Step 5

To save a presentation or a template after you have finished designing it, select File > Save in DMD. To understand the dialog box for saving your designs, see the “File Menu” section of Table 3-11 on page 3-38.

Step 6

Deploy the presentation to the DMP displays that should show it. See Scheduling Time Slots for Media and Events on DMPs, page 3-73.
Understanding the Playlist Items Area and Its Options

The Playlist Items area loads inside the Properties panel when the selected object on your workspace is either a video playlist object or a nonvideo playlist object.

- To understand these two object types for presentation playlists, see Table 3-13 on page 3-43.
- To understand other elements inside the Properties panel, see Understanding the Properties Panel and Its Options, page 3-48.

Table 3-16 Elements for Managing Presentation Playlists

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>unlabeled check box</td>
<td>Click to select (or to deselect) one or more assets so that you can change the playback sequence of, or remove assets from, the playlist that you are editing.</td>
</tr>
<tr>
<td>asset location</td>
<td>Shows a miniature icon to indicate whether you selected the asset from your media library or from a remote server.</td>
</tr>
<tr>
<td>IANA Internet media type</td>
<td>Shows a miniature file icon to represent the asset that the corresponding row describes. DMD identifies assets according to their IANA-registered Internet media types. To learn about media types and understand the requirements to register them, see <a href="http://www.iana.org/assignments/media-types/">http://www.iana.org/assignments/media-types/</a>.</td>
</tr>
<tr>
<td>Name</td>
<td>A unique and human-readable name that you entered.</td>
</tr>
<tr>
<td>Duration, sec</td>
<td>The playback duration in seconds for the asset that the corresponding row describes. Click a value to see and use its duration control ( ), which is hidden until you click the value. To increase the playback duration by 1 second, click the top of a control. Alternatively, to reduce the playback duration by 1 second, click the bottom of a control. To increment or decrement the duration value quickly, hold down the mouse button after you click the top or the bottom of a control.</td>
</tr>
<tr>
<td>URL</td>
<td>Shows the storage URL for the asset that the corresponding row describes.</td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Content Chooser dialog box, where—to populate a playlist—you make selections from your media library or enter the URLs for remotely stored assets. To understand the Content Chooser dialog box, see Table 3-17 on page 3-53.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes all of the selected assets from the relevant playlist. Nonetheless, the assets remain in your media library or on the remote server from which you selected them.</td>
</tr>
<tr>
<td>Move Up</td>
<td>Reorders the playlist so that the selected asset moves up one row, exchanging places with the asset that was above it.</td>
</tr>
<tr>
<td>Move Down</td>
<td>Reorders the playlist so that the selected asset moves down one row, exchanging places with the asset that was below it.</td>
</tr>
</tbody>
</table>
Understanding the Content Chooser and Its Options

The Content Chooser dialog box is part of DMD. You use the Content Chooser to populate a presentation playlist. To save your work and use a presentation playlist that you have populated, click **Submit**. Alternatively, to discard your work, click **Cancel**.

**Tip**

We recommend that you use the advanced task called DMP Startup URL and enter a value for either the Video URL or the Browser URL. If both values are blank, you might find that your DMP sometimes loses its ability to play even the Shockwave Flash files that it has played successfully in the past. To learn how to use advanced tasks, see Using Advanced Tasks, page 3-56. To understand this advanced task, see the “DMP Startup URL” row in Table 3-19 on page 3-57.
## UI Reference: The Content Chooser

Table 3-17 on page 3-53 describes elements in the Content Chooser dialog box.

### Table 3-17  Elements to Manage Assets in Playlists

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Content Manager</td>
<td>Tabs that you can select, which determine whether the Available Content table will URL} show selectable assets in your media library or help you to select an asset that is stored remotely.</td>
</tr>
<tr>
<td>Content Groups</td>
<td>An object selector that lists all of the categories in your media library and that is visible only when the Content Manager tab is selected. From the object selector, click the one category that the Available Content table should describe. See Working with Assets and Categories in Your Media Library, page 3-27.</td>
</tr>
<tr>
<td>Available Content</td>
<td>A table, which describes every available asset in the category that you clicked. Click any other category to see descriptions of its assets in the Available Content table.</td>
</tr>
<tr>
<td>Add to Playlist</td>
<td>Adds to the Selected Items table whichever assets you have checked in the Available Content table, so that they might be included in a playlist. To add more assets to the Selected Items table, repeat this step as many times as necessary.</td>
</tr>
<tr>
<td>Name</td>
<td>The name that you entered for the asset.</td>
</tr>
<tr>
<td>Type</td>
<td>Says whether the asset is stored locally or should be retrieved from an HTTP URL.</td>
</tr>
<tr>
<td>Path</td>
<td>Shows the HTTP URL for the described asset.</td>
</tr>
<tr>
<td>External URL</td>
<td>Area where you select an asset that is stored remotely, so that you can add the asset to the Selected Items table.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a name to describe the asset.</td>
</tr>
<tr>
<td>URL</td>
<td>Enter the HTTP URL for the remote asset, or enter the UDP URL and port number.</td>
</tr>
<tr>
<td>Add URL</td>
<td>Add the remote asset to the Selected Items table, so you can might include it in a playlist.</td>
</tr>
</tbody>
</table>
Chapter 3      Managing Digital Signage and Enterprise TV

Working with Presentations, Templates, and Presentation Playlists for Digital Signage

Creating and Organizing Ordinary Playlists

Note

- Playlists that you create under the Digital Signage tab are separate from and mutually exclusive from the presentation playlists that you create in DMD. To assign a playlist to a zone for a presentation, you must use a presentation playlist, which you used DMD to create.
- You cannot add an advanced task (or a system task) to a playlist. However, you can schedule advanced tasks to occur between playlists.

Step 1  Choose Digital Signage > Playlists.
Step 2  Select the options and enter the values that meet your requirements.
If you do not understand your options, see Table 3-18 on page 3-55. When you make selections anywhere on the Playlists page, it is updated automatically to show the options and features that are relevant to your selection.

**UI Reference: New Playlist Dialog Box**

**Table 3-18  Elements to Define an Ordinary Playlist**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>The title for this playlist.</td>
</tr>
<tr>
<td>Assets</td>
<td>A table in which each row describes one asset. Attributes are sorted into these columns:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Title</strong> — A unique and human-readable name for the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>File Type</strong> — the type that best describes the asset: Video, Shockwave Flash, Images, HTML, or Firmware.</td>
</tr>
<tr>
<td></td>
<td>- {<strong>Estimated</strong> | <strong>Planned</strong>} — Respectively:</td>
</tr>
<tr>
<td></td>
<td>- An estimate of the actual running time from start to finish of the described asset, without regard for the amount of time the playlist has reserved to show it.</td>
</tr>
<tr>
<td></td>
<td>- The amount of time that is reserved in the playlist to show this asset.</td>
</tr>
<tr>
<td></td>
<td>A planned duration of 0 (zero) seconds in the playlist causes a video to play from beginning to end. To skip a video instead of playing it, you must remove it from the playlist. Nonvideo assets must have a duration of 1 second or more for each that you include in a playlist.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Size</strong> — The file size.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Delete</strong> —</td>
</tr>
<tr>
<td></td>
<td>To select additional assets from your media library that this playlist should include, click <strong>Add Assets</strong>. To change the sequence of playback for assets in this playlist, select an asset that should move and then click either <strong>Move Playlist Item Up</strong> or <strong>Move Playlist Item Down</strong>.</td>
</tr>
<tr>
<td>Randomize</td>
<td>Enables or disables a randomized sequence of playback for assets in this playlist. To turn randomization on, check the check box. To turn randomization off, uncheck the check box.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Choose the resolution of your DMP display from the <strong>Select</strong> list or enter its width and height, in pixels.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of this playlist. The description is optional.</td>
</tr>
<tr>
<td>Playlist Owner</td>
<td>Your name or the name of the person who manages this playlist.</td>
</tr>
</tbody>
</table>
Using Advanced Tasks

Many advanced tasks and options are available to you in DMM-DSM. Your expectations and goals for your digital signage network determine which tasks and options are relevant to you at any particular time or for any particular purpose.

**Step 1**  Select **Digital Media Players > Advanced Tasks**, and then click an application name in the **Application Types** list, as follows:

<table>
<thead>
<tr>
<th>Application Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Go to) URL</td>
<td>Load media from a web server into TVzilla, the embedded browser on a DMP. See the “Go to URL” section on page 3-57.</td>
</tr>
<tr>
<td>DMP Audio/Video Settings</td>
<td>Adjust the audio and video signals that DMPs send to their attached DMP displays. See the “DMP Audio/Video Settings” section on page 3-57.</td>
</tr>
<tr>
<td>DMP Discovery</td>
<td>Autoregister the DMPs in a network range that you specify and add those DMPs to DMM-DSM for centralized management. See the “DMP Discovery” section on page 3-58.</td>
</tr>
<tr>
<td>DMP Display Controls</td>
<td>Bind together a group of RS232 instructions that you can use to remotely configure display settings on some DMTECH and NEC display models when displays of these types are attached to your DMPs. See the “DMP Display Controls” section on page 3-59.</td>
</tr>
<tr>
<td>DMP Failover Retry</td>
<td>Set the DMP Recovery URL value and the Recovery Timeout value. See the “DMP Failover Retry” section on page 3-59.</td>
</tr>
<tr>
<td>DMP Firmware Upgrade</td>
<td>Select firmware upgrades and patches to send to one or more DMPs. See the “DMP Firmware Upgrade” section on page 3-60.</td>
</tr>
<tr>
<td>DMP Startup URL</td>
<td>Configure DMPs to load a particular HTTP URL when you start or restart them. See the “DMP Startup URL” section on page 3-61.</td>
</tr>
</tbody>
</table>
| File Transfer to DMP or Server      | Use HTTP pulling or use FTP to transfer to your DMPs, or use FTP to transfer to your FTP servers (external deployment servers), the:  
  - Assets from presentations that you prepared in Digital Media Designer.  
  - Commands and settings from advanced tasks that you selected or configured under the Digital Media Players tab.  
  See the “File Transfer to DMP or Server” section on page 3-62. |
| System Tasks                        | Select an administrative command to send to one or more DMPs. See the “System Tasks” section on page 3-63. |

**Step 2**  *(Optional)* If you previously defined or configured options for the relevant application and you saved your selections, click any row in the Applications table to select one of the operations that you defined; the row that you click should be one that you want to edit, deploy to DMPs, or delete.

**Step 3**  Do one of the following:

- To define or configure options for a new operation, click  
  ![Add New Application](add_new_application_icon.png)  
  Add New Application.
- To edit the options that you previously defined or configured for the operation that you selected in Step 2, click  
  ![Edit Application](edit_application_icon.png)  
  Edit Application.
- To delete the operation that you selected in Step 2, click  
  ![Delete Application](delete_application_icon.png)  
  Delete Application.

**Step 4**  If you clicked  
  ![Add New Application](add_new_application_icon.png)  
  Add New Application or  
  ![Edit Application](edit_application_icon.png)  
  Edit Application, the page is refreshed and you can select options or enter values that define or redefine the behavior for this operation.
Step 5  To save your selections, click **Submit**. Otherwise, click **Cancel** to discard your selections.

Step 6  To deploy to your DMPs the commands that you saved in Step 5, see Scheduling Time Slots for Media and Events on DMPs, page 3-73.

### Table 3-19  Understanding and Using Advanced Tasks

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description, Icons, and Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to URL</td>
<td>Load media from a web server into TVzilla, the embedded DMP browser.</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong> — A unique and human-readable name for the website that you will select to show in this task. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.</td>
</tr>
<tr>
<td></td>
<td><strong>Description</strong> — A brief description. The description is optional.</td>
</tr>
<tr>
<td></td>
<td><strong>URL</strong> — The full and correct HTTP URL that points to a page or file on a webserver. The URL that you enter should point to a page that is dynamic and does not require any human interaction (such as clicking or scrolling) to be useful or interesting. You must enter a URL.</td>
</tr>
<tr>
<td>DMP Audio/Video Settings</td>
<td>Adjust the audio and video signals that DMPs send to their attached DMP displays.</td>
</tr>
<tr>
<td></td>
<td><strong>Name</strong> — A unique and human-readable name for the settings that you configure in this task. For example, you might adjust the brightness setting to accommodate a locale where the lighting is dim, then enter a name that identifies that kind of locale. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.</td>
</tr>
<tr>
<td></td>
<td><strong>Description</strong> — A brief description. The description is optional.</td>
</tr>
<tr>
<td></td>
<td><strong>Brightness</strong> — The setting that compensates for any deficiencies in the on-screen brightness of your DMP displays. Brightness compensation values can range from –128 to 127.</td>
</tr>
<tr>
<td></td>
<td><strong>Contrast</strong> — The setting that compensates for any deficiencies in the on-screen contrast of your DMP displays. Contrast compensation values can range from 0 to 255. The default is 128.</td>
</tr>
<tr>
<td></td>
<td><strong>Saturation</strong> — The setting that compensates for any deficiencies in the on-screen color saturation of your DMP displays. Saturation compensation values can range from 0 to 255. The default is 128.</td>
</tr>
<tr>
<td></td>
<td><strong>Left Audio Channel Volume</strong> — The setting to control how loudly or softly your DMP display speakers play sound in the left audio channel. Volume can range from 0 to 100, where 0 is silent. The default is 50.</td>
</tr>
<tr>
<td></td>
<td><strong>Right Audio Channel Volume</strong> — The setting to control how loudly or softly your DMP display speakers play sound in the left audio channel. Volume can range from 0 to 100, where 0 is silent. The default is 50.</td>
</tr>
</tbody>
</table>
### DMP Discovery

Autoregister the DMPs in a network range that you specify and add those DMPs to DMM-DSM for centralized management. For autoregistration and centralized management to succeed:

- Your firewall must allow DMM-DSM and your DMPs to communicate over TCP port 7777 and must also allow ICMP (ping) traffic on this port.
- In DMPDM, you must enable the Enable Cisco TAC Troubleshooting Access option.

To learn about other autoregistration options for the DMPs in your digital signage network, see the "[Add New | Edit] DMP" row in Table 3-2 on page 3-7.

**Note**  
DMP autoregistration operations occur in sequence and cannot overlap. You should not schedule multiple DMP autoregistration operations that overlap or run simultaneously. If you do, only the first such operation will run and DMM-DSM will not show any error message to explain why the other autoregistration operations failed to find any DMPs. If you must run autoregistration tasks that search different subnets, schedule a 35-minute interval between the start time for one autoregistration and the start time for the next autoregistration.

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description, Icons, and Options</th>
</tr>
</thead>
</table>
| DMP Discovery    | Autoregister the DMPs in a network range that you specify and add those DMPs to DMM-DSM for centralized management. For autoregistration and centralized management to succeed:  
- Your firewall must allow DMM-DSM and your DMPs to communicate over TCP port 7777 and must also allow ICMP (ping) traffic on this port.  
- In DMPDM, you must enable the Enable Cisco TAC Troubleshooting Access option.  
To learn about other autoregistration options for the DMPs in your digital signage network, see the "[Add New | Edit] DMP" row in Table 3-2 on page 3-7. |

| Name — A unique and human-readable name for this autoregistration IP address range task. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled. |
| Description — A brief description. The description is optional. |
| Discovery IP Range — The NMAP syntax to describe one or multiple ranges of IP addresses. |
Table 3-19 Understanding and Using Advanced Tasks (continued)

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description, Icons, and Options</th>
</tr>
</thead>
</table>
| DMP Display Controls | Note Before you can use this feature, you must enable RS-232 support for your displays. Select Digital Media Players > Advanced Tasks > System Tasks, then name, save, and deploy one of these as the correct option for your display type:  
  • Turn On DMTech RS-232 Control.  
  • Turn On NEC RS-232 Control.  
  
  Bind together a group of RS-232 instructions that you can use to remotely configure display settings.  
  Tip To learn about the RS-232 commands that manage Cisco LCD displays, see Using RS-232 Commands to Manage Cisco LCD Professional Series Displays, page 3-64.  
  
  — TV Type — Select the manufacturer and the model type:  
    • {DMTECH | NEC_3210 | NEC_4010 | NEC_4610 | NEC_5710}  
  — Contrast — Select or enter a contrast value from 0 to 100.  
  — Brightness — Select or enter a brightness value from 0 to 100.  
  — Sharpness — Select or enter a sharpness value from 0 to 100.  
  — Color — Select or enter a color value from 0 to 100.  
  — Tint — Select or enter a tint value from 0 to 100.  
  — TV Channel — Select or enter the analog television signal frequency for a channel from 0 to 99.  
  — Audio Volume — Select or enter a volume level from 0 to 100.  
  — Mute — Select whether to mute the display.  
    • {on | off}  
  — Input — Select the input type. Options differ, according to your selection from the TV Type list.  
    • {TV | RGB | RGB1 (DVI-D) | RGB2 (D-SUB) | RGB3 (BNC) | DVD/HD | Video (Composite) | Video 1 | Video 2 | Video 3 | S-Video | None (DVBT) | Component | PC | HDMI | None (DVBT)}  
  — Power — Select whether the television should be turned on.  
    • {on | off}  
| DMP Failover Retry | Configure the recovery URL to use in case of failover and the interval between attempts to reload that URL if the connection to it is disrupted.  
  — Name — A unique and human-readable name for the DMP failover retry task that you are configuring. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.  
  — Description — A brief description. The description is optional.  
  — Recovery URL — The URL to show immediately on a DMP display after its attached DMP restarts for any reason, unless other content is scheduled to be shown. If this value is blank, your DMP will reuse the most recent URL that failed to load.  
  — Recovery Timeout (in seconds) — The maximum number of seconds that your DMP will wait for a response from the server that you identify in the Recovery URL field before it tries again to reach that server. There is no maximum number of retry attempts.  

### DMP Firmware Upgrade

**Caution** Before you install an upgrade, you must run the “Stop All Applications” system task on all the affected DMPs. To do so, click the Schedules tab, select the DMP group that you will upgrade, select Stop All Applications from the Actions list, then click Go.

**Note** Before you transfer a firmware upgrade file to the SD memory card in a DMP, you must configure, save, and deploy a system task that causes your DMP to accept the transfer. Select Digital Media Players > Advanced Tasks, click System Tasks in the list of defined tasks, then click Add New Application. Enter a name and description, then select Set from the Request Type list and use this syntax in the Request field:

```
init.startService_shell=yes&mib.save=1&mng.exit=1
```

To restore DMP security after the file transfer is finished, repeat the procedure but use this syntax instead:

```
init.startService_shell=no&mib.save=1&mng.exit=1
```

Send a DMP firmware image from your media library to a DMP and send commands to install the new firmware image.

- **Name** — A unique and human-readable name for the upgrade task that you are configuring. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.
- **Description** — A brief description. The description is optional.
- **Media Categories** — An object selector that lists all the categories in your media library. From the object selector, click the one category that the Available Content table should describe. To learn more about categories, see Working with Assets and Categories in Your Media Library, page 3-27.
  - **Opened Media Library** — Shows all the categories in your media library until you click to hide them.
  - **Closed Media Library** — Hides the list of categories until you click to show them.
  - **Content Category** — A media library category that you created.
- **Available Content** — Click a row to select an asset in the category. Its attributes are:
  - **Name** — A unique and human-readable name that you entered.
  - **Source** — Says whether the asset is a file (F) or an HTTP URL (U).
  - **Data Type** — Identifies the type of asset.
  - **Size** — The file size in bytes.
  - **Path** — The full pathname that points to the file on the DMP.
  - **Description** — A brief description. The description is optional.
  - **Upload Started** — Time stamp (in the format YYYY-MM-DD hh:mm:ss:ms) that says when you started to upload the file.
  - **Upload Finished** — Time stamp (in the format YYYY-MM-DD hh:mm:ss:ms) that says when the file was completely uploaded.
  - **Status** — Says whether a DMP is reachable. A green icon (✔) tells you that the DMP is connected to a power source, uses a known IP address, and is reachable. A red icon (✘) tells you that the DMP is unreachable.
Table 3-19  Understanding and Using Advanced Tasks (continued)

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description, Icons, and Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMP Startup URL</td>
<td>Causes DMPs to load and show media that you specify, immediately after every restart.</td>
</tr>
<tr>
<td>Tip</td>
<td>We recommend that you enter a value for either the Video URL or the Browser URL. If both values are blank, you might find that your DMP sometimes loses its ability to play even the Shockwave Flash files that it has played successfully in the past.</td>
</tr>
<tr>
<td>Name</td>
<td>A unique and human-readable name for the startup URL task that you are configuring. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description. The description is optional.</td>
</tr>
<tr>
<td>Video URL</td>
<td>The HTTP URL (or local path on the DMP) that points to an encoded digital video file that a DMP should load automatically and show immediately after every restart. We do not support any use of spaces in filenames or URLs. The supported transport protocols and URL types are:</td>
</tr>
<tr>
<td></td>
<td>• http://&lt;ip_address&gt;/&lt;path_and_filename&gt;</td>
</tr>
<tr>
<td></td>
<td>• udp://&lt;ip_address_of_multicast_server&gt;/&lt;port_number&gt;</td>
</tr>
<tr>
<td>Browser URL</td>
<td>The HTTP URL of any document that TVzilla, the embedded browser on a DMP, should load automatically and show immediately after each restart. We do not support any use of spaces in URLs. We recommend that you do not point to any document or site that requires human interaction to be useful, interesting, or entertaining, because there is no keyboard or mouse that you can use to interact with what you show on a DMP display.</td>
</tr>
<tr>
<td>Reboot Necessary?</td>
<td>Check the check box if a DMP should restart immediately when it receives this instruction. Uncheck the check box if no immediate restart is required.</td>
</tr>
</tbody>
</table>
### Using Advanced Tasks

#### File Transfer to DMP or Server

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description, Icons, and Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caution</td>
<td>Before you use a file transfer application to deploy the assets from a new or updated presentation to any of your DMPs, you must first run the “Stop All Applications” system task on each affected DMP. To do so, click the Schedules tab, select the DMP group that will use the presentation, select Stop All Applications from the Actions list, then click Go.</td>
</tr>
</tbody>
</table>

Use HTTP pulling or FTP to transfer to particular DMPs or to external (FTP) deployment servers the assets from presentations that you prepared in DMD, the media and electronic program guides for Enterprise TV, or the commands and settings from advanced tasks. (Although it is technically possible, it is not useful to transfer a system task, a go to URL task, or a startup URL task.) See Scheduling Time Slots for Media and Events on DMPs, page 3-73.

- **Name** — A unique and human-readable name for the file transfer task that you are configuring. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.

- **Description** — A brief description. The description is optional.

- **Caution** — HTTP pulling is highly scalable but can result in a distributed denial-of-service (DDoS) attack against any server, such as your DMM appliance, that is not built and configured to withstand the resulting load. If you choose HTTP as the protocol, be sure that your DMPs will pull all files from ACNS or another system that can tolerate the load.

- **DMP Publishing Protocol** — Choose HTTP or FTP as the protocol for the file transfer task.

- **Emergency/Alarm** — Check (tick) this box if the transferred files will be used during emergencies. Otherwise, do not check this box. Assets for emergencies are saved to a special partition.

- **Application Types** — The list of categories for advanced tasks. Click a category to see its tasks.

- **Available Applications** — Advanced tasks in the category that you clicked. Click anywhere in a row to select the corresponding task.
  - **Select Applications** — Moves from the Available Applications table to the Selected Applications table the tasks that you selected.
  - **Name** — The unique and human-readable name that identifies a particular task.
  - **Description** — A brief description. The description is optional.

- **Selected Applications** — Advanced tasks that you selected from the Available Applications table, so that you could include them in the file transfer operation that you are configuring. Click a file transfer task to select its assets for deployment.
  - **Move Selected Item Up/Down** — Reorders the list so that the highlighted item moves up (or down) one row, exchanging places with the item that was above it (or below it).
  - **Delete Selected Item** — Moves from the Selected Applications table to the Available Applications table the applications that you selected.
  - **Zoom In/Out** — Shows only the Selected Applications table, hiding the Available Applications table. Alternatively, shows the Selected Applications table and the Available Applications table simultaneously.

---

*Table 3-19 Understanding and Using Advanced Tasks (continued)*

---

User Guide for Cisco Digital Media Manager 5.0

OL-15762-01

3-62
Chapter 3  Managing Digital Signage and Enterprise TV

Using Advanced Tasks

Table 3-19  Understanding and Using Advanced Tasks (continued)

<table>
<thead>
<tr>
<th>Application Name</th>
<th>Description, Icons, and Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Tasks</td>
<td></td>
</tr>
<tr>
<td><strong>Caution</strong></td>
<td>If you restore factory-default settings on a DMP, you must set it up again, exactly as you would set up a brand-new DMP. (To learn how to set up a DMP, see the quick start guide on Cisco.com for your DMP model.) If you restart a DMP, you will disrupt whatever it is doing at that time. If you save any configuration settings mistakenly, you must reenter the correct settings manually.</td>
</tr>
</tbody>
</table>
| Predefined system commands that you can send to a DMP. If you will use this feature to pass RS-232 commands through your DMPs and to your DMP displays, first confirm that an RS-232 cable connects each DMP to its associated DMP display; otherwise, your displays will not receive the commands that you define for them. When you create or edit a system task, these are the elements:

- **Name** — A unique and human-readable name for the system task that you are configuring. You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.

- **Description** — A brief description. The description is optional.

- **Request Type** — A list in which the options are *Get* and *Set*, in the sense that you can set new values on a DMP or instruct DMM-DSM to get information from a DMP and show that information in a popup window.

- **Request** — The command string.

  - **Default** — Restore factory default settings.
  - **FTP** *(Off | On)* — Enable or disable the FTP service.
  - **HDMI Autodetection** *(Off | On)* — Enable or disable DMP display type autodetection.
  - **Reboot** — Restart.
  - **Save Settings** — Save the active settings.
  - **Save Settings and Reboot** — Save the active settings, then restart.
  - **Screen Resolution Autodetection** *(Off | On)* — Enable or disable autodetection of the resolutions that your DMP displays support.
  - **Show** *(Browser | Video)* — Show one content plane but hide the other.
  - **Status** — See the DMP status message in real time.
  - **Stop All Applications** — Stop every application that DMPs are running.
  - **Transparency 50%** — Set the browser plane (TVzilla) to be partially transparent and show the video plane through it.
  - **Turn On DMTech RS-232 LCD Control** — Cause DMPs to send RS-232 management instructions to an LCD display manufactured by DMTech.
  - **Turn On NEC RS-232 LCD Control** — Cause DMPs to send RS-232 management instructions to an LCD display manufactured by NEC.
  - **Upgrade Status** — See the DMP upgrade status message in real time.
  - **Version** — See the installed firmware version number.
Using RS-232 Commands to Manage Cisco LCD Professional Series Displays

When you use an HDMI cable or a DVI cable to connect your DMP to an LCD display model from the Cisco LCD Professional Series, you can use DMM-DSM to centrally manage the LCD display.

When HDMI is the connection type from a DMP to a Professional Series display, centralized management from DMM works immediately, without any prerequisites. However, when DVI is the connection type, you must prepare your LCD display before you can start to centrally manage it.

- Preparing a Cisco LCD Display for Centralized Management Through DVI, page 3-64
- RS-232 Command Reference for Cisco LCD Displays, page 3-64

Preparing a Cisco LCD Display for Centralized Management Through DVI

When HDMI is the connection type from a DMP to a Professional Series display, centralized management from DMM works immediately, without any prerequisites. However, when DVI is the connection type, you must complete a simple task at the physical installation site for your LCD display before you can start to centrally manage it.

Procedure

**Step 1**

Do either of the following:

- On the remote control for your LCD display, press **Menu**.
- On the front panel of your LCD display, press **Menu**.

**Step 2**

Choose **Input > Source List > DVI**, and then press **Enter**.

**Step 3**

Choose **Input > Edit Name > DVI > HD STB**, and then press **Enter**.

RS-232 Command Reference for Cisco LCD Displays

Tables in this section describe RS-232 command strings that you can use for centralized management of LCD display models from the Cisco LCD Professional Series:

- LCD 100-Pro-40N (40” model)
- LCD-110-Pro-52S (52” model)

The RS-232 command strings are described in these tables:

- Turning the Display On and Off, page 3-65
- Muting and Unmuting the Display, page 3-65
- Adjusting Brightness, page 3-65
- Adjusting Colorfulness, page 3-65
- Adjusting Contrast, page 3-65
- Turning the Remote Control On and Off, page 3-65
- Locking and Unlocking the Display and Its Remote Control, page 3-66
### Turning the Display On and Off

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn on the display</td>
<td>rs232.tx_hex=aa11fe010111</td>
</tr>
<tr>
<td>Turn off the display</td>
<td>rs232.tx_hex=aa11fe010010</td>
</tr>
</tbody>
</table>

### Muting and Unmuting the Display

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute the display</td>
<td>rs232.tx_hex=aa13ff010114</td>
</tr>
<tr>
<td>Unmute the display</td>
<td>rs232.tx_hex=aa13ff010013</td>
</tr>
</tbody>
</table>

### Adjusting Brightness

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set brightness to 50 percent</td>
<td>rs232.tx_hex=aa25ff013257</td>
</tr>
<tr>
<td>Set brightness to 75 percent</td>
<td>rs232.tx_hex=aa25ff014b70</td>
</tr>
<tr>
<td>Set brightness to 100 percent</td>
<td>rs232.tx_hex=aa25ff016489</td>
</tr>
</tbody>
</table>

### Adjusting Colorfulness

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set colorfulness(^1) to 50 percent</td>
<td>rs232.tx_hex=aa27ff013259</td>
</tr>
<tr>
<td>Set colorfulness to 75 percent</td>
<td>rs232.tx_hex=aa27ff014b72</td>
</tr>
<tr>
<td>Set colorfulness to 100 percent</td>
<td>rs232.tx_hex=aa27ff01648b</td>
</tr>
</tbody>
</table>

\(^1\) An image with a colofulness value of zero percent is grayscale, while the same image with a colorfulness value of 100 percent has vivid colors.

### Adjusting Contrast

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set contrast to 50 percent</td>
<td>rs232.tx_hex=aa24ff013256</td>
</tr>
<tr>
<td>Set contrast to 75 percent</td>
<td>rs232.tx_hex=aa24ff014b6f</td>
</tr>
<tr>
<td>Set contrast to 100 percent</td>
<td>rs232.tx_hex=aa24ff016488</td>
</tr>
</tbody>
</table>

### Turning the Remote Control On and Off

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn on the remote control</td>
<td>rs232.tx_hex=aa36ff010137</td>
</tr>
<tr>
<td>Turn off the remote control</td>
<td>rs232.tx_hex=aa36FF010036</td>
</tr>
</tbody>
</table>
Planning for and Responding to Emergencies

When emergencies of any kind affect sites where you deploy digital signage, you can use DMP displays to alert your viewers, warn them about dangers that might affect them, and direct them to safety. Or you can provide other kinds of information to them as you see fit. Until you stop playing emergency messages, they override all events that were scheduled to run automatically.

It is important to remember that emergency message insertions in your schedule will override only the events that are scheduled to run automatically. Furthermore, such insertions will override these events on only the DMPs that the emergency message insertion affected. All other DMPs in your network will abide by their schedule, without disruption. To understand the schedule and learn about the manual and automatic methods for scheduling, see Scheduling Time Slots for Media and Events on DMPs, page 3-73.

Emergency conditions might prevent messages from playing on your DMP displays.

Consider very carefully which DMM-DSM users should have permission to work with your schedule and manage your DMP groups. Although all of the “Play in Future” features are suspended (for affected DMPs only) while an emergency is in progress, none of the “Play Now” features or “DMP Manager” features are suspended. Therefore, it is possible for a user with sufficient permissions to start another event manually on the DMPs where an emergency message should be playing.

If policies in your organization require of you that one or more screen zones must show assets that are editable, you can stage the editable assets remotely on one of your external deployment servers instead of staging them locally on your DMPs. Then, the people in your organization who are entrusted to edit these assets can change them—to update the emergency message, for example—in real time.

After an emergency has stopped and normal scheduling has resumed on a DMP group and its children, any playlist or presentation that was scheduled for playback at that time will start from the beginning.

The emergency messaging features in DMM-DSM are designed with these scenarios in mind:

- **Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately**, page 3-67
- **Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage**, page 3-68
- **Emergency Scenario 3: Schedule the Staging of Assets to a Remote Server**, page 3-69
- **Emergency Scenario 4: Start Playback of an Emergency Message**, page 3-71
- **Emergency Scenario 5: Stop Playback of an Emergency Message**, page 3-72

---

**Locking and Unlocking the Display and Its Remote Control**

<table>
<thead>
<tr>
<th>Task</th>
<th>RS-232 Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lock all features</td>
<td>rs232.tx_hex=aa5dff01015e</td>
</tr>
<tr>
<td>Unlock all features</td>
<td>rs232.tx_hex=aa5dff01005d</td>
</tr>
</tbody>
</table>
Chapter 3      Managing Digital Signage and Enterprise TV

Planning for and Responding to Emergencies

Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately

In this scenario, you start immediately to transfer assets for emergency messaging that will be staged locally on your DMPs. This scenario describes one of three possible staging methods that you can use to deploy assets for use during an emergency. To learn about the two other staging methods, see Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68, and Emergency Scenario 3: Schedule the Staging of Assets to a Remote Server, page 3-69.

Before You Begin
- This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.
- This scenario assumes that you already created the playlist or presentation whose assets you will transfer to your DMPs. See Working with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33.

Step 1
Choose Digital Media Players > Advanced Tasks, and then click File Transfer to DMP or Server.

Step 2
To create a new file transfer task, click Add New Application.

Step 3
After the page is refreshed, do the following to define behaviors for, and save, the file transfer task:

a. Enter a specific name, such as “Fire” or “Flash Flood,” for the type of emergency. You might want to use a less specific name, such as “Emergencies,” if this task will transfer the assets for multiple presentations or playlists, or if your organization uses one playlist or presentation for emergencies of all kinds.

b. From the DMP Publishing Protocol list, choose FTP or HTTP, and then check the Emergency/Alarm check box.

c. If the assets are part of a saved presentation, click Presentations in the Applications list. Alternatively, if the assets are part of a saved playlist, click Playlists.

d. After the page is refreshed, click in the Available Applications list the name of the presentation or playlist whose assets should be transferred, and then click Select Applications.

e. (Optional) To transfer the assets for multiple playlists and presentations, repeat the preceding step.

f. To save this task, so that it becomes available for your use, click Submit.

Note
Even though you created and saved a file transfer task, you have not used it yet. Your DMPs will not have local copies of the emergency assets until after you run this task successfully.

Step 4
To transfer the emergency assets to your DMPs immediately, use one of the following methods.

DMP Manager Method
a. Click the DMP Manager tab and then, in the DMP Groups tree, click the name of the group whose member DMPs should have local copies of the emergency assets.

b. In the Actions list, scroll down to the File Transfer to DMP or Server section and choose the name of the task you created in Step 3.

c. To issue the command immediately that transfers copies of the assets to your DMPs, and to create as many Go-to URL entries (all using the prefix “Alarm”) as the number of presentations and playlists you selected in Step 3, click Go.
Play Now Method

a. Choose Schedules > Play Now.

b. From the Select an Event Type list, choose System Tasks and then click Select System Tasks.

c. After the Select Event dialog box opens, click File Transfer to DMP or Server (in the Type column) and then click the name of the task you created in Step 3 (in the Application Name column).

d. To confirm your selection and close the Select Event dialog box, click OK.

e. In the DMP Groups tree, click the name of the group whose member DMPs should have local copies of the emergency assets.

f. To issue the command immediately that transfers copies of the assets to your DMPs, and to create as many Go-to URL entries (all using the prefix “Alarm”) as the number of presentations and playlists you selected in Step 3, click Submit.

Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage

In this scenario, you schedule a time in the future to transfer assets for emergency messaging that will be staged locally on your DMPs. This scenario describes one of three possible staging methods that you can use to deploy assets for use during an emergency. To learn about the two other staging methods, see Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67, and Emergency Scenario 3: Schedule the Staging of Assets to a Remote Server, page 3-69.

Before You Begin

• This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.

• This scenario assumes that you already created the playlist or presentation whose assets you will transfer to your DMPs. See Working with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33.

Step 1  Choose Digital Media Players > Advanced Tasks, and then click File Transfer to DMP or Server.

Step 2  To create a new file transfer task, click Add New Application.

Step 3  After the page is refreshed, do the following to define behaviors for, and save, the file transfer task:

a. Enter a specific name, such as “Fire” or “Flash Flood,” for the type of emergency. If you will transfer the assets for multiple presentations or playlists, you might want to use a less specific name, such as “Emergencies.”

b. From the DMP Publishing Protocol list, choose FTP or HTTP, and then check the Emergency/Alarm check box.

c. If the assets are part of a saved presentation, click Presentations in the Applications list. Alternatively, if the assets are part of a saved playlist, click Playlists.

d. After the page is refreshed, click in the Available Applications list the name of the presentation or playlist whose assets should be transferred, and then click Select Applications.

e. (Optional) To transfer the assets for multiple playlists and presentations, repeat the preceding step.

f. To save this task, so it becomes available for your use, click Submit.
Step 4  
To schedule the future transfer of the emergency assets to your DMPs, choose **Schedules > Play in Future**, and then do the following:

a. From the calendar, choose the year, month, and day when the assets should be transferred. The timeline is updated automatically, so that it shows the schedule for that day.

b. From the Event Type list, which is located under the timeline, choose **System Tasks**.

c. After the Schedule Task dialog box opens, use it to choose the DMPs:
   1. Click **Select Group**, and then click the name of the group whose member DMPs should have local copies of the emergency assets.
   2. To confirm your selection and close the Select DMP Group dialog box, click **OK**.

d. Choose the task:
   1. Click **Select System Tasks**.
   2. After the Select System Tasks dialog box opens, click **File Transfer to DMP or Server** (in the Types list), and then click the name of the task you created in Step 3 (in the untitled table).
   3. To confirm your selection and close the Select System Tasks dialog box, click **OK**.

You can use the provided controls to adjust the start and stop time for this task. Remember to allow sufficient time for the transfer to complete. The amount of time required can vary according to the cumulative file size of the selected assets, the capacity of your network, any congestion in your network, and possibly other factors. Emergency conditions might prevent messages from playing on your DMP displays.

Do not use any of the provided controls for repeating a task.

e. To confirm your selections and close the Schedule Task dialog box, click **Save**.

f. To save your selections, click **Save All**.

g. To transmit the deployment according to the schedule that you defined, click **Publish All**.

---

**Emergency Scenario 3: Schedule the Staging of Assets to a Remote Server**

In this scenario, you schedule a time in the future to transfer assets for emergency messaging that will be staged on an FTP server or a webserver. This scenario describes one of three possible staging methods that you can use to deploy assets for use during an emergency. To learn about the two other staging methods, see Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67, and Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68.
Planning for and Responding to Emergencies

Before You Begin

- This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and then go to [http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656](http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656).

- This scenario assumes that you already:
  - Entered and saved login credentials for an external server, such as an FTP server or a webserver. See Configuring DMM-DSM to Deploy to External Servers, page 3-88.
  - created the playlist or presentation whose assets you will transfer to your DMPs. See Working with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33.

**Step 1** Choose Digital Media Players > Advanced Tasks, and then click File Transfer to DMP or Server.

**Step 2** To create a new file transfer task, click Add New Application.

**Step 3** After the page is refreshed, do the following to define behaviors for, and save, the file transfer task:

a. Enter a specific name, such as “Fire” or “Flash Flood,” for the type of emergency. If you will transfer the assets for multiple presentations or playlists, you might want to use a less specific name, such as “Emergencies.”

b. From the DMP Publishing Protocol list, choose FTP or HTTP, and then check the Emergency/Alarm check box.

c. If the assets are part of a saved presentation, click Presentations in the Applications list. Alternatively, if the assets are part of a saved playlist, click Playlists.

d. After the page is refreshed, click in the Available Applications list the name of the presentation or playlist whose assets should be transferred, and then click Select Applications.

e. (Optional) To transfer the assets for multiple playlists and presentations, repeat the preceding step.

f. To save this task, so it becomes available for your use, click Submit.

**Note** Even though you created and saved a file transfer task, you have not used it yet. Your external servers will not have copies of the emergency assets until after you run this task successfully.

**Step 4** To schedule the future transfer of the emergency assets to your external servers, choose Schedules > Play in Future, and then do the following:

a. From the calendar, choose the year, month, and day when the assets should be transferred. The timeline is updated automatically, so that it shows the schedule for that day.

b. From the Event Type list, which is located under the timeline, choose System Tasks.

c. After the Schedule Task dialog box opens, use it to choose the DMPs:

   1. Click Select Group, and then click the name of the group whose member DMPs should have local copies of the emergency assets.

   2. To confirm your selection and close the Select DMP Group dialog box, click OK.

d. Choose the task:

   1. Click Select System Tasks.

   2. After the Select System Tasks dialog box opens, click File Transfer to DMP or Server (in the Types list), and then click the name of the task you created in Step 3 (in the untitled table).

   3. To confirm your selection and close the Select System Tasks dialog box, click OK.
You can use the provided controls to adjust the start and stop time for this task. Remember to allow sufficient time for the transfer to complete. The amount of time required can vary according to the cumulative file size of the selected assets, the capacity of your network, any congestion in your network, and possibly other factors. Emergency conditions might prevent messages from playing on your DMP displays.

Do not use any of the provided controls for repeating a task.

e. To confirm your selections and close the Schedule Task dialog box, click **Save**.

f. To save your selections, click **Save All**.

g. To transmit the deployment according to the schedule that you defined, click **Publish All**.

### Emergency Scenario 4: Start Playback of an Emergency Message

**Before You Begin**

- This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and then go to [http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656](http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656).

- This scenario assumes that you already completed Scenario 1 or Scenario 2 and transferred to your DMPs the supporting assets for a playlist or presentation that your DMPs should show during an emergency. To learn about these scenarios, see:
  - Emergency Scenario 1: Stage Assets to DMP Local Storage Immediately, page 3-67
  - Emergency Scenario 2: Schedule the Staging of Assets to DMP Local Storage, page 3-68.

**Step 1**

Do one of the following:

- Choose **Digital Media Players > Emergencies**.
- Choose **Schedules > Emergencies**.

**Step 2**

Click **Start Emergency**.

**Step 3**

From the Select Emergency list, choose the playlist or presentation that your DMPs should play during the type of emergency that is now in progress.

Entries that you see in the Select Emergency list are derived from file transfer tasks that you saved after checking the Emergency/Alarm check box. You cannot add the “ALARM” prefix manually to the name of a Go-to URL task to make the task appear in the Select Emergency list. Nor can you delete the “ALARM” prefix manually from the name of a Go-to URL task to exclude the task from the Select Emergency list.

**Step 4**

Expand the Select DMP Group tree, click the entry for the DMP group whose member DMPs should all announce the emergency, and then click **Start**.

If you choose a DMP group that has child groups, the child groups and their member DMPs are also selected automatically.

While this emergency is in-progress, the event-scheduling features at Schedule > Play in Future will be suspended temporarily for whichever group and children you chose. However, your other DMP groups will not be affected. You still can schedule events for those other groups. Later, after you stop this emergency, the event-scheduling features at Schedule > Play in Future will be restored for the group and children that you chose.
Step 5

To confirm your selections and start playback immediately of your emergency presentation or emergency playlist, click OK. (Emergency conditions might prevent messages from playing on your DMP displays.) Alternatively, to discard your selections without playing any assets for any emergency, click Cancel.

A message tells you whether you submitted the emergency successfully. After you dismiss the message, the page is refreshed. If you submitted the emergency, the DMP group that you chose in Step 4 is colored red in the Select DMP Group tree.

Tip

You can submit an emergency to a DMP group while it is showing a playlist or presentation that describes some other emergency. There is no need to explicitly stop playback of the current emergency message before you start another one.

Emergency Scenario 5: Stop Playback of an Emergency Message

Before You Begin

- This scenario describes features that are included in the 5.0.2 release of Cisco DMS. Before you can use these features, you must upgrade DMS successfully from its 5.0 release. To learn about and obtain the 5.0.2 upgrade patch if you have not installed it, log in to your Cisco.com account, and then go to http://tools.cisco.com/support/downloads/go/Redirect.x?mdfid=281723656.
- This scenario assumes that you already have started playback of an emergency message. See Emergency Scenario 4: Start Playback of an Emergency Message, page 3-71.

Step 1

Do one of the following:

- Choose Digital Media Players > Emergencies.
- Choose Schedules > Emergencies.

Step 2

Click Stop Emergency.

Step 3

Expand the Select DMP Group tree, click the DMP group that is colored red, and then click Stop. If you choose a DMP group that has child groups, the child groups and their member DMPs are also selected automatically.

Step 4

To confirm your selections, which will stop playback of your emergency message and restore normal scheduling for the DMP group (and children) that you chose, click OK. Alternatively, to discard your selections without stopping the emergency, click Cancel.

A message tells you whether you stopped the emergency successfully. After you dismiss the message, the page is refreshed. If you stopped the emergency, the DMP group that you chose in Step 3 is no longer colored red in the Select DMP Group tree.

If you selected a DMP group whose member DMPs were not showing emergency messages, these DMPs will stop and then restart their playback of whatever asset they are scheduled to show.

If separate emergencies were in effect simultaneously across multiple DMP groups and you stopped the emergency for only one group, remember that the event-scheduling features at Schedule > Play in Future still are suspended for all groups where emergencies remain in effect.
Scheduling Time Slots for Media and Events on DMPs

Tip

Network congestion or other performance problems at a DMP deployment site might cause the assets that you deploy to pause, stop, or play at unacceptably low speeds. To work around this problem, troubleshoot network performance at the deployment site and consider upgrading its network or applying policies to shape and prioritize its traffic.

In DMM-DSM, you can schedule events to start manually (“Play Now”) or run automatically (“Play in Future”). Topics in this section tell you how to deliver to your DMPs and servers the assets and commands that you saved in DMM-DSM, as well as the TV channels and VoDs that you saved in DMM-ETV.

- Deploying Elements Immediately, page 3-73
- Working with Future Deployments, page 3-74
- Preempting a Recurring Event for a One-time Event, page 3-81
- Using Deployment Reports, page 3-81

Note

To learn how to configure DMM-DSM support for ACNS, see Configuring DMM-DSM to Use ACNS, page 3-87.

Deploying Elements Immediately

An element in DMM is any command, event, presentation, playlist, TV channel, electronic program guide, VoD, or anything else that you can schedule for deployment to DMPs. You can deploy elements immediately to one DMP or to multiple DMPs that all use the same one DMP group as their parent.

Note

- In this release, we do not support immediate deployments to external (FTP) servers.
- We recommend that you avoid using immediate deployments with ACNS, due to the amount of time required to distribute assets throughout your network and to its edge. If you do so despite this recommendation, DMM-DSM always uses the default ACNS channel. You cannot select any other channel.

Before You Begin

- You must already have created and saved the elements that you will deploy. See Working with Assets and Categories in Your Media Library, page 3-27. See also Using Advanced Tasks, page 3-56.
- You must already have created the DMP group whose member DMPs should receive the deployment. See Managing and Grouping Your DMPs, page 3-6.

Step 1

Choose Schedules > Play Now.

Step 2

From the Event Type list, choose Digital Signage, Enterprise TV, or System Tasks, depending on which of these is the deployment type.

The option that you choose from the Event Type list causes a button to be shown. Its name is derived from your choice.
Step 3  
To choose specifically the element that should be deployed to your DMPs, click this button. 
A dialog box opens, from which you can select the specific element to be deployed. The name and 
elements of this dialog box will vary, depending on which option you chose from the Event Type list.

Step 4  
Click the name of the specific instruction or media to be deployed, and then do one of the following: 
• To confirm your selection and close the dialog box, click **OK**. 
• To discard your selection and close the dialog box, click **Cancel**.

Step 5  
In the **DMP Groups** object selector, click the name of a DMP group to see a list of its member DMPs.

Step 6  
In the list of DMPs, Ctrl-click the name of each DMP that should receive the deployment.

Step 7  
Do one of the following: 
• To confirm your selections and deploy the element immediately, click **Submit**. 
• To discard your work for this deployment, click **Cancel**.

---

### Working with Future Deployments

You can schedule future time slots for elements that you will deploy once or repeatedly to: 
• One registered DMP, if it belongs to a DMP group which does not contain any other DMPs. 
• Multiple registered DMPs that all use the same one DMP group as their parent. 
• All of your registered external (FTP) deployment servers; the schedule treats all of your registered 
  external servers identically.

You can schedule a deployment to occur at any time and recur any number of times (within reason), and 
you can schedule any number of deployments. The schedule can manage multiple deployments 
simultaneously and—assuming that a DMP has a fast network connection and you send deployments to 
it that are not mutually exclusive—a DMP can receive multiple deployments simultaneously.

---

**Note**  
Avoid placing entries in your schedule that recur often and persist for an unreasonably long time. 
Otherwise, your manifest files might not be generated quickly enough to meet your expectations. We 
recommend that you apply this rough algorithm: 
• An entry that recurs daily should persist in your schedule for no more than 3 days. 
• An entry that recurs weekly should persist in your schedule for no more than 3 weeks. 
• An entry that recurs monthly should persist in your schedule for no more than 3 months. 
• An entry that recurs annually should persist in your schedule for no more than 3 years.

---

**Tip**  
You can view two types of summary for any scheduled deployment. See: 
• **Understanding Tooltips in the Schedule Timeline, page 3-78** 
• **Viewing Status Messages Inline for Deployed Events in the Schedule Timeline, page 3-79**
Chapter 3      Managing Digital Signage and Enterprise TV

Scheduling Time Slots for Media and Events on DMPs

This section contains these topics:

- Understanding Future Deployments for Presentations, page 3-75
- Understanding Time Zones in the Schedule, page 3-76
- Scheduling the Time Slot for a Future Event, page 3-76

Understanding Future Deployments for Presentations

You can deploy only one presentation at a time if the assets that it uses should be stored directly on your DMPs. To check the free space on the SD memory card in a DMP, log in to its local instance of DMPDM, then click Internal Storage. If you want a particular presentation to play during stage-one failover on a DMP, the combined file size of all its assets must not be any more than:

- 0.9 GB (900 MB) on a DMP 4300G.
- 1.9 GB on a DMP 4305G.
- 3.8 GB on a DMP 4400G.

Caution

Do not delete the scheduled deployment job for a presentation to stop it from playing on your DMPs. If you delete the deployment job, your DMPs will continue to use the presentation as if you did nothing. This happens because each deployment job includes an instruction to stop, but you delete that instruction when you delete the deployment job that contains it. To stop your DMPs from using a presentation in this case, create and deploy an advanced task to stop all applications. See the “System Tasks” row in Table 3-19 on page 3-57.

Note

It is important that you understand all of the possible limitations and effects of deploying to an FTP server, as well as the exact circumstances that lead to these effects. Files are sometimes unplayable or deleted automatically; subdirectories are sometimes created automatically; and values that you enter in DMM-DSM are sometimes changed automatically.

- Video files do not play at all if you deploy a presentation to an FTP server when the presentation uses MPEG files that are:
  - Served from Microsoft Internet Information Server (IIS). On Windows, we support only Apache.
  - Requested through Microsoft Proxy Server.
  - Requested through Microsoft Internet Security and Acceleration Server.
- When your media library in DMM-DSM is the source for a file that you deploy as part of a presentation, and when you select an FTP server as the target to receive that file, DMM-DSM transfers copies of the relevant file to all of the FTP servers that you have registered. After the transfer is completed, DMM-DSM deletes the original file from its media library, then changes the relevant presentation so that it uses a URL instead of a local path. The URL that DMM-DSM enters automatically is specific to whichever FTP server you registered first.
- When an HTTP URL is the source for a deployed file, and when the pathname on the source server contains subdirectories that do not exist on the target FTP server, DMM-DSM automatically creates the required subdirectories on the FTP server.
Understanding Time Zones in the Schedule

Future time slots that the schedule describes will always designate hours in boldface numerals according to the UTC time zone offset for the locale where your DMM appliance is installed. If you are working from any other time zone when you view the schedule, this offset will differ from the offset for your locale and the difference might be confusing. Furthermore, the offset might be confusing even if you and your DMM appliance are together in one time zone but you want to schedule time slots for a DMP that is in some other time zone.

In either scenario, you can cause the schedule to designate hours from two time zones simultaneously. One of these time zones is always the one for your DMM appliance. To choose the second time zone (whether it is for your locale or the locale of a DMP), select a named UTC offset option, such as “America/Los Angeles,” from the untitled list above the schedule.

The schedule is updated immediately to show designated hours from the second time zone that you selected, in addition to the designated hours that it always shows for your DMM appliance:

- Small, plain numerals designate hours for the UTC-offset locale that you selected.
- Large, boldface numerals designate hours for the locale where your DMM appliance is installed.

Scheduling the Time Slot for a Future Event

Tip

Displayed times for deployments in the schedule are relative to the time zone where you deployed your DMM appliance, not the time zone where you deployed any DMP, and not the time zone for any other locale. You set the time zone value for your DMM appliance when you used AAI to configure it and you can use AAI to correct the time zone value if it is wrong.

- To learn how to set or reset the time zone, see the “Administering a DMM Appliance” chapter in Appliance Administration Guide for Cisco Digital Media System 5.0 on Cisco.com.
- To understand how the schedule represents time zones, see Understanding Time Zones in the Schedule, page 3-76.
- If the user interface for the schedule does not load correctly in your browser, see Release Notes for Cisco Digital Media System 5.0 on Cisco.com.

Before You Begin

- You must already have created and saved the elements that you will deploy. See Working with Assets and Categories in Your Media Library, page 3-27.
- You must already have created the DMP group that should receive a deployment. See Managing and Grouping Your DMPs, page 3-6.

Step 1 Choose Schedules > Play in Future.

Step 2 From the calendar, choose the year, month, and day when the deployment should start.

The timeline is updated automatically, so that it shows the schedule for that day.

Step 3 From the Event Type list, under the timeline, choose the deployment type.
Step 4  When the Schedule Task dialog box opens, complete these steps:

a. Click Select Group, click the group name for the DMPs or the external (FTP) deployment servers that should receive this deployment, and then click OK.

b. Click the Select <event_type> Tasks button, click the name of the specific event to be deployed, and then click OK.

c. To designate the start and stop times for this event:
   - In the Start Time area—For the deployment date that you chose in Step 2, enter the hour (numeric, in the range from 1 to 12) and minute (numeric, in the range from 00 to 59) when DMPs should start this event, then enter either AM or PM as the period.
   - In the Stop Time area—Use the same method to specify when DMPs should stop this event.

Step 5  From the Repeat list, choose the recurrence interval for this event. The intervals are:

- Never
- Every Day
- Every Week
- Every Month
- Every Year

Step 6  To save your selections, click Save All.

Note  If you do not click Save All, the schedule discards your selections immediately after you refresh your browser or load any other page.

You must click Save All even if you do not plan to deploy the event right away. Later, when you are ready to deploy the event, click Publish All.

Step 7  (Optional) To make copies of an event in the schedule, so that it recurs as many times as you want and at any interval that you specify:

a. Click the event description on the timeline, then choose Add an Event > Duplicate All.

b. Click the first Select button to choose the group whose event will be copied, and then click OK.

c. Click the second Select button to choose the group that should receive the copy, and then click OK.

d. Click Save.

Step 8  To transmit the deployment according to the schedule that you defined—and synchronize it if you use ACNS—click Publish All.
Understanding Tooltips in the Schedule Timeline

Whenever your pointer hovers over an event in the timeline, the schedule shows a tooltip. Information in the tooltip describes the current status of the corresponding event and summarizes its most important attributes. Information in the tooltip is organized as follows:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• <strong>New</strong> — You made selections to define a new deployment. However, because you have not yet clicked Save, the schedule will discard your selections if you refresh your browser or load any other page in it.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Saved</strong> — You made selections to define a new deployment and you clicked Save. You created a permanent record for the deployment, but have not scheduled it yet to run.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Published</strong> — You made selections to define a deployment, you saved your selections, and the deployment is scheduled to run at the times that you specified.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Scheduled</strong> — The deployment is occurring now.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Finished</strong> — The deployment occurred at the scheduled time and is now stopped.</td>
</tr>
<tr>
<td>App</td>
<td>The selection that you made from the Applications list.</td>
</tr>
<tr>
<td>Group</td>
<td>The selection that you made from the DMP Groups list.</td>
</tr>
<tr>
<td>From</td>
<td>The date and time when the deployment is (or was) scheduled to start.</td>
</tr>
<tr>
<td>To</td>
<td>The date and time when the deployment is (or was) scheduled to stop.</td>
</tr>
<tr>
<td>Repeat</td>
<td>The number of times that the deployment is scheduled to recur.</td>
</tr>
<tr>
<td>Start Cmd Result (Total/OK/Failed)</td>
<td>N/N/N, where:</td>
</tr>
<tr>
<td></td>
<td>• The first N is a color-coded (black) numeral that counts the total number of times that DMM-DSM tried to deploy the command to start the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The second N is a color-coded (green) numeral that counts the number of times that DMM-DSM succeeded in deploying the command to start the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The third N is a color-coded (red) numeral that counts the number of times that DMM-DSM failed to deploy the command to start the designated task.</td>
</tr>
<tr>
<td>Stop Cmd Result (Total/OK/Failed)</td>
<td>N/N/N, where:</td>
</tr>
<tr>
<td></td>
<td>• The first N is a color-coded (black) numeral that counts the total number of times that DMM-DSM tried to deploy the command to stop the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The second N is a color-coded (green) numeral that counts the number of times that DMM-DSM succeeded in deploying the command to stop the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The third N is a color-coded (red) numeral that counts the number of times that DMM-DSM failed to deploy the command to stop the designated task.</td>
</tr>
</tbody>
</table>
Viewing Status Messages Inline for Deployed Events in the Schedule Timeline

Whenever you let your pointer hover over a scheduled deployment in the timeline, DMM-DSM describes the current status of the corresponding deployment and summarizes its most important attributes. Information in the popup is organized as follows:

Table 3-21  Elements to Describe the Current Status of Scheduled Events

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>The selection that you made from the Applications list.</td>
</tr>
<tr>
<td>Application Type</td>
<td>Either Digital Media Designer (see Working with Presentations, Templates, and Presentation Playlists for Digital Signage, page 3-33) or one of the following (see Using Advanced Tasks, page 3-56):</td>
</tr>
<tr>
<td></td>
<td>• (Go to) URL</td>
</tr>
<tr>
<td></td>
<td>• DMP Audio/Video Settings</td>
</tr>
<tr>
<td></td>
<td>• DMP Discovery (autoregistration)</td>
</tr>
<tr>
<td></td>
<td>• DMP Display Controls</td>
</tr>
<tr>
<td></td>
<td>• DMP Failover Retry</td>
</tr>
<tr>
<td></td>
<td>• DMP Firmware Upgrade</td>
</tr>
<tr>
<td></td>
<td>• DMP Startup URL</td>
</tr>
<tr>
<td></td>
<td>• File Transfer to DMP or Server</td>
</tr>
<tr>
<td></td>
<td>• System Tasks</td>
</tr>
<tr>
<td>From</td>
<td>The date and time when the deployment is (or was) scheduled to start.</td>
</tr>
<tr>
<td>To</td>
<td>The date and time when the deployment is (or was) scheduled to stop.</td>
</tr>
<tr>
<td>How Often</td>
<td>The number of times that the deployment is scheduled to recur.</td>
</tr>
<tr>
<td>Status</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• New — You made selections to define a new deployment. However, because you have not yet clicked Save, DMM-DSM will discard your selections if you refresh your browser or load any other page in it.</td>
</tr>
<tr>
<td></td>
<td>• Saved — You made selections to define a new deployment and you clicked Save. DMM-DSM created a permanent record for the deployment, but has not scheduled it yet to run.</td>
</tr>
<tr>
<td></td>
<td>• Published — You made selections to define a deployment, you saved your selections, and DMM-DSM has scheduled the deployment to run at the times that you specified.</td>
</tr>
<tr>
<td></td>
<td>• Scheduled — The deployment is occurring now.</td>
</tr>
<tr>
<td></td>
<td>• Finished — The deployment occurred at the scheduled time and is now stopped.</td>
</tr>
<tr>
<td>Group</td>
<td>The selection that you made from the DMP Groups list.</td>
</tr>
</tbody>
</table>
Table 3-21  Elements to Describe the Current Status of Scheduled Events (continued)

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Command Summary (Total/OK/Failed)</td>
<td>( N/N/N ), where:</td>
</tr>
<tr>
<td></td>
<td>• The first ( N ) is a color-coded (white) numeral that counts the total number of times that DMM-DSM tried to deploy the command to start the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The second ( N ) is a color-coded (green) numeral that counts the number of times that DMM-DSM succeeded in deploying the command to start the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The third ( N ) is a color-coded (red) numeral that counts the number of times that DMM-DSM failed to deploy the command to start the designated task.</td>
</tr>
<tr>
<td>Stop Command Summary (Total/OK/Failed)</td>
<td>( N/N/N ), where:</td>
</tr>
<tr>
<td></td>
<td>• The first ( N ) is a color-coded (white) numeral that counts the total number of times that DMM-DSM tried to deploy the command to stop the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The second ( N ) is a color-coded (green) numeral that counts the number of times that DMM-DSM succeeded in deploying the command to stop the designated task.</td>
</tr>
<tr>
<td></td>
<td>• The third ( N ) is a color-coded (red) numeral that counts the number of times that DMM-DSM failed to deploy the command to stop the designated task.</td>
</tr>
</tbody>
</table>

In addition, a status bar at the bottom of the popup window counts the number of errors associated with the described deployment.
Preempting a Recurring Event for a One-time Event

In some cases, you might want to show a presentation one time, or for a limited time, that overlaps with a recurring deployment.

For example, you might schedule a presentation to run from 9:00 a.m. to 6:00 p.m. every weekday in the month of March, but want to show a different presentation on the second Tuesday in March. The problem in this scenario is that your DMP cannot prioritize contradictory events that are scheduled to start simultaneously. However, there are three possible methods that you might use to schedule a preemption. In this scenario, you can do any of the following:

| Method 1 | 1. Schedule and deploy a recurring event for the first uninterrupted span of dates.  
|          | 2. Schedule and deploy the one-time event.  
|          | 3. Schedule and deploy a copy of the first recurring event for the second uninterrupted span of dates.  |

| Method 2 | Create two DMP groups. In this scenario, we will call them Group_A and Group_B.  
|          | • For Group_A, schedule an event that recurs throughout the entire span of dates.  
|          | • For Group_B, schedule the one-time event.  
|          | Then complete these steps:  
|          | 1. When the one-time event should begin, move your DMPs from Group_A to Group_B.  
|          | 2. When the one-time event should end, move your DMPs back to Group_A, then select **Schedules > Play Now**.  
|          | 3. In the **DMP Groups** object selector, click the **Group_A** name to see its member DMPs in the untitled table.  
|          | 4. In the untitled table, Ctrl-click each DMP that should start again to show the recurring presentation.  
|          | 5. Choose **Select an Event Type > Digital Signage** and then click **Select Digital Signage**.  
|          | 6. Click the presentation name and then click **OK**.  |

| Method 3 | 1. Schedule the recurring event to run every weekday, as you would expect, from 9:00 a.m. to 6:00 p.m.  
|          | 2. Use one-time scheduling to start an advanced task (such as the Go to URL task, if the event is a live video stream) at 9:05 a.m., so that it interrupts the recurring event instead of conflicting with its start time, and then schedule this one-time event to stop at 6:00 p.m.  
|          | In this method, the one-time event cannot be a presentation; it must be an advanced task. The recurring task will begin again, as expected, the next day.  |

Using Deployment Reports

You can view, configure, and export “proof-of-play” reports for the presentations and tasks that you have deployed in your digital signage network.

| Step 1  | Choose **Schedules > Reports**.  |
|         | Step 2  | Check the check boxes for the relevant DMP groups.  |
|         | Step 3  | Enter date range values in the From field and the To field.  |
Using Administrative Options

This section contains these topics:
- Configuring User Rights and Permissions for Digital Signage and Enterprise TV, page 3-82
- Limiting User Permissions, page 3-84
- Configuring DMM-DSM Server Settings, page 3-87
- Configuring DMM-DSM to Use ACNS, page 3-87
- Configuring DMM-DSM to Deploy to External Servers, page 3-88
- Testing for the Presence of, and Obtaining, the Required Java Version, page 3-89

Configuring User Rights and Permissions for Digital Signage and Enterprise TV

In DMM-DSM, you can manage access rights and permission levels for administrators and members of the Digital Signage user group that is managed at a higher level in DMS-Admin. The rights and permissions that you manage in DMM-DSM are ones that pertain to digital signage and enterprise TV.

Tip
To understand the high-level concepts and workflow for managing user accounts, access rights, and permission levels, see Understanding User Management Concepts and Workflow, page 2-5.

Before You Begin
To see and use the Settings tab, you must be logged in as an administrator.

Step 1  Choose Settings > User Accounts, then choose the options that meet your requirements. If you do not understand your options, see Table 3-22 on page 3-83.

Step 2  Click Submit.
Table 3-22  Elements for Configuring DMM-DSM User Accounts

<table>
<thead>
<tr>
<th>Element</th>
<th>Icon and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users List</td>
<td>Select an account whose digital signage or enterprise TV access rights and permission levels you will edit. When you click a username, DMM-DSM automatically shows the Change User pane for the corresponding user account.</td>
</tr>
<tr>
<td>Change User</td>
<td>A worksheet where you edit attributes of the selected user account.</td>
</tr>
<tr>
<td>— Name</td>
<td>A unique username. The name is unique in the sense that you have not used it as the name for any other user account that you created in DMM-DSM. You must enter the username.</td>
</tr>
<tr>
<td>— Description</td>
<td>Optional, brief description of the user account and its purpose.</td>
</tr>
<tr>
<td>— Password</td>
<td>The password for the user account. You must enter a password, then reenter it.</td>
</tr>
<tr>
<td>— Administrator</td>
<td>The check box to select if this account belongs to an administrator. Otherwise, deselect the check box. When a user account belongs to an administrator, the corresponding user is granted full permissions to create, read, write, and delete every object type without limitation. If you deselect the check box, you must manually change the permissions for each user role and each object type that pertain to this user account. Because we recommend that you follow a best practice in which you create only a few users, the check box is selected by default each time that you add a user account.</td>
</tr>
<tr>
<td>— Role</td>
<td>The list of user role types. Each type of role is associated with some of the features in DMM-DSM. Select a role to see or change the corresponding permissions for the user whose account you are adding or editing. After you select a role, you can set the permissions to create, read, write, and delete objects that are relevant to whichever role you selected. Depending on the user role that you select, an object might be a registered DMP, a registered FTP server, a category in your digital media library, an application that you configured, or the target device (DMP or FTP server) to receive a scheduled deployment.</td>
</tr>
<tr>
<td>— DMP Manager</td>
<td>A user with permissions to manage every DMP in your digital signage network, only the DMPs within particular DMP groups that you specify, or no DMPs whatsoever.</td>
</tr>
<tr>
<td>— Content Manager</td>
<td>A user with permissions to manage every category in your media library, only the particular categories that you specify, or none of the categories.</td>
</tr>
<tr>
<td>— Application Manager</td>
<td>A user with permissions to work with every application type, only the particular application types that you specify, or none of the applications of any kind.</td>
</tr>
<tr>
<td>— Publisher Manager</td>
<td>A user with permissions to schedule media deployments to all of your registered DMPs and external (FTP) deployment servers, only the particular DMPs and FTP servers that you specify, or none of the registered DMPs or FTP servers.</td>
</tr>
<tr>
<td>— All</td>
<td>Contains the check box that you select to assign global permissions to the user, so that he or she can always {create</td>
</tr>
<tr>
<td>— Selected</td>
<td>Contains the check box that you select to assign limited permissions to the user, so that he or she can {create</td>
</tr>
</tbody>
</table>

The untitled table sorts user account permissions information into these rows:

- Objects: Contains the Create, Read, Write, and Delete buttons. To see or edit any one of these types of permissions as it applies to the specified user, you must first click the corresponding button. If you deselect both the All check box and the Selected check box in the column under a button, DMM-DSM automatically shows the words “No permissions” in red, to signify that the user does not have any permissions of that type in relation to the objects that are relevant to the role that you selected from the Role list.
- All: Contains the check box that you select to assign global permissions to the user, so that he or she can always {create | see | edit | delete} objects that pertain to whichever user role you selected from the Role list. Click the relevant button, then select the corresponding check box in the All row.
- Selected: Contains the check box that you select to assign limited permissions to the user, so that he or she can {create | see | edit | delete} only a subset of the objects that pertain to the user role that you selected from the Role list. Click the relevant button, select the corresponding check box in the Selected row, then select the subset where the user permissions should apply. (Depending on the object type, you might choose the subset by clicking its name in an object selector or clicking its name in a table; DMM-DSM automatically shows either an object selector or a table from which to select the subset.)
Limiting User Permissions

You can restrict the permissions that you grant to particular user accounts in DMM-DSM. For example, you might grant a user the permission to use only the advanced tasks that you choose or to deploy presentations to only the DMPs that you choose.

The list of “applications” that this section describes includes two applications (called “Enterprise TV” and “Enterprise TV VoD”) in addition to the full list of advanced tasks. Each Enterprise TV user must have at least read-only permission to the “Enterprise TV” application, which pertains to the electronic program guide.

Tip
To understand the high-level concepts and workflow for managing user accounts, access rights, and permission levels, see Understanding User Management Concepts and Workflow, page 2-5.

Before You Begin
To see and use the Settings tab, you must be logged in an administrator.

Step 1 Choose Settings > User Accounts.
Step 2 In the Users list, click a username to highlight it. DMM-DSM automatically shows the Change User pane for the corresponding user account, where you can edit the permissions that apply to the user.
Step 3 Make selections to limit any or all of the permissions that you will grant to the user.

If you do not understand your options, see Table 3-22 on page 3-83 or consider the examples in these scenarios:

- Scenario 1: User Who Can Work with Assets for Signage or Enterprise TV but Cannot Schedule Time Slots, page 3-84
- Scenario 2: User Who Can Administer One DMP Group but Cannot Manage Assets, page 3-85
- Scenario 3: User Who Can Administer One DMP Group, Manage Assets, and Schedule Time Slots, page 3-86
- Scenario 4: User Who Can Schedule Time Slots for One DMP Group But Has No Other Rights, page 3-86

By limiting permissions in specific ways, similar to the ways that these examples demonstrate, you can assign highly specialized combinations of access to any DMM-DSM user. The examples in these scenarios describe some of the commonest types of limited permissions that you might want to assign and tell you how to assign them.

Step 4 After you have selected the options to meet your requirements, click Submit.

Scenario 1: User Who Can Work with Assets for Signage or Enterprise TV but Cannot Schedule Time Slots

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select DMP Manager, select the All check box in the Read column, then deselect every check box in the Create, Write, and Delete columns.
2. From the Role list, select Content Manager, then select the All check box in the Create, Read, Write, and Delete columns.
3. From the Role list, select **Application Manager**, then select the **Selected** check box in the Create, Read, Write, and Delete columns. Next, do all of the following:
   - Click **Create**, then—in the table that associates permissions with applications—select only these check boxes: **Digital Media Designer, Enterprise TV, Enterprise TV VoD**, and **Go to URL**.
   - Click **Read**, then—in the table that associates permissions with applications—select only these check boxes: **Digital Media Designer, Enterprise TV, Enterprise TV VoD**, and **Go to URL**.
   - Click **Write**, then—in the table that associates permissions with applications—select only these check boxes: **Digital Media Designer, Enterprise TV, Enterprise TV VoD**, and **Go to URL**.
   - Click **Delete**, then—in the table that associates permissions with applications—select only these check boxes: **Digital Media Designer, Enterprise TV, Enterprise TV VoD**, and **Go to URL**.

4. From the Role list, select **Publisher Manager**, select the **All** check box in the Read column, then deselect every check box in the Create, Read, Write, and Delete columns.

5. Click **Submit**.

**Scenario 2: User Who Can Administer One DMP Group but Cannot Manage Assets**

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select **DMP Manager**, then select the **Selected** check box in the Create, Read, Write, and Delete columns. Next, do all of the following:
   - Click **Create**. Then, in the object selector, click a DMP group to highlight it.
   - Click **Read**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.
   - Click **Write**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.
   - Click **Delete**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.

2. From the Role list, select **Content Manager**, then deselect every check box in the Create, Read, Write, and Delete columns.

3. From the Role list, select **Application Manager**, then—in the table that associates permissions with applications—select only these check boxes: **DMP Discovery, DMP Video/Audio Settings, System Tasks, DMP Firmware Upgrade**.

4. From the Role list, select **Publisher Manager**, then select the **Selected** check box in the Create, Read, Write, and Delete columns. Next, do all of the following:
   - Click **Create**. Then, in the object selector, click and highlight the same DMP group that you highlighted for the DMP Manager role.
   - Click **Read**. Then, in the object selector, click and highlight the same DMP group that you highlighted for the DMP Manager role.
   - Click **Write**. Then, in the object selector, click and highlight the same DMP group that you highlighted for the DMP Manager role.
   - Click **Delete**. Then, in the object selector, click and highlight the same DMP group that you highlighted for the DMP Manager role.
5. Click Submit.

**Scenario 3: User Who Can Administer One DMP Group, Manage Assets, and Schedule Time Slots**

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select **DMP Manager**, then select the **Selected** check box in the Create, Read, Write, and Delete columns. Next, do all of the following:
   - Click **Create**. Then, in the object selector, click a DMP group to highlight it.
   - Click **Read**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.
   - Click **Write**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.
   - Click **Delete**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.

2. From the Role list, select **Content Manager**, then select the **All** check box in the Create, Read, Write, and Delete columns.

3. From the Role list, select **Application Manager**, then — in the table that associates permissions with applications — select every check box.

4. From the Role list, select **Publisher Manager**, then select the **Selected** check box in the Create, Read, Write, and Delete columns. Next, do all of the following:
   - Click **Create**. Then, in the object selector, click a DMP group to highlight it.
   - Click **Read**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.

5. Click Submit.

**Scenario 4: User Who Can Schedule Time Slots for One DMP Group But Has No Other Rights**

To restrict user permissions as they should be restricted in this scenario, you would do the following.

1. From the Role list, select **DMP Manager**, select the **All** check box in the Read column, then deselect every check box in the Create, Write, and Delete columns.

2. From the Role list, select **Content Manager**, then deselect every check box in the Create, Read, Write, and Delete columns.

3. From the Role list, select **Application Manager**, select the **All** check box in the Read column, then deselect every check box in the Create, Write, and Delete columns.

4. From the Role list, select **Publisher Manager**, then select the **Selected** check box in the Create, Read, Write, and Delete columns. Next, do all of the following:
   - Click **Create**. Then, in the object selector, click a DMP group to highlight it.
   - Click **Read**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.
• Click **Write**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.

• Click **Delete**. Then, in the object selector, click and highlight the same DMP group that you highlighted for Create permissions.

5. Click **Submit**.

**Configuring DMM-DSM Server Settings**

You must configure DMM-DSM to use the correct Java servlet server and to use one, consistent username and password for administrative access to all of the DMPs that you will manage centrally.

**Before You Begin**

To see and use the Settings tab, you must be logged in an administrator.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose <strong>Settings &gt; Server Settings</strong>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the Servlet Server Address field, enter the routable IP address or resolvable DNS hostname for your DMM appliance. It will not be updated automatically if you use AAI to change the IP address of your DMM appliance.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the DMP User Name field, enter the one administrative username that you have configured all of your DMPs to share.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the DMP User Password field, enter the one administrative password that you have configured all of your DMPs to share.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>

**Configuring DMM-DSM to Use ACNS**

You can configure DMM-DSM to use ACNS.

⚠️ **Caution**

Never delete an ACNS channel that Cisco DMS uses. If you do, you will not be able to see, select, edit, or delete in your schedule any events that use the deleted channel. Failover (content substitution) occurs on your DMPs when scheduled events call upon missing assets. Before you delete any ACNS channel, be sure that you have deleted from your schedule all events that will be disrupted otherwise.

**Before You Begin**

To see and use the Settings tab, you must be logged in an administrator.

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Choose <strong>Settings &gt; ACNS</strong>, then select the options that meet your requirements. If you do not understand your options, see Table 3-23 on page 3-88.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click <strong>Save</strong>.</td>
</tr>
</tbody>
</table>
You can configure DMM-DSM to deploy to external servers, but only within these operating parameters:

- The only supported server type is FTP in this release.
- You cannot use the Schedules > Play Now feature with external deployment servers.
- All deployments to your external deployment servers require that you use the Schedules > Play in Future feature.

**Before You Begin**

To see and use the Settings tab, you must be logged in as an administrator.

**Step 1** Choose **Settings > External Deployment Locations**, then select the options that meet your requirements. If you do not understand your options, see Table 3-24 on page 3-88.

**Step 2** Click **Save**.
Using Administrative Options

Tip

To understand all of the prerequisites to use DMS and its components, including DMM-DSM, see Release Notes for Cisco Digital Media System 5.0 on Cisco.com.

Step 1

Choose Help > Downloads, and then click Check Java Plugin.

A popup window opens. If the correct Java version is installed, a message tells you so. Otherwise, DMM-DSM directs you to download the required version.

### Testing for the Presence of, and Obtaining, the Required Java Version

You can test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. If the required version is not installed, DMM-DSM tells you where you can download it.

Your task is to test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. If the required version is not installed, DMM-DSM tells you where you can download it. You can test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. If the required version is not installed, DMM-DSM tells you where you can download it.

Your task is to test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. If the required version is not installed, DMM-DSM tells you where you can download it. You can test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. If the required version is not installed, DMM-DSM tells you where you can download it. You can test for the presence on your PC of the Java Runtime Engine version that DMM-DSM requires. If the required version is not installed, DMM-DSM tells you where you can download it.
Common Scenarios for Using DMM-DSM

This section describes common scenarios for using DMM-DSM.

- Uploading Files to a DMP for Local Storage and Immediate Deployment, page 3-90

Uploading Files to a DMP for Local Storage and Immediate Deployment

You can create a presentation that shows video files from a playlist, then transfer the presentation and its assets to the local Secure Digital (SD) flash memory card in a DMP for playback on its attached DMP display.

Note

- The total amount of available file space for local storage is:
  - 0.9 GB (900 MB) on a DMP 4300G.
  - 1.9 GB on a DMP 4305G.
  - 3.8 GB on a DMP 4400G.

Consider these SD memory card capacities carefully when you make designs for use during stage-one failover. The combined file size for all assets in such designs cannot exceed the storage capacity of the SD card. To check the free space on the SD memory card in a DMP, log in to its local instance of DMPDM, then click Internal Storage. To understand failover, see the “Understanding Content Substitution (Failover)” topic in User Guide for Cisco Digital Media Player Device Manager 5.0 on Cisco.com.

- A presentation cannot play any file with a file size greater than 1.9 GB on a DMP, regardless of its model type. This size is constrained by the limits of streaming.

Before You Begin

To learn how to create a playlist in Digital Media Designer, so that you can show the playlist as part of a presentation, see Creating and Organizing Presentation Playlists, page 3-49.

Step 1

To create an advanced task that will transfer the assets for your playlist anywhere in your digital signage network, select Digital Media Players > Advanced Tasks > File Transfer to DMP or Server, then do the following:

a. Click Add New Application, then enter a name for the new file transfer task in the Name field; for example, you might enter the name LocalPublishing.

   You must enter a name. The name is unique in the sense that you have not used it previously as the name for anything that can be scheduled.

b. In the Applications list, click Digital Media Designer.

c. In the Available Content table, click a row to highlight the presentation, then click Select Applications. Doing this moves the highlighted presentation to the Selected Content table, so that its assets become available for deployment.

d. To save your work, click Submit.
Step 2  To deploy the file transfer task to a DMP or DMP group, select Schedules > Play Now, then do the following:

a. From the DMP Groups object selector, select the DMP or DMP group that should receive the deployment.

b. From the Actions list, select the name of the advanced task that you configured and saved for this file transfer operation, then click Go.

DMM-DSM deploys the assets and commands immediately to the DMPs that you selected, and the targeted DMPs restart automatically.

Note

- After they restart, your DMPs will not show the newly received presentation automatically on their attached DMP displays. The presentation will not play unless stage-one failover occurs or until you deploy the Go to URL task that DMM-DSM generated automatically when you deployed assets to the SD memory card.

- After you create and deploy any “File Transfer to DMP or Server” task to save the assets from a DMD presentation to the SD memory card inside a DMP, DMM-DSM automatically creates a Go to URL task. The name by default for the Go to URL task is “failover - <name_of_presentation>.” If any of your DMPs should show the presentation at any time other than during stage-one failover, you must deploy the corresponding Go to URL task to those DMPs. See Scheduling Time Slots for Media and Events on DMPs, page 3-73.

- After you delete a presentation for which DMM-DSM automatically generated a corresponding Go to URL task, you must also delete that Go to URL task.
Managing Desktop Video

Tip
Features in Digital Media Manager-Video Portal Module (DMM-VPM) are available to you if you purchased and installed the required license. For information about licensing, see the “Managing Licenses for Features and Components of Cisco DMS” section on page 2-3.

This chapter includes the following sections:
- Using Features Under the Setup Tab, page 4-1
- Using Features Under the Users Tab, page 4-7
- Using Features Under the Video Portal Tab, page 4-8
- Using Features Under the Encoders Tab, page 4-42
- Workflows for Setting Up Live Events, page 4-48

Using Features Under the Setup Tab

Tip
For information about setting up DMM-VPM on a new DMM appliance, see the Quick Start Guide for Cisco Digital Media System 5.0 on Cisco.com.

Administrators and configuration managers use options under the Setup tab to manage the configuration and deployment settings for DMM-VPM on a DMM appliance. For information about user accounts and permissions, see the “Using Features Under the Users Tab” section on page 4-7.

This section includes the following topics:
- Configuring Administrative and Network Settings, page 4-2
- Viewing Environment Parameters, page 4-3
- Configuring the Settings to Use a Video Portal, page 4-3
- Configuring the Location Settings for Deployments, page 4-5
Configuring Administrative and Network Settings

You can configure low-level administrative and network settings for DMM-VPM.

**Step 1** Select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2** Select **Setup > DMM**.

**Step 3** Enter the values that meet your requirements, as described in Table 4-1 on page 4-2.

**Step 4** To save and commit your entries, click **Save Configuration Parameters**.

or

To discard your entries, click **Cancel**.

---

Administrative and Network Settings

Table 4-1 describes the elements and settings for configuring administrative and network settings for DMM-VPM.

**Table 4-1  Elements for Configuring Global Variables**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Administrator</td>
<td>The e-mail address that receives help requests from users. This field is read only in DMM-VPM, and it contains the e-mail that is specified for the superuser account in DMS-Admin.</td>
</tr>
<tr>
<td>Contact Email</td>
<td>The e-mail address that receives a copy of every deployment and notification message that DMM sends to any user.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip</strong> Use an e-mail alias to send notifications to multiple recipients.</td>
</tr>
<tr>
<td>Deployment CC Email Recipient</td>
<td>The e-mail address that receives requests to retrieve and restore lost passwords from Video Portal users.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you use embedded authentication, we recommend that you enter an e-mail address to provide a password management option for users who have only Video Portal User level access. For information about Video Portal user accounts, see the “Using Features Under the Users Tab” section on page 4-7.</td>
</tr>
<tr>
<td>Metadata Checkout Duration</td>
<td>The duration (in minutes) that a user can lock metadata for editing.</td>
</tr>
<tr>
<td>Scheduled Deployment Interval</td>
<td>The interval (in minutes) between automated cycles when DMM checks whether there are any scheduled deployments that it should process. This setting pertains only to scheduled deployments; immediate deployments start immediately.</td>
</tr>
<tr>
<td>(minutes)</td>
<td></td>
</tr>
<tr>
<td>Default Content Provider</td>
<td>The content provider name to assign, by default, to any new program upon its creation. For example, you might enter the name of your organization.</td>
</tr>
<tr>
<td>E-mail Server</td>
<td>The DNS-resolvable hostname or routable IP address of the SMTP server through which DMM sends deployment and approval e-mail messages automatically.</td>
</tr>
<tr>
<td>Application Server Base</td>
<td>The lowest-level HTTP URL (including the TCP port number) that points to your DMM appliance. For example: <a href="http://dmm.yourdomain.com:8080">http://dmm.yourdomain.com:8080</a>. To confirm that the URL is reachable, click <strong>Check</strong>.</td>
</tr>
</tbody>
</table>
Viewing Environment Parameters

When you select Setup > DMM, the bottom of the page shows environment parameters for the DMM appliance. Table 4-2 describes the parameters.

### Table 4-2 Environment Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DMM version</td>
<td>Shows the release number for the DMM-VPM version that is installed on your DMM appliance.</td>
</tr>
<tr>
<td>Java</td>
<td>Shows the release number for the Java version that installed on your client system.</td>
</tr>
<tr>
<td>Database</td>
<td>Shows the release number for the MySQL version that is installed on your DMM appliance.</td>
</tr>
<tr>
<td>Tomcat uptime</td>
<td>Shows the total number of days, hours, and minutes since the most recent time that you restarted your DMM appliance.</td>
</tr>
</tbody>
</table>

Configuring the Settings to Use a Video Portal

You can configure settings to use DMM-VPM with a Video Portal appliance.

**Step 1** Select Video Portal from the untitled list at the top far-right of any page.

**Step 2** Select Setup > Video Portal.

**Step 3** Enter the values that meet your requirements, as described in Table 4-3 on page 4-4.

**Step 4** To save and commit your entries, click Save Portal Parameters.

or
To discard your entries, click **Cancel**.

### DMM-VPM Use Settings

*Table 4-2* describes the elements and settings for configuring DMM-VPM to use a Video Portal appliance.

#### Table 4-3  Elements for Configuring DMM-VPM to Use a Video Portal

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Portal Login Prompt</td>
<td>The text that users see when they log in to the Video Portal; there is a 25-character limit.</td>
</tr>
</tbody>
</table>
| Video Portal FQDN               | Exactly the same DNS-resolvable hostname\(^1\) for your Video Portal appliance that you defined on your:  
  - DNS server.  
  - Video Portal appliance, in its version of AAI.                                                                                             |
| Video Portal Instance           | **Caution** You must not use Cisco as the instance name. We reserve and use the Cisco name for other purposes. All of your deployments will fail if you use Cisco as the instance name.  
  Exactly the same instance name that you defined for your Video Portal appliance in its version of AAI.                                        |
| Video Portal Password           | The password that is currently in effect for the administrative account in AAI on your Video Portal appliance. Any time that you change that password on your Video Portal appliance, you must also enter exactly the same updated password value here. |
| Video Portal Web Server Base    | The top-level HTTP URL of the server on which your audience can find your Video Portal. To confirm that the URL is reachable, click **Check**.                                                                 |
| The URL to the live video portal | The HTTP URL that points directly to your public Video Portal. If you click **Check**, you see one of these messages:  
  - “URL is blank.” — You have not entered any URL.  
  - “Server was not found.” — You entered an invalid URL.  
  - “URL exists.” — The URL that you entered points correctly to a Video Portal.                                                                   |
| Default Audio Only Image        | The SWF or non-progressive JPEG image to show as the thumbnail for every audio file. You must specify a file that is 100 pixels wide and 75 pixels high (or uses any proportional multiple of those dimensions, such as 400 x 300). The file must be in the same directory that you specified as the *Upload Path on Local File System* when you completed the “Configuring Administrative and Network Settings” section on page 4-2.  
  **Note** This option applies to you only if — when you or an administrator used AAI to set up your Video Portal appliance — you selected FLV as the only supported file type and Flash/Sorenson as the only supported format for encoding. For more information, see Task 10 in the “Setting Up and Configuring a Video Portal Appliance” chapter in *Appliance Administration Guide for Cisco Digital Media System 5.0* on Cisco.com. |
| Default Preview Image           | The SWF or non-progressive JPEG image to show as a placeholder thumbnail image when no other preview image is available for a video file. You must specify a file that is 100 pixels wide and 75 pixels high or use any proportional multiple of those dimensions. |
Chapter 4  Managing Desktop Video

Using Features Under the Setup Tab

### Configuring the Location Settings for Deployments

You can configure the location settings for video deployments. You must deploy files to at least one remote location because you cannot present them to audiences directly from your DMM appliance.

**Caution**

You must enter a deployment location for each file type that you use. You can enter a unique location for each of the different file types, or you can use one location that applies equally to every file type. Any invalid entries will cause deployments to fail.

1. **Step 1**
   Select **Video Portal** from the untitled list at the top far-right of any page.

2. **Step 2**
   Select **Setup > Deployment Locations**.

3. **Step 3**
   Enter the values that meet your requirements, as described in Table 4-4 on page 4-6. Valid file types are the following:
   - **Flash Video** — Flash (FLV) files to deploy as the Flash Video version of a video offering or to show as a video preview.
   - **Windows Media Video** — Windows Media (WMV) files to deploy as the Windows Media version of a video offering.
   - **MPEG4/H.264** — MPEG-4 (MP4, M4V, MP4V, M4A, or MOV) files to deploy as the Quicktime version of a video offering.
   - **Support** — Any non-video binary files to deploy as supporting images, such as SWF files or non-progressive JPEG files. Any related items that content managers add to a video part for download are deployed to this support location. Also, related files that will be downloaded are deployed and stored in this support location.

4. **Step 4**
   To save and commit your entries, click **Save Deployment Locations**
   or
   To discard your entries, click **Cancel**.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported Media Formats</td>
<td>The formats to support. Select any combination of Flash Video, Windows Media, and MPEG4/H.264 (QuickTime).</td>
</tr>
<tr>
<td>Media Preferences by Browser</td>
<td>The order in which the Video Portal and embedded video players attempt to play a video.</td>
</tr>
<tr>
<td>Video Portal URL with Plugin Detector</td>
<td>The HTTP URL that activates the plugin detector on your Video Portal so that it automatically selects the format to use when it shows media to Video Portal audience members.</td>
</tr>
<tr>
<td>Video Portal URLs by Individual Supported Media Formats</td>
<td>The HTTP URL that bypasses the plugin detector on your Video Portal so that it show only one media type to your Video Portal audience members whether or not they have the required plugin to see that media type. Ensure that users have installed the correct plugin on their systems; otherwise, they may experience technical difficulty when accessing a video by using this URL.</td>
</tr>
</tbody>
</table>

1. Do not use underscores or any other special characters in hostnames. DNS standards do not support these characters. Use only letters, numerals, and hyphens.

---

**Table 4-3 Elements for Configuring DMM-VPM to Use a Video Portal (continued)**
Step 5  (Optional) To run a deployment now, complete the following steps:

a. Select Video Portal > Deployments and click Schedule New Deployment.

b. Select the Video Part 1 check box in the Video Part Selection area.

c. To deploy the pre-loaded content and metadata immediately, select the Schedule Immediately check box in the Deployment Time area.

d. Click Create Deployment.

e. To ensure that the content and metadata deployed appropriately, use another computer on your network to access the Video Portal that you installed.

Deployment Location Settings

Table 4-4 describes the settings and elements for configuring deployment locations.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection type</td>
<td>The protocol or method for file transfer (the options are FTP, SFTP, and SCP). No matter which protocol you use, the connection timeout is 10 seconds on this page and 30 seconds during an actual deployment.</td>
</tr>
<tr>
<td>Host address</td>
<td>The DNS-resolvable hostname or routable IP address of the remote server where you will deploy files of the relevant filetype.</td>
</tr>
<tr>
<td>Login name</td>
<td>A user account name that has the required privileges to access the remote server.</td>
</tr>
<tr>
<td>Login password</td>
<td>The assigned password for the login name that you specified. If you select the SFTP option for deployments to your Video Portal appliance, the password that you enter must be exactly the same as your Video Portal admin password.</td>
</tr>
</tbody>
</table>
| Root file directory      | The absolute directory path to files that you will deploy. If you click Check, you see one of the following messages:  
  • “Field is blank” — You have not entered any path.  
  • “File Path Does Not Exist” — You entered an invalid path.  
  • “File Path exists” — The path that you entered points correctly to a valid file. |
| Root URL Path            | The absolute URL, where the Video Portal will host and reference your files. If you click Check, you see one of the following messages:  
  • “URL is blank” — You have not entered any URL.  
  • “Server was not found” — You entered an invalid URL.  
  • “URL exists” — The URL that you entered points correctly to a valid file. |
Using Features Under the Users Tab

Two types of user authentication that you configure in DMS-Admin: *Embedded authentication* is completely native to DMM while *LDAP authentication* causes DMS to rely on a Microsoft Active Directory server. Alternatively, you can choose no authentication; however, this option disables the requirement that Video Portal and Video Portal Reports user accounts must use authentication. For more information, see the “Managing User Accounts and Authentication Settings” section on page 2-4.

Administrators use the features under the Users tab in DMM-VPM to assign differing levels of access and permissions to users of DMM-VPM, Video Portal Reports, and Video Portal, depending on their roles and responsibilities.

This section includes the following topics:
- Working with User Accounts, page 4-7
- Viewing Your Profile, page 4-8

Working with User Accounts

User accounts are centrally managed in DMS-Admin but assigned roles in DMM-VPM. If you are an Administrator in DMM-VPM, you can assign differing levels of access and permissions for other DMM-VPM users; however, not even an administrator can change his or her own access privileges. Only another administrator can change your access privileges if you are an administrator.

Note

Users must exist in DMS-Admin before you can assign levels of access. For more information, see the “Managing User Accounts and Authentication Settings” section on page 2-4.

Step 1 Select Video Portal from the untitled list at the top far-right of any page.
Step 2 Select Users > User Accounts.
All active users in DMS-Admin display.
Step 3 Click Edit next to the user to which you want to assign permissions, as described in Table 4-5 on page 4-7.

User Account Settings

Table 4-5 describes the elements for DMM-VPM and Video Portal users.

<table>
<thead>
<tr>
<th>Table 4-5</th>
<th>Elements for User Accounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>First Name</td>
<td>The given name of the user for this account. DMM-VPM greets the user by this name when the user logs in. DMM-VPM also includes this name when it sends approval requests and e-mail notifications.</td>
</tr>
<tr>
<td>Last Name</td>
<td>The surname of the user. DMM-VPM includes this name when it sends approval requests and e-mail notifications.</td>
</tr>
<tr>
<td>Company</td>
<td>The company for the user.</td>
</tr>
</tbody>
</table>
### Viewing Your Profile

Profile information in DMM-VPM is not editable. You can edit this information only in DMS-Admin if you have Administrator or Configuration Manager permissions.

**Step 1** Select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2** Select **Users > My Profile**.

The My Profile page displays information that you see when you work with user accounts, as described in Table 4-5 on page 4-7. Depending on your access level, you may not see the Module Access Type area.

### Using Features Under the Video Portal Tab

Administrators and authors use the options under the Video Portal tab to create, modify or disable programs, videos, video parts and lineups.

This section contains these topics:

- Working with Programs, Videos and Video Parts, page 4-9
- Approving or Denying the Request to Approve a Video Part or Playlist, page 4-18
- Understanding the Live Event Module, page 4-18
- Understanding and Working with Synchronized Slides, page 4-18
Working with Programs, Videos and Video Parts

You can create programs and populate them with videos and video parts and then deliver the programs to your audiences live or on demand.

Remember the following information when you work with programs, videos, and video parts:

Requirements for Content Objects

- Programs, videos, and video parts are all content objects. You can create, edit, disable, and delete content objects at any time, according to your requirements.
- Although a program can contain multiple videos, you cannot add any video to more than one program.
- Each program that you create must contain at least one video before you can show it to any audience.
- Each video that you create must contain at least one video part before you can show it to any audience.

Approvals for Video Parts

You can configure DMM-VPM to track approvals for video parts. Content authors can request approval for video parts; then, a designated approver can approve or deny the requests. A designated approver is someone whose DMM-VPM user type is Approver. Not even a designated approver can approve his or her own requests. Approval and denial have no effect on whether a video part can be deployed. Therefore, the approval process workflow does not help you to enforce any security policy; instead, it helps your organization to formalize communication. For information about user accounts and permissions, see the “Using Features Under the Users Tab” section on page 4-7.

Western European Font Support

The Video Portal can display Western European language fonts that are included in the ISO 8859-1 standard when content authors use supported language versions of their browsers, operating systems, and keyboards to enter information about videos in DMM-VPM. The information that content authors provide displays to Video Portal viewers in the language in which it was entered regardless of the language settings of their browsers. Video Portal navigational elements display in English, and Video Portal users cannot search for videos that include non-English characters in titles and descriptions.
### Closed Captioning

Closed captioning enables you to display closed captioning text that is embedded in a Windows Media stream to Video Portal viewers.

- **Closed captioning for VoDs**—This option requires that you manually or use software tools to transcribe the audio track; synchronize the transcription with the video; and create a special SAMI file before you publish the VoD and deploy it to the Video Portal.

- **Closed captioning for DME live events**—This option requires that you edit the encoder profile on the DME to enable encoding of closed caption text before the event; see the documentation that came with your encoder for more information. Then, during the event, you need a stenographer-type system to provide the text and a closed caption multiplexer to insert the text into the analog video signal.

When you provide closed captioning, Video Portal viewers see a closed captioning icon that they can click to display text. For more information, see the *User Guide for Cisco Video Portal 5.0*.

To work with programs, videos, and video parts, complete the following procedure:

**Step 1** Select **Video Portal** from the untitled list at the top far-right of any page, and then select **Video Portal > Programs**.

On the Programs page, you can toggle between two tables that are mostly very similar and that both show a list of DMM-VPM programs. You can move programs from one table to the other.

**Step 2** Do one of the following:

- Click **Active** to see in the Active table a list of all the programs that are available to show to your audience. These programs are active in the sense that you have not disabled them. If you have not created any programs or if you archived every program, the table is empty.

- Click **Archive** to see in the Archive table a list of all the programs that you have disabled temporarily. These programs are disabled in the sense that they are not available for your audience to find or see and you cannot add them to playlists. You might choose eventually to restore or delete these programs.

**Step 3** Enter the values that meet your requirements, as described in Table 4-6 on page 4-10.

**Step 4** Click **Save**.

### Content Object Settings

Table 4-6 describes the elements and settings that you use to configure the following content objects: programs, videos, and video parts.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New {Program</td>
<td>Video</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves the content objects that you selected from the Active table to the Archive table.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If you archive a program, the videos and video parts within it remain active. You can deploy them in a playlist, and your audiences can use a keyword search to find them on your Video Portal.</td>
</tr>
</tbody>
</table>
Caution
If you delete a program, the actual effect of the deletion differs if the program is part of a playlist or is not. If you delete a program that is part of an active and deployed playlist, your audiences can still find, see, and use the program, its videos, and its video parts on your Video Portal. However, if you have not included the program in any playlist, DMM-VPM immediately deletes the program, its videos, and its video parts. They are not available for any purpose in DMM-VPM or on your Video Portal, and you cannot undo the deletion. However, VOD files are available through direct portal links until you delete the files from their content storage locations.

Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the disabled or archived content objects that you selected.

Activate Selected
Moves the content objects that you selected from the Archive table to the Active table.

Select a Program Provider to Filter On
Lists the program providers. Select a provider name to filter the list of programs and display only the programs the are associated with that provider.
Table 4-6  Elements for Configuring Content Objects (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Untitled check box</strong></td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• Marks a content object that you will disable, if selected, in the Active table.</td>
</tr>
<tr>
<td></td>
<td>• Marks a content object that you disabled and that you will restore or delete, if selected, in the Archive table.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Shows the name or title for the content object that the corresponding row describes, shows the Modify ( ) button, and sometimes shows the Preview ( ) button. Values in the name column are the basis by default for how DMM-VM sorts the rows, but you can click the heading in any other column to re-sort the rows by the values in that column. If you click the Modify button, DMM-VM loads a page where you can edit content object metadata, such as the title and description for a program.</td>
</tr>
<tr>
<td><strong>Provider</strong></td>
<td>— Programs only. Shows the provider who produced the program that one row describes, as specified in the program metadata.</td>
</tr>
<tr>
<td><strong>Last Modified</strong></td>
<td>Shows the date on which the content object was last edited.</td>
</tr>
<tr>
<td><strong>Active Videos</strong></td>
<td>— Programs only. Shows the Active Videos ( ) button and the Add New Video ( ) button. If you click the Active Videos button, DMM-VM loads a page where you can add videos to the program that the corresponding row describes or mark videos to remove from that program. If you click Add New Video, DMM-VM loads the page where you can enter metadata for a new video.</td>
</tr>
<tr>
<td><strong>Active Categories</strong></td>
<td>— Programs only. Shows the Active Categories page for the program that the corresponding row describes. From the Active Categories page, you can select and add categories to associate with the program, or you can select and delete category associations from the program.</td>
</tr>
<tr>
<td><strong>Active Video Parts</strong></td>
<td>— Videos only. Shows the Active Video Parts ( ) button and the Add New Video Part ( ) button. If you click the Active Video Parts button, DMM-VM loads a page where you can add video parts to the video that the corresponding row describes or mark video parts to remove from the video.</td>
</tr>
<tr>
<td><strong>Release Date</strong></td>
<td>— Video Parts only. Shows the release date.</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>— Video Parts only. Shows the playback duration of the video part in days, hours, minutes and seconds.</td>
</tr>
<tr>
<td><strong>Active Related Items</strong></td>
<td>— Video Parts only. Shows the Active Related Items page for the video part that the corresponding row describes. If you click the Active Related Items button, DMM-VM loads a page where you can add items, such as links to web sites or files, to the video part that the corresponding row describes or mark related items to remove from the video part.</td>
</tr>
<tr>
<td><strong>Approval Status</strong></td>
<td>— Video Parts only. To request an approval for the video part that the corresponding row describes, click Request Approval, select an approver from the list in the popup window, and then click Request Approval and Close. For information about approvals, see the “Approvals for Video Parts” section on page 4-9.</td>
</tr>
</tbody>
</table>
Table 4-6  Elements for Configuring Content Objects (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Add New Program</td>
<td>Modify Program}</td>
</tr>
<tr>
<td><strong>Program Name</strong></td>
<td>The title for the program that your audiences see on the Video Portal when they click the Program Guide tab. Only the first 25 characters that you enter will be visible on the Video Portal.</td>
</tr>
<tr>
<td><strong>Program Description</strong></td>
<td>The description that your audiences see on the Program Guide tab, next to the corresponding program name. In addition, this description is visible in the Video Portal “More Info” text for any video that this program contains.</td>
</tr>
<tr>
<td><strong>Program Status</strong></td>
<td>If you select Active, the program is visible to your audiences after you populate, save, and deploy it. If you select Archive, the program is not visible to your audiences.</td>
</tr>
<tr>
<td><strong>Program Provider</strong></td>
<td>The name of your company, organization, or department. You use this information to manage and administer content; your audiences do not see it. The default provider name is whichever one you chose under the Setup tab.</td>
</tr>
<tr>
<td><strong>Program Categories</strong></td>
<td>Your audiences can use the program guide or search feature on your Video Portal to find this program in the categories that you select. You can add or remove category associations at any time. To understand categories, see the “Creating and Working with Content Categories” section on page 4-26.</td>
</tr>
<tr>
<td>{Add New Video</td>
<td>Modify Video}</td>
</tr>
<tr>
<td><strong>Video Title</strong></td>
<td>The title for this video, which your audiences see on your Video Portal when they use its playlist, program guide, or search features. Only the first 33 characters are used.</td>
</tr>
<tr>
<td><strong>Video Status</strong></td>
<td>If you select Active, you can add the video to a program that you create. If you select Inactive, you cannot add the video to any program unless you reactivate it.</td>
</tr>
<tr>
<td><strong>Video Description</strong></td>
<td>A description for your reference. Your audiences do not see it.</td>
</tr>
<tr>
<td>{Add New Video Part</td>
<td>Modify Video Part}</td>
</tr>
<tr>
<td><strong>Show Direct Portal Link</strong></td>
<td>Shows the Video Portal URL for this video part.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>When you archive or delete a video part, the direct portal link is removed from the Video Portal listing but continues to access the VOD file from the original deployment location. We recommend that you remove the file from its content storage location to make it inaccessible.</td>
</tr>
<tr>
<td><strong>Video Part Description</strong></td>
<td>The description that your audiences see on your Video Portal in its preview pane and in the “More Info” text under its Overview tab. Do not enter more than 72 lines of text or more than 48 characters per line. This element is visible only when you are adding or editing a video part.</td>
</tr>
</tbody>
</table>
### Table 4-6 Elements for Configuring Content Objects (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type of Video</strong></td>
<td>If VoD, the source is a file; if DME Live Event or Non-DME Live Event, the source is an encoder.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>The Non-DME Live Event option enables you to publish a live stream URL to the Video Portal and control event visibility, but you cannot control the encoder. The VoD option is available for non-DME live events, but you cannot control event visibility on the Video Portal by using this option.</td>
</tr>
<tr>
<td>Video (video or audio)</td>
<td>Shows a filename that you enter or that DMM-VPM enters automatically after you click the link to upload a new VoD file.</td>
</tr>
<tr>
<td><strong>Restrictions</strong></td>
<td>The maximum supported file size for uploads is 2GB. If you enter the filename manually for a VoD, special requirements apply to each supported file type.</td>
</tr>
<tr>
<td>DMM-VPM saves uploaded VoD files to the deployment location that you specified under the Setup tab. The file formats that you see are exactly the ones that you selected to support when you set up your Video Portal. You must enter or upload one file apiece for each format that your Video Portal supports. We recommend that you encode all files to be 400 pixels wide and 300 pixels high.</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Closed captioning requires Windows Media. For more information, see the “Closed Captioning” section on page 4-10.</td>
</tr>
</tbody>
</table>

If you selected the DME Live Event option as the video type, you see the following additional options:

- **Encoder** — Lists all of the encoders that you have configured DMM-VPM to use. Select the encoder that is the source of the live stream.
- **Use Default Streaming Settings** — Use the DMM-VPM settings exactly as they are.
- **Advanced Settings** — Configure this stream to use settings that differ from the default. Select the encoding or transcoding format, publishing method (push or pull), audio input method, video input method, audio input method, video input standard, whether to save a copy of the live stream as a file for later viewing as a VoD — and possibly also the DME 2000 input channel to use, if your encoder is a DME 2000.

If you selected the Non-DME Live Event option as the video type, you see the following additional options:

- **Event Status** — Shows Pending, Live, or Stopped, corresponding to whether Video Portal access to the event is turned on or off.
- **{Start | Stop | Re-Start} Live Event** — Enables you to turn on and turn off Video Portal access to the event.

**Play Order in Video** — Shows when the video will play this video part, relative to the playback sequence of all the video parts in the video.
Using Features Under the Video Portal Tab

Table 4-6  Elements for Configuring Content Objects (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| {Release | End of Life} Date/Time | — Click to pick the date, select options for the hour and minute, and then select AM or PM. The release date is by default today.  
- DME Live Event and Non-DME Live Event: If you are setting up a live event, you must explicitly enter the End of Life Date/Time value. DMM-VPM does not obtain it automatically from the Release Date/Time value. If you do not enter an End of Life Date/Time value, the event will not be visible in the Encoder table; you will not be able to start the event; and the event will not be visible on the Video Portal.  
To modify the release date for a DME Live Event, see the “Modifying the Scheduled Times for DME Live Events” section on page 4-51.  
- VoD: The EoL/Date field is a placeholder to denote in DMM-VPM when content should be archived.  
**Tip** Use the Archive function for the video part page in the DMM-VPM to specify that you want to remove video from the Video Portal. Then, create a new deployment to remove it. |
| Duration | — Describes the playback duration of the video part in hours, minutes and seconds. Use the format HH:MM:SS. If you enter only seconds, DMM-VPM corrects your entry.  
- DME Live Event and Non-DME Live Event: You can use the scheduled length of a live event as the duration of its corresponding stream. The duration that you enter does not stop your Video Portal from delivering the whole stream if the actual event runs past its scheduled time to stop; the stream continues to play in your Video Portal until you stop it or it is no longer available.  
- VoD: You must manually enter the duration for Windows Media and QuickTime video files, but this information is provided automatically for Flash video files. |
**Table 4-6 Elements for Configuring Content Objects (continued)**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access restrictions</td>
<td>Enables content-level viewing security, so the Video Portal displays only the content that users can view.</td>
</tr>
<tr>
<td>Note</td>
<td>Authentication must be enabled in DMS-Admin to enforce access restrictions.</td>
</tr>
<tr>
<td></td>
<td>• None (Viewable to all user groups)—Specifies that all Video Portal users can see information about the video part and watch it.</td>
</tr>
<tr>
<td></td>
<td>• Viewable only to select groups—Specifies that only user groups with permissions can see information about the video part and watch it. Click <strong>Choose Group</strong> to display the groups that the administrator created or to create or edit a group. For more information, see the “Managing User Accounts and Authentication Settings” section on page 2-4.</td>
</tr>
<tr>
<td>Preview Content File URL</td>
<td>The location of a SWF file or nonprogressive JPEG file (100 pixels wide and 75 pixels high, or any proportionate multiple of those dimensions) that your Video Portal should show as the preview image for this video part. To select and upload a local file, click <strong>Upload new preview video file</strong>. If you use a SWF file, we recommended that you program it to pause after 10 seconds and not loop.</td>
</tr>
<tr>
<td>Enable Questions from the Audience</td>
<td>Click **{On</td>
</tr>
<tr>
<td>Slide Show</td>
<td>Select and upload the SWF file or ZIP archive of slides to show next to the video stream.</td>
</tr>
<tr>
<td>Preview Description</td>
<td>A text description that your Video Portal shows to your audiences but truncates after 160 characters. If you do not enter a preview description, your Video Portal shows the first 160 characters from the video part description instead.</td>
</tr>
<tr>
<td>Keywords</td>
<td>Descriptive words to make this video part searchable on your Video Portal.</td>
</tr>
<tr>
<td>Embedded Video</td>
<td>Provides the necessary HTML code to embed and display the live or on-demand video inside a custom website without the Video Portal interface. Embedded video requires an active Video Portal because the code checks the encoded video type and opens the correct supporting decoder software before displaying the video and basic playback controls to viewers. However, because viewers do not log in to the Video Portal, usage statistics for this video are not available in Video Portal Reports.</td>
</tr>
<tr>
<td>Note</td>
<td>Because the code provides direct access to the video, do not assign access restrictions in the Video Portal. We recommend that you manage access by implementing security measures on the website or through the application that publishes the code.</td>
</tr>
<tr>
<td>Tip</td>
<td>Video Portal users can also share videos by sending direct Video Portal URLs to other users, who can watch the videos if they have permissions to access. For information about URL sharing, see the <em>User Guide for Cisco Video Portal 5.0</em> on Cisco.com.</td>
</tr>
</tbody>
</table>
Using Features Under the Video Portal Tab

Links to web sites, video parts in other programs on your Video Portal, or files for your audience to download and use. Your audience sees the related items for a video part on your Video Portal if they click More Info during playback.

Click Add New Related Item, select the type of link, and enter the metadata. Alternatively, click the Edit button for a related item, and modify the metadata. To save your work, click Save.

Download—Provide files for users to download.

Note
For proper download, video files must be inside a ZIP archive.

Web Link in New Default Browser—Provide a URL that opens in a standard browser.

Web Link in New Custom Browser—Provide a URL that opens in a browser you customize in DMM-VPM.

Related Video—Provide a link to another video part.

1. We use the terms MPEG-4, QuickTime, and H.264 interchangeably in DMM-VPM. These formats coexist.
2. You cannot upload any video part that is larger than 2GB. To work around this limitation, post the file to a public webserver, and enter the corresponding HTTP URL instead of entering a filename.
3. You must use HTTP to point to any remote Flash file that you will upload. Flash files must use [FLV | FLA] for their filename extension. You cannot select Flash as the media format for a live event because Cisco Video Portal does not support Flash video streaming.
4. You must use [MMS | RTSP] to point to any remote Windows Media file that you will upload. Windows Media files must use [WMV | WMA | ASF] for their filename extension.
5. You must use [HTTP | RTSP] to point to any remote QuickTime (or H.264) file that you will upload. These files must use [MOV | MP4 | M4V | MP4V | M4A] for their filename extension.
6. When you point to a live stream, a filename is not necessary. In most cases, you point instead to a directory on the streaming server. If you are unsure about the configuration that your organization uses, ask your systems administrator for details. Streaming options are available for Windows Media, but not for Flash video.
7. Encoding format options are 1.5M, 350K, 50K, and 768K. Transcoding format options are 1.5M, 2M, 350K, 50K, and 768K.
8. See Managing Push Configurations, page 4-45.
9. One of these:
   • Composite/RCA
   • S-Video
10. One of these:
    • Unbalanced (RCA)
    • XLR Balanced
11. One of these:
    • NTSC_M (US)
    • NTSC_M_J (Japan)
    • PAL_B
    • PAL_D
    • PAL_H
    • PAL_I
    • SECAM_B
    • SECAM_D
    • SECAM_G
    • SECAM_H
    • SECAM_K
    • SECAM_K1
    • SECAM_L
    • SECAM_L1
12. Your Video Portal cannot display progressive JPEG images.
13. The ability to upload a slide presentation to a VoD is used for VoDs that were created from a live events. The ZIP archive that you upload must contain JPEG files that you exported from PowerPoint (or similar software), whose sequence of filenames is numbered correctly to preserve their natural order. See the “Generating and Importing the Slides to Be Synchronized” section on page 4-19.
14. There is no reason to enter commas, semicolons, or other word separators; your Video Portal ignores them if you do.

Table 4-6 Elements for Configuring Content Objects (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Add New Related Item</td>
<td>Modify Related Item}</td>
</tr>
<tr>
<td>Download</td>
<td>Provide files for users to download. Note For proper download, video files must be inside a ZIP archive.</td>
</tr>
<tr>
<td>Web Link in New Default Browser</td>
<td>Provide a URL that opens in a standard browser.</td>
</tr>
<tr>
<td>Web Link in New Custom Browser</td>
<td>Provide a URL that opens in a browser you customize in DMM-VPM.</td>
</tr>
<tr>
<td>Related Video</td>
<td>Provide a link to another video part.</td>
</tr>
</tbody>
</table>

1. We use the terms MPEG-4, QuickTime, and H.264 interchangeably in DMM-VPM. These formats coexist.
2. You cannot upload any video part that is larger than 2GB. To work around this limitation, post the file to a public webserver, and enter the corresponding HTTP URL instead of entering a filename.
3. You must use HTTP to point to any remote Flash file that you will upload. Flash files must use [FLV | FLA] for their filename extension. You cannot select Flash as the media format for a live event because Cisco Video Portal does not support Flash video streaming.
4. You must use [MMS | RTSP] to point to any remote Windows Media file that you will upload. Windows Media files must use [WMV | WMA | ASF] for their filename extension.
5. You must use [HTTP | RTSP] to point to any remote QuickTime (or H.264) file that you will upload. These files must use [MOV | MP4 | M4V | MP4V | M4A] for their filename extension.
6. When you point to a live stream, a filename is not necessary. In most cases, you point instead to a directory on the streaming server. If you are unsure about the configuration that your organization uses, ask your systems administrator for details. Streaming options are available for Windows Media, but not for Flash video.
7. Encoding format options are 1.5M, 350K, 50K, and 768K. Transcoding format options are 1.5M, 2M, 350K, 50K, and 768K.
8. See Managing Push Configurations, page 4-45.
9. One of these:
   • Composite/RCA
   • S-Video
10. One of these:
    • Unbalanced (RCA)
    • XLR Balanced
11. One of these:
    • NTSC_M (US)
    • NTSC_M_J (Japan)
    • PAL_B
    • PAL_D
    • PAL_H
    • PAL_I
    • SECAM_B
    • SECAM_D
    • SECAM_G
    • SECAM_H
    • SECAM_K
    • SECAM_K1
    • SECAM_L
    • SECAM_L1
12. Your Video Portal cannot display progressive JPEG images.
13. The ability to upload a slide presentation to a VoD is used for VoDs that were created from a live events. The ZIP archive that you upload must contain JPEG files that you exported from PowerPoint (or similar software), whose sequence of filenames is numbered correctly to preserve their natural order. See the “Generating and Importing the Slides to Be Synchronized” section on page 4-19.
14. There is no reason to enter commas, semicolons, or other word separators; your Video Portal ignores them if you do.
Approving or Denying the Request to Approve a Video Part or Playlist

After anyone submits a video part or playlist approval request, DMM-VPM sends e-mail to the designated approver. The e-mail message contains a link to preview and approve or deny the video part. For information about approvals, see the “Approvals for Video Parts” section on page 4-9.

If you receive the message, do the following:

---

Step 1  Click the e-mail link to preview the video part or playlist and, when your browser loads the Approval Request page, click **Preview Now**.

Step 2  Watch the video part, enter comments if you have any, and use the controls at the bottom of the window to approve or deny the request.

DMM-VPM is updated immediately and notifies the requestor through e-mail that you approved or denied the request.

Step 3  To return to DMM-VPM, click **Close and Return**.
---

Understanding the Live Event Module

The Live Event Module is a separately licensed add-on to DMM-VPM that helps you to do the following:

- Synchronize presentation slides with live audio and video streams that you show on your Video Portal. See the “Understanding and Working with Synchronized Slides” section on page 4-18.

- Receive and work with text-based questions that remote audience members submit to you while they are viewing live events on your Video Portal. See the “Understanding and Working with Audience Questions” section on page 4-21.

*Note*  Every time that you will host a live event, you must start the DME remotely from the DMM-VPM encoder dashboard. If you use any physical control on the DME chassis to start the encoder, your live events will not be available to your Video Portal audience members.

Understanding and Working with Synchronized Slides

If you have purchased a license to use the Live Event Module, the moderators at your live events can synchronize slides with their live event streams. The slide synchronization option requires that you use the Windows Media format and that you use either a DME 1000 or DME 2000 as the encoder. Windows Media and the DMEs use types of APIs that are not currently available with other encoding formats to support tight synchronization between slides and streams of audio and video.

*Directory Location for Slides*

For slides that are JPG files, unless a `/slides` subdirectory exists within the root directory that you specified in the Support area on the Deployment Locations page, deployments will fail for your synchronized slides. DMM-VPM creates the `/slides` subdirectory for you automatically if you use forward slashes (`/`) in the Root File Directory field but does not create the directory if you use back slashes (`\`).
slashes (\). If you used back slashes, you must log in to the server that you specified and create the required subdirectory manually. For information about the Deployment Locations page, see the “Configuring the Location Settings for Deployments” section on page 4-5.

For slides that are contained in a SWF file, slides are copied over to the Video Portal appliance in the /appliance_name/dms/video_portal/assets/ directory to avoid cross-domain access issues that could prevent the SWF slides from working. Also, this setup prevents the SWF file from being overwritten during an upgrade.

For more information, see the “Generating and Importing the Slides to Be Synchronized” section on page 4-19.

VoDs Files Created From Live Events

If you chose to create a VoD from a live event, you can publish the resultant VoD file after the event is finished. You cannot edit the VoD file with Cisco DMS 5.0 and maintain the slide synchronization commands that were created during the live event because the synchronization data is stored inline with the video data. Therefore, the data is lost if you use third-party tools that create and edit videos, such as Windows Movie Maker, to render and encode the file again.

Tip

To edit video duration, you can use a third-party tool that enables you to trim the length of a video clip and transfer the synchronization data to the header, such as Windows Media File Editor.

This section contains the following topics:

- Generating and Importing the Slides to Be Synchronized, page 4-19
- Operating a Slide Show, page 4-21
- What Video Portal Audiences See When You Use Synchronized Slides, page 4-21

Generating and Importing the Slides to Be Synchronized

In most cases, the synchronized slides that you show during live events will be derived from Microsoft PowerPoint presentations that your organization prepared for this purpose. Alternatively, your organization might use similar software from another vendor to develop its presentation slides.

- Best Practices for Creating and Importing Slides, page 4-19
- Creating and Importing a ZIP File for Synchronization, page 4-20
- Creating and Importing a SWF File for Synchronization, page 4-20

Best Practices for Creating and Importing Slides

Creating Slides

There are two ways to create your slides for use with the Live Event Module.

- You can export sequentially numbered JPEG files from a presentation and save those exported images inside a ZIP archive, which you import. One advantage to this method is that it does not require your organization to buy any additional software. However, the exported images might not provide a high-quality viewing experience for your audience members who opt to view the slides in their own resizeable window on the Video Portal. See the “Creating and Importing a ZIP File for Synchronization” section on page 4-20.
• You can use a third-party add-on that converts a presentation into a SWF file, which you can then import. The advantages to using this method are that it generates only a single file to be distributed and offers a potentially higher-quality viewing experience when viewers select the option to open the slides in a new window and re-size this window. See the “Creating and Importing a SWF File for Synchronization” section on page 4-20.

Importing Slides
If you will show synchronized slides during a live event, we recommend that you create the live event and upload the slides for it no later than 30 minutes before the live event should start. This best practice allows sufficient time in most cases for the slides to reach and be cached on all of the web servers and content delivery devices that your organization has configured in support of live streaming.

Creating and Importing a ZIP File for Synchronization
The following procedures assume that PowerPoint is your preferred software.

Step 1
After you finish preparing your PowerPoint slide deck, select File > Save As.

Step 2
From the Save as type list, select JPEG file Interchange Format (*.jpg).

Step 3
Using a method that your operating system provides for this purpose, create and name a new folder where the exported JPEG versions of your slides should be saved. The name that you enter should not contain any spaces.

Step 4
To start exporting your slides, click OK.

Step 5
When a prompt asks you, “Do you want to export every slide in the presentation or only the current slide?”, click Every Slide.

PowerPoint then extracts each slide and saves it as a separate JPEG file in the folder that you created and named. Each JPEG file receives an ascending number as its filename.

Step 6
After PowerPoint is finished saving all of the JPEG versions of your slides, compress the folder that contains them so that it is the basis for a new ZIP archive.

Creating and Importing a SWF File for Synchronization
After you finish preparing your PowerPoint slide deck, use a third-party application or a separately purchased PowerPoint plug-in to convert your slides into a single SWF file. Ensure that you remove all intra-slide and slide-to-slide transitions before you convert to a SWF file.
Operating a Slide Show

For most live events, a designated synchronization operator will use one of the two provided consoles to synchronize slides with the actions of the live presenter. When the presenter advances by one slide in a presentation, for example, the synchronization operator uses the synchronization console to do the same. There are two supported ways to synchronize slides.

- **Simple**—The first synchronization method uses a simple, full-screen interface that shows each slide. To change or synchronize a slide, the synchronization operator or presenter presses the right or left arrow keys on a keyboard to move forward or backward through a presentation one slide at a time. This method is ideal for small events or in-studio events where the presenter (not a separate synchronization operator) manages slides.

- **Advanced**—The second method uses a more advanced view that includes slide selection controls along its right side. By using this method, a synchronization operator or presenter can choose to selectively skip slides and move quickly forward or backward to any slide in the slide deck.

Each time that a slide is synchronized, the Live Event Module inserts a command into the stream:

- If you converted presentation slides into a sequence of numbered JPEG images that you uploaded inside a ZIP archive, the command in the stream instructs your Video Portal to fetch the relevant JPEG file and display it to audience members.

- If you converted presentation slides into a SWF file, the command in the stream instructs your Video Portal to find the relevant section in the SWF file and display it to audience members.

This process ensures that slides are tightly synchronized to streams.

Each time a slide synchronization takes place, the action is noted in the encoder console event window.

What Video Portal Audiences See When You Use Synchronized Slides

When you associate synchronized slides with a live event or a VoD, changes occur automatically in the user interface that Video Portal audience members see. By default, video is displayed on the left and synchronized slides are on the right. Audience members can choose to view slides inside a resizeable popup window, which is useful to them if information on a slide is not easily readable at the default size.

The popup view also provides audience members with an option to review past slides that were already presented. To select a past slide to view at full size, audience members click its thumbnail preview in a scrolling list on the right.

Understanding and Working with Audience Questions

If you have purchased a license to use the Live Event Module, your Video Portal audience members can submit text-based questions during the live events in which you have enabled this feature.

During a live event, audience members who click the Ask Question button on the Video Portal will open a new window where they can enter and submit questions for the presenters. All of the submitted questions appear first in the Question Manager console in DMM-VPM, which your live event moderators can monitor. At selected times during a live event, your moderators can submit prescreened questions to the presenters either in the Presenter console or verbally. The presenters are then able to answer questions from remote audience members during the live event. Submitted questions are not visible to audience members, and audience member names are not associated with their questions or displayed to live event moderators and presenters.
Because the live events that you show on your Video Portal can have thousands of audience members and it might be difficult for just one moderator to prescreen all of the submitted questions, multiple moderators can open and manage multiple instances of the Question Manager console simultaneously. After the event is finished, you can export all of the submitted questions and, if necessary, publish them on a separate server.

Moderators and presenters at live events use the Question Manager console in DMM-VPM to work with questions from Video Portal audience members.

This section contains the following topics:

- **Moderating Questions, page 4-22**
- **Answering Questions, page 4-24**

## Moderating Questions

If you are a moderator for a live event, you can prescreen questions for the presenters.

**Step 1**

Select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2**

Use your preferred method to open the moderation features:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>a. Select <strong>Encoders &gt; Encoder Dashboard.</strong></td>
<td>a. Select <strong>Video Portal &gt; Programs.</strong></td>
</tr>
<tr>
<td>b. In the list of encoders, find and click the icon ( ) for the encoder that your live event will use. DMM-VPM shows ad-hoc streaming controls for the encoder that you clicked.</td>
<td>b. Click the <strong>Active</strong> tab.</td>
</tr>
<tr>
<td>c. Click <strong>View Audience Questions.</strong></td>
<td>c. On the Active Programs page, click the <strong>Active Videos</strong> ( ) button that corresponds to the relevant program.</td>
</tr>
<tr>
<td></td>
<td>d. On the Active Videos page, click the <strong>Active Video Parts</strong> ( ) button that corresponds to the relevant video.</td>
</tr>
<tr>
<td></td>
<td>e. On the Active Video Parts page, click the <strong>Modify</strong> ( ) button that corresponds to the relevant live event stream.</td>
</tr>
<tr>
<td></td>
<td>f. For more information, see the “Working with Programs, Videos and Video Parts” section on page 4-9.</td>
</tr>
<tr>
<td></td>
<td>g. Scroll to the bottom of the displayed page, then click <strong>Review Audience Questions.</strong></td>
</tr>
</tbody>
</table>

**Step 3**

Enter the values that meet your requirements, as described in **Table 4-7 on page 4-23.**
## Settings for Moderating Live Events

Table 4-7 describes the settings for moderating live events.

### Table 4-7  Elements for Moderating Live Events

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Questions tab</td>
<td>Shows a scrolling list of the questions that audience members have submitted. The list is updated in real time whenever new questions arrive.</td>
</tr>
<tr>
<td></td>
<td>**[Show</td>
</tr>
<tr>
<td></td>
<td>• <strong>Show Questions</strong>—Click On to enable, or click Off to disable, filtering against a text string that you enter. While enabled, the filter constrains the list so that it includes only the questions that contain your text string.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Auto-remove Questions</strong>—Click On to enable, or click Off to disable, filtering against a text string that you enter. While enabled, the filter constrains the list so that it excludes all questions that contain your text string.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you enable both of the filters and enter the identical text string for both of them to use, the filters become mutually exclusive. In this case, all questions are moved under the Removed Questions tab. To restore them to the list of active questions, click Removed Questions, and then click Reactivate All.</td>
</tr>
<tr>
<td></td>
<td><strong>Export Questions</strong>—Creates a delimited text file that contains all the questions and other data, including timestamps, that are visible in the list of active questions. If you have configured your browser correctly to use helper applications, the file will open automatically in your preferred software for editing spreadsheets.</td>
</tr>
<tr>
<td></td>
<td><strong>Columns</strong>—Information about the questions is sorted into the following columns:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Question</strong>—The literal text of the question, exactly as it was submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Time Asked</strong>—The date, hour, minute, and second when the question was submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Actions</strong>—Buttons for moderating the corresponding question. You can highlight it, send it under the Presenter View tab, or move it under the Removed Questions tab.</td>
</tr>
<tr>
<td>Removed Questions tab</td>
<td>Shows a scrolling list of the questions that you have hidden, at least temporarily, from the presenter. The list is updated as you add questions to it manually and as your filters remove questions automatically from the list of active questions under the Questions tab.</td>
</tr>
<tr>
<td></td>
<td><strong>Reactivate All</strong>—Moves all questions back to the list of active questions under the Questions tab.</td>
</tr>
<tr>
<td></td>
<td><strong>Columns</strong>—Information about the questions is sorted into the following columns:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Question</strong>—The literal text of the question, exactly as it was submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Time Asked</strong>—The date, hour, minute, and second when the question was submitted.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Actions</strong>—Buttons for moderating the corresponding question. You can highlight it, send it under the Presenter View tab, or move it under the Removed Questions tab.</td>
</tr>
</tbody>
</table>
Answering Questions

If you are the presenter at a live event, you can see and answer the questions that your moderator has prescreened for you.

The moderator or another member of the stage crew at your live event might already have opened the Q&A Administration window for you where you can see the list of questions that await your answer. Otherwise, if no one did this for you already, complete Step 1 through Step 2c in the “Moderating Questions” procedure on page 4-22; then, click the Presenter’s View tab.

Under the Presenter’s View tab, you will see a list of the questions that the moderator has screened and edited for you to answer. The list is updated whenever your moderator adds a question to it manually. Information about the questions is sorted into the following columns:

- **Question** — The literal text of the question, exactly as it was submitted.
- **Time Asked** — The date, hour, minute, and second when the question was submitted.
- **Actions** — A button to move the corresponding question under the Removed Questions tab.

Creating and Working with Playlists

Each playlist must contain at least one video part before you can show it to any audience.

DMM-VPM can help you to emphasize particular content offerings by showing key videos on your Video Portal under its Featured Playlist tab.

You can also configure DMM-VPM to track approvals for playlists. The approval process workflow does not help you to enforce any security policy; instead, it helps your organization to formalize communication.

Content authors can request approval for playlists; then, a designated approver can approve or deny the requests. A designated approver is someone whose DMM-VPM user type is Approver. Not even a designated approver can approve his or her own requests. Approval and denial have no effect on whether a playlist can be deployed. For information about responding to requests for approval, see the “Approving or Denying the Request to Approve a Video Part or Playlist” section on page 4-18.

---

**Step 1** Select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2** Select **Video Portal > Playlists**.

On the Playlists page, you can toggle between two tables that are mostly very similar and that both show a list of DMM-VPM playlists. You can move playlists from one table to the other.

**Step 3** Do one of the following:

- Click **Active** to see in the Active table a list of all the playlists that are available to show to your audience. These playlists are active in the sense that you have not disabled them. If you have not created any playlists or if you archived every playlist, the table is empty.

- Click **Archive** to see in the Archive table a list of all the playlists that you have disabled temporarily. These playlists are disabled in the sense that they are not available for your audience to find or see. You might choose eventually to restore or delete these playlists.

**Step 4** Enter the values that meet your requirements, as described in Table 4-8 on page 4-25.
Step 5  Click Save.

Settings for Playlists

Table 4-8 describes the elements and settings for configuring playlists.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Playlist</td>
<td>Shows the Add New Playlist page.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the playlists that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived playlist that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the playlists that you selected.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Columns</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Untitled check box</td>
<td>One of the following:</td>
</tr>
<tr>
<td></td>
<td>• Marks a playlist that you will disable, if selected in the Active table.</td>
</tr>
<tr>
<td></td>
<td>• Marks a playlist that you disabled and that you will restore or delete, if selected in the Archive table.</td>
</tr>
<tr>
<td>Name</td>
<td>The title of the playlist that the corresponding row describes, the Edit ( ) button, and the Preview ( ) button. Values in the name column are the basis by default for how DMM-VPN sorts the rows, but you can click the heading in any other column to re-sort the rows by the values in that column. If you click the Edit button, DMM-VPN loads a page where you can edit metadata, such as the title and description, for the playlist that the corresponding row describes. If you click the Preview button, your Video Portal shows you the playlist that the corresponding row describes.</td>
</tr>
<tr>
<td>Publish Dates</td>
<td>The range of dates when which the playlist is valid between the release date and the end of life date.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>The date on which the content object was last edited.</td>
</tr>
<tr>
<td>Active Video Parts</td>
<td>Shows the Active Video Parts ( ) button and the Add New Video Part ( ) button. If you click the Active Video Parts button, DMM-VPN loads a page where you can add video parts to the playlist that the corresponding row describes or mark video parts to remove from the playlist.</td>
</tr>
<tr>
<td>Current Status</td>
<td>Describes the approval status and helps you to request playlist approval from a DMM-VPN user with approver permissions. To request approval for the playlist that the corresponding row describes, click Request Approval, select an approver from the list in the popup window, and then click Request Approval and Close.</td>
</tr>
<tr>
<td>Deployment Choice</td>
<td>Says whether the playlist that the corresponding row describes is the default playlist for deployments.</td>
</tr>
</tbody>
</table>
Creating and Working with Content Categories

You can categorize programs according to characteristics that they have in common, such as their topic, subject matter, target audience, featured executive, or business function. Your audiences use corresponding categories on your Video Portal to find or browse content. The videos and video parts in a program inherit their category associations automatically.

The program guide on your Video Portal describes only the programs that you have categorized. If you deploy a program but do not associate it with any categories, it is not visible in the program guide. In this case, your audiences must either perform a keyword search or use the absolute URL to find and see a video that the program contains. Therefore, to improve the user experience for your audiences, we recommend that you associate each program with at least one category.

To create and manage categories and to associate programs with them, use the Categories page.

Step 1
Select Video Portal from the untitled list at the top far-right of any page, then select Video Portal > Categories.

On the Categories page, you can toggle between two tables that are mostly very similar and that both show a list of DMM-VPM content categories. You can move categories from one table to the other.

Step 2
Do one of the following:
• Click **Active** to see in the Active table a list of all the categories that are available to associate with content objects and show to your audience. These categories are active in the sense that you have not disabled them. If you have not created any categories or if you archived every category, the table is empty.

• Click **Archive** to see in the Archive table a list of all the categories that you have disabled temporarily. These categories are disabled in the sense that they are not available for your audience to find or see and you cannot associate them with any content objects. You might choose eventually to restore or delete these categories.

**Step 3** Enter the values that meet your requirements, as described in *Table 4-9 on page 4-27.*

---

**Category Settings**

*Table 4-9* describes the elements and settings that you configure for categories.

*Table 4-9 Elements for Configuring Categories*

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Category</td>
<td>Shows the Add New Category page.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the categories that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived category that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the categories that you selected.</td>
</tr>
<tr>
<td><strong>columns</strong></td>
<td><em>(Untitled check box)— One of the following:</em> ______________________</td>
</tr>
<tr>
<td></td>
<td>• Marks a category that you will disable, if selected in the Active table.</td>
</tr>
<tr>
<td></td>
<td>• Marks a category that you disabled and that you will restore or delete, if selected in the Archive table.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the category that the corresponding row describes and the Modify ( ) button. Values in the Name column are the basis by default for how DMM-VPM sorts the rows, but you can click the heading in any other column to re-sort the rows by the values in that column. If you click the Edit button, DMM-VPM loads a page where you can edit metadata, such as the name and description, for the category that the corresponding row describes.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>The date and time when the category was last edited.</td>
</tr>
<tr>
<td>Date Added</td>
<td>The date and time when the category was created.</td>
</tr>
<tr>
<td># of Programs</td>
<td>Shows the Active Associated Programs ( ) button. If you click the button, DMM-VPM loads a page where you can associate programs with the category that the corresponding row describes or mark programs to disassociate from the category.</td>
</tr>
</tbody>
</table>
In DMM-VPM, an interstitial is a short segment that your Video Portal shows when you have not scheduled anything else to show. To create a new interstitial, follow these steps:

**Step 1** Select Video Portal from the untitled list at the top far-right of any page.

**Step 2** Select Video Portal > Interstitials.

On the Interstitials page, you can toggle between two tables that are mostly very similar and that both show a list of DMM-VPM interstitials. You can move interstitials from one table to the other.

**Step 3** Do one of the following:

- Click Active to see in the Active table a list of all the interstitials that are available. These interstitials are active in the sense that you have not disabled them. If you have not created any interstitials or if you archived every interstitial, the table is empty.

- Click Archive to see in the Archive table a list of all the interstitials that you have disabled temporarily. These interstitials are disabled in the sense that your audience will not see them. You might choose eventually to restore or delete these interstitials.

**Step 4** Enter the values that meet your requirements, as described in Table 4-10 on page 4-29.

**Step 5** Click Save.
### Interstitial Settings

Table 4-10 describes the elements and settings for configuring interstitials.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Category</td>
<td>Shows the Add New Interstitial page.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the interstitials that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived interstitial that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the interstitials that you selected.</td>
</tr>
</tbody>
</table>

#### Table 4-10  Elements for Configuring Interstitials

**Element**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Category</td>
<td>Shows the Add New Interstitial page.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the interstitials that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived interstitial that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the interstitials that you selected.</td>
</tr>
</tbody>
</table>

**columns**

- **Untitled check box** — One of the following:
  - Marks an interstitial that you will disable, if selected in the Active table.
  - Marks an interstitial that you disabled and that you will restore or delete, if selected in the Archive table.
- **Name** — The Modify ( ) button, the name of the interstitial that the corresponding row describes, and the name of the video part that the interstitial contains. The interstitial name in this column is the basis by default for how DMM-VPM sorts the rows, but you can click the heading in the Length column to re-sort the rows by duration. If you click the Edit button, DMM-VPM loads a page where you can edit metadata, such as the name and description, for the interstitial that the corresponding row describes.
- **Length** — The number of seconds that the video part will play until it stops.

#### Edit Interstitial

- **Add New Interstitial | Modify Interstitial**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name for this interstitial. Enter a maximum of 50 characters.</td>
</tr>
<tr>
<td>File URL</td>
<td>The full path and name of the file to use as an interstitial, after you a upload the file but before you deploy it. After you deploy the interstitial, this value is changed automatically to show the URL for deployment.</td>
</tr>
<tr>
<td>Upload new Interstitial graphical media file</td>
<td>Uploads a SWF or nonprogressive JPEG file that is 400 pixels wide and 120 pixels high. This file acts like a button; when your audiences click it, your Video Portal shows to them the click-through segment that you specify.</td>
</tr>
<tr>
<td>Click Through Segment</td>
<td>To select the video part that your Video Portal should show to someone who clicks the interstitial, click Select a Video Part.</td>
</tr>
<tr>
<td>Play Duration</td>
<td>The number of seconds that the video part should play until it stops.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description that is meaningful to you. The description is optional and is only for your reference.</td>
</tr>
<tr>
<td>Status</td>
<td>Active or Inactive. If you select Active, your audiences see the interstitial. If you select Inactive, the category is not visible to your audiences, and you cannot associate programs with it. The default is Active.</td>
</tr>
</tbody>
</table>
Creating and Working with Interstitial Sequences

In DMM-VPM, an interstitial sequence is an ordered list of interstitials that your Video Portal should play in order when you have not scheduled it to show anything else. To create a new interstitial sequence:

**Step 1** Select **Video Portal** from the untitled list at the top far-right of any page,

**Step 2** Select **Video Portal > Interstitial Sequences**.

On the Interstitial Sequences page, you can toggle between two tables that are mostly very similar and that both show a list of sequences. You can move sequences from one table to the other.

**Step 3** Do one of the following:

- Click **Active** to see in the Active table a list of all the sequences that are available. These sequences are active in the sense that you have not disabled them. If you have not created any sequences or if you archived every sequence, the table is empty.
- Click **Archive** to see in the Archive table a list of all the sequences that you have disabled temporarily. These sequences are disabled in the sense that your audience will not see them. You might choose eventually to restore or delete these sequences.

**Step 4** Enter the values that meet your requirements, as described in Table 4-11 on page 4-30

**Step 5** Click **Save**.

### Interstitial Sequence Settings

Table 4-11 describes the elements and settings for configuring interstitial sequences.

**Table 4-11 Elements for Configuring Interstitial Sequences**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Interstitial Sequence</td>
<td>Shows the Add New Interstitial Sequence page.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the sequences that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived sequence that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the sequences that you selected.</td>
</tr>
</tbody>
</table>
**Table 4-11 Elements for Configuring Interstitial Sequences (continued)**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| **columns** | **Untitled check box** — One of the following:  
  • Marks a sequence that you will disable, if selected in the Active table.  
  • Marks a sequence that you disabled and that you will restore or delete, if selected in the Archive table.  
| **Name** | The Modify ( ) button and the name of the sequence that the corresponding row describes. Values in the name column are the basis by default for how DMM-VPM sorts the rows, but you can click the heading in any other column to re-sort the rows by the values in that column. If you click the Edit button, DMM-VPM loads a page where you can edit metadata, such as the name and description, for the sequence that the corresponding row describes.  
| **Date Added** | The date and time when the sequence was created.  
| **Last Modified** | The date and time when the sequence was last edited.  
| **Active Interstitials** | Shows the Active Interstitials ( ) button and the Add New Interstitial ( ) button. If you click the Active Interstitials button, DMM-VPM loads a page where you can add interstitials to the playlist that the corresponding row describes or mark interstitials to remove from the playlist.  
| **Deployment Choice** | Says whether the sequence that the corresponding row describes is the default sequence for deployments.  
| **Metadata attributes that define the sequence. Enter or select the metadata after you click Add New Interstitial Sequence or after you click the Edit button for a sequence. To save your work, click Save.** |  
| **Name** | The name for this sequence. Enter a maximum of 50 characters.  
| **Description** | Enter a description that is meaningful to you. You must enter the description. Enter a maximum of 2,000 characters.  
| **Status** | Active or Inactive. If you select Active, your audiences see the sequence. If you select Inactive, the sequence is not visible to your audiences. The default is Active.  
| **Make this sequence default choice for deployments?** | Yes or No. To use this sequence by default when your Video Portal is not showing anything else, select Yes. Otherwise, select No.  

### Creating and Working with Tickers

In DMM-VPM, a ticker is scrolling text that your Video Portal shows to your audiences.

**Step 1** Select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2** Select **Video Portal > Tickers**.

On the Tickers page, you can toggle between two tables that are mostly very similar and that both show a list of tickers. You can move tickers from one table to the other.

**Step 3** Do one of the following:

- Click **Active** to see in the Active table a list of all the tickers that are available. These tickers are active in the sense that you have not disabled them. If you have not created any tickers or if you archived every ticker, the table is empty.
- Click **Archive** to see in the Archive table a list of all the tickers that you have disabled temporarily. These tickers are disabled in the sense that your audience will not see them. You might choose eventually to restore or delete these tickers.

**Step 4** Enter the values that meet your requirements, as described in Table 4-12 on page 4-32.

**Step 5** Click **Save**.

## Ticker Settings

Table 4-12 describes the elements and settings for configuring tickers.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Defaults</td>
<td>Stops your Video Portal from playing any ticker.</td>
</tr>
<tr>
<td>Add New Ticker</td>
<td>Shows the Add New Ticker page.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the tickers that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived ticker that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the tickers that you selected.</td>
</tr>
</tbody>
</table>

**Columns**

- **Untitled check box** — One of the following:
  - Marks a sequence that you will disable, if selected in the Active table.
  - Marks a sequence that you disabled and that you will restore or delete, if selected in the Archive table.

- **Name** — The Modify ( ) button and the name of the ticker that the corresponding row describes. Values in the name column are the basis by default for how DMM-VPM sorts the rows, but you can click the heading in any other column to re-sort the rows by the values in that column. If you click the Edit button, DMM-VPM loads a page where you can edit the ticker that the corresponding row describes.

- **Launch Date** — The date and time when the ticker should start.

- **Expiration Date** — The date and time when the ticker should stop and should no longer be visible in your Video Portal.

- **Deployment Choice** — Says whether the ticker that the corresponding row describes is the default ticker for deployments.
Using Features Under the Video Portal Tab

Chapter 4      Managing Desktop Video

Customizing Your Video Portal

DMM-VPM helps you to control and customize the user interface colors that your audiences see when they use your Video Portal. You can customize the coloration of backgrounds, logos, ticker messages, interstitials, and controls.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>{Add New Ticker</td>
<td>Modify Ticker}</td>
</tr>
<tr>
<td>Ticker Name</td>
<td>The name for this ticker. Enter a maximum of 50 characters.</td>
</tr>
<tr>
<td>Ticker Description</td>
<td>Enter a description that is meaningful to you. You must enter the description. Enter a maximum of 2,000 characters.</td>
</tr>
<tr>
<td>Ticker Text</td>
<td>Enter the text that the ticker should show on your Video Portal. Enter a maximum of 2,000 characters. The text that you enter will scroll across the bottom of your Video Portal.</td>
</tr>
<tr>
<td>Ticker Status</td>
<td>Active or Inactive. If you select Active, your audiences see the ticker. If you select Inactive, the ticker is not visible to your audiences. The default is Active.</td>
</tr>
<tr>
<td>Launch Date</td>
<td>Select the month, day, and year when your Video Portal should start the ticker.</td>
</tr>
<tr>
<td>Make this ticker default choice for deployments?</td>
<td>Yes or No. To show this ticker by default on your Video Portal, select Yes. Otherwise, select No.</td>
</tr>
<tr>
<td>End of Life Date</td>
<td>Select the month, day, and year when your Video Portal should stop the ticker.</td>
</tr>
</tbody>
</table>

Table 4-12        Elements for Configuring Tickers (continued)

Step 1 Select Video Portal from the untitled list at the top far-right of any page.

Step 2 Select Video Portal > User Interfaces.

On the User Interfaces page, you can toggle between two tables that are mostly very similar and that both show named sets of user interface customizations. You can move sets from one table to the other.

Step 3 Do one of the following:

- Click Active to see in the Active table a list of all the customization sets that are available, meaning that you have not disabled them. If you have not created any customization sets or if you archived every set, the table is empty.

- Click Archive to see in the Archive table a list of all the customization sets that you have disabled temporarily. These customizations are disabled in the sense that your audience will not see them. You might choose eventually to restore or delete these customization sets.

Step 4 Enter the values that meet your requirements, as described in Table 4-13 on page 4-34.

Step 5 Click Save.
Customization Settings

Table 4-13 describes the elements and settings that you configure to customize the Video Portal.

**Table 4-13   Elements for Customizing the Video Portal**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add New Interface</td>
<td>Shows the Add New Interface page, described elsewhere in this topic.</td>
</tr>
<tr>
<td>Archive Selected</td>
<td>Moves from the Active table to the Archive table the customization sets that you selected.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Shows the Delete Confirmation page. See the instructions on that page that tell you how to delete the archived customization sets that you selected.</td>
</tr>
<tr>
<td>Activate Selected</td>
<td>Moves from the Archive table to the Active table the customization sets that you selected.</td>
</tr>
<tr>
<td><strong>columns</strong></td>
<td><strong>Untitled check box</strong> — One of the following:</td>
</tr>
<tr>
<td></td>
<td>• Marks a customization set that you will disable, if selected in the Active table.</td>
</tr>
<tr>
<td></td>
<td>• Marks a customization set that you disabled and that you will restore or delete, if selected in the Archive table.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The Modify ( ) button, the Preview ( ) button, and the name of the customization set that the corresponding row describes. Values in the name column are the basis by default for how DMM-VPM sorts the rows, but you can click the heading in any other column to re-sort the rows by the values in that column. If you click the Edit button, DMM-VPM loads a page where you can edit the customization set that the corresponding row describes. If you click the Preview button, your Video Portal shows to you the customization set that the corresponding row describes, so you can confirm that the customizations work as you expect them to before you deploy them to your Video Portal.</td>
</tr>
<tr>
<td><strong>Date Added</strong></td>
<td>The date and time when the customization set was created.</td>
</tr>
<tr>
<td><strong>Last Modified</strong></td>
<td>The date and time when the customization set was last edited.</td>
</tr>
<tr>
<td><strong>Deployment Choice</strong></td>
<td>Indicates whether the customization that the corresponding row describes is the default Video Portal user interface for deployments.</td>
</tr>
</tbody>
</table>
### Table 4-13  Elements for Customizing the Video Portal (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tip</strong></td>
<td>This row describes elements that you see in the <em>Required Items</em> area where you must enter or select values to add or edit a Video Portal user interface. For descriptions of other, optional values, see the next row. Attributes of the user interface. Enter or select these values after you click Add New Interface or after you view properties of a customized user interface. To save your work, click <strong>Save</strong>.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The name for this set of customizations. Enter a maximum of 50 characters.</td>
</tr>
<tr>
<td><strong>Background Image</strong></td>
<td>The nonprogressive JPEG file that serves as the background image. The file that you select should be 720 pixels wide by 540 pixels high, and should not distract or detract from the content that you want to emphasize. To upload a new image, click <strong>Upload New Background Image File</strong>. Alternatively, to select a factory-default image or a file that you uploaded previously, click <strong>Existing Images</strong>. <em>Video Portal Colors</em> — Hexadecimal color values and contrast scale values for the public user interface on your Video Portal. Enter hexadecimal color values and contrast scale values for the background panel, tab text, and listing text, as well as the buttons and sliders. Alternatively, to make selections from palettes and see a preview of them in real time, click <strong>Preview Colors</strong>. The color-picker popup window includes a dynamic preview pane that shows the effect of your color and contrast selections in real time, exactly as audience members will see them if you use them on your Video Portal. To select colors and make selections for Video Portal user interface subcomponents, click **{Panel Background Color</td>
</tr>
<tr>
<td><strong>Interface Idle Duration</strong></td>
<td>In seconds, the idle time that you allow after any one of your scheduled shows has stopped before your Video Portal starts to show (and loop) interstitials.</td>
</tr>
<tr>
<td><strong>Make this template default choice for deployments?</strong></td>
<td>Yes or No. To show this user interface customization set by default on your Video Portal, select Yes. Otherwise, select No.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Active or Inactive. If you select Active, you can select the customization set as one for your audiences to see. If you select Inactive, the customization set is not selectable as one that your audiences might see. The default is Active.</td>
</tr>
</tbody>
</table>
Table 4-13  

**Elements for Customizing the Video Portal (continued)**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
</table>
| [Add New | Modify] Interface | **Tip** This row describes elements that you see in the Optional Items area where you can enter or select optional values while you add or edit a Video Portal user interface. For descriptions of the other, required values, which you must enter, see the previous row. Attributes of the user interface. Enter or select these values after you click Add New Interface or after you view properties of a customized user interface. To save your work, click **Save**. **Description**—Enter a description that is meaningful to you. You must enter the description. Enter a maximum of 2,000 characters. **Header Logo**—The nonprogressive JPEG file that serves as the logo for your Video Portal. The file that you select should be 470 pixels wide by 60 pixels high. The tabbed area on your Video Portal will cover and hide the lower right quarter of the image, so we recommend that quadrant not contain anything important. It is optional to use a logo. Do one of the following:  
  • To upload a logo file that you have never uploaded, click **Upload new Header Logo file**.  
  • To reuse a logo file that you uploaded previously for use in another customization set, click **Existing Images**.  
  • If you click **Check** to confirm your selection to use the logo, you see one of the following messages:  
    - “Field is blank”—You have not entered any path.  
    - “File Path Does Not Exist”—You entered an invalid path.  
    - “File Path exists”—The path that you entered points correctly to a valid file. **Interface Links**—As many as three web links that your Video Portal should show:  
  • **Link Text**—The clickable text to show. Enter a maximum of 17 characters.  
  • **URL**—The HTTP URL for the clickable text.  
  • If you click **Check** to confirm that a URL is valid, you see one of the following messages:  
    - “URL is blank”—You have not entered any URL.  
    - “Server was not found”—You entered an invalid URL.  
    - “URL exists”—The URL that you entered points correctly to a valid file. |

1. Hexadecimal color values in SWF files do not always match exactly the same hexadecimal color values in other file types. If your organization uses precise color values as part of its branding strategy, you might have to adjust the colors slightly for SWF files to see the intended result.

### Configuring the Settings to Manage Deployments

You must deploy all additions, updates, and other changes in your content and data. You can deploy immediately or schedule deployments in advance for any time and date. You can cancel any deployment that you schedule.

**Note** You do not need to deploy video parts when you make changes to access restrictions. These changes take effect immediately.
After you schedule a deployment, the Currently Scheduled Deployments table is refreshed and shows the new deployment that you scheduled, in its chronological sequence relative to any other scheduled deployments. DMM-VPM then deploys the job to the deployment location that you specified under the Setup tab (see the “Configuring the Location Settings for Deployments” section on page 4-5). After a deployment is finished, the Currently Scheduled Deployments table is refreshed again, so it no longer includes any description of the deployment.

This section contains the following topics:
- Understanding Event Types, page 4-37
- Scheduling a New Deployment, page 4-38
- Scheduling a Pre-Event Listing, page 4-39
- Scheduling a Live Event, page 4-40
- Scheduling a Post-Event Listing, page 4-40
- Scheduling an On-Demand Deployment, page 4-41
- Learning the URL for a Deployed Video Part, page 4-41

### Understanding Event Types

Live event offerings differ from on-demand offerings in the following ways:

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| Live events         | Live events are scheduled to start and stop at a fixed date and time. After a live event starts, audience members who connect late see the event in progress and cannot see what came before. Each audience member sees the same thing at the same time as other audience members. Audience members cannot see a live stream before the event starts, go backward, or skip ahead. When a live event stops, it is no longer available to anyone. For information about the differences between the Live Event and Non-DME Live Event options, see the “Add New Video Part | Modify Video Part” section in Table 4-6 on page 4-10. You can record a live event as it occurs, and then edit and upload the recording for on-demand access shortly thereafter. Live events are either **pushed** or **pulled**:

  - **Push** — The encoder pushes the live stream to a streaming server.
  - **Pull** — The streaming server pulls the live stream from an encoder.

**Tip** Using the Video Part page, you can upload a pre-event image and post-event image. These will appear in the video frame before and after the live event. Also, your encoder can simultaneously stream a live event and save it to a file. See the “Capturing a Live Stream and Publishing the Output File as Video On-Demand” section on page 4-44. |
| On-demand events    | You schedule on-demand events to become available at any date and time that you specify and to remain available for any span of hours or dates that you specify, depending on the freshness or relevance of the content. Any audience member can start at the beginning of an event, no matter when they see it. Likewise, any audience member can rewind, skip ahead, or jump to different parts of an event at any time, assuming that your Video Portal makes these video navigation controls available. As long as an on-demand offering is available, audience members can see it at any time. You can archive an on-demand event at any time; after you archive an event, no one in your audience can see it. |
Scheduling a New Deployment

To schedule a new deployment, complete the following steps:

Step 1  If you configured your browser to block popup windows, reenable popup windows now. You cannot complete this procedure successfully if your browser blocks popup windows.

Step 2  Select Video Portal from the untitled list at the top far-right of any page.

Step 3  Select Video Portal > Deployments.

The Currently Scheduled Deployments page lists all of the scheduled and queued deployments, as described in Table 4-15.

Table 4-15  Elements for Deployment Scheduling

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule New Deployments</td>
<td>Schedule a new deployment.</td>
</tr>
<tr>
<td>Scheduled Deployment</td>
<td>The date and time for which existing deployments are scheduled, listed in chronological order starting with the earliest deployment.</td>
</tr>
<tr>
<td>Date Added</td>
<td>The date and time when existing deployments were added to DMM-VPM.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel a deployment.</td>
</tr>
</tbody>
</table>

Step 4  Click Schedule New Deployment.

The ▼ Active ▼ Inactive ▼ Removed legend at the top of the page shows the real-time color-coding that DMM-VPM applies to entities in the list, based on change statuses:

- Active — Entities whose status has been changed to Active. All entities classified as Active are visible in the Video Portal after deployment.
- Inactive — Entities whose status has been changed to Inactive. All entities classified as inactive or removed disappear from the Video Portal after deployment.
- Removed — Entities that have been permanently deleted from DMM-VPM.

Step 5  In the “Video Part Selection” area, click a check box to select the corresponding video part.

DMM-VPM automatically lists for selection all new and modified video parts whose status is set to Active. Each video part is displayed with its corresponding videos and programs. All uploaded files, file references, and metadata associated to each Active video part are deployed with your selection. These files are deployed to the deployment location that you specified under the Setup tab.

Step 6  In the “Additional Items Included in Deployment” area, review any metadata changes that will be published with your deployment.

The following entities are identified in the Metadata Changes:

- Categories — All categories whose status has changed or that were deleted.
- Programs — All programs whose status has changed or that were deleted.
- Videos — All videos whose status has changed or that were deleted.

Step 7  In the “Global Options” area, make selections from the following lists:

- Featured Playlist — Select the playlist to publish on your Video Portal.
The list displays all Active Featured Playlists in alphabetical order by Featured Playlist Name with the Default Featured Playlist selected by default. There can only be one Featured Playlist visible in the Video Portal at any given time. See the “Creating and Working with Playlists” section on page 4-24.

- **User Interface**—Select the customization set to use on your Video Portal.
  
  The alphabetical list contains all Active user interfaces customization sets with the default customization set selected by default. There can only be one user interface visible in your Video Portal at any given time. See the “Customizing Your Video Portal” section on page 4-33.

- **Ticker**—Select the ticker to publish on your Video Portal.
  
  The list displays all Active tickers in alphabetical order by name with the default ticker selected by default. To hide the ticker, click *Don’t Show a Ticker*. You can use no more than one ticker at a time on your Video Portal. See the “Creating and Working with Tickers” section on page 4-31.

- **Interstitial Sequence**—Select the sequence to publish on your Video Portal.
  
  The list displays all Active Interstitial Sequences in alphabetical order by Interstitial Sequence Name with the Default Interstitial Sequence selected by default. There can only be one Interstitial Sequence visible in the Video Portal at any given time. See the “Creating and Working with Interstitial Sequences” section on page 4-30.

**Step 8**

In the “Deployment Time” area, select the deployment date and time, or check the **Schedule Immediately** check box. If you select a scheduled deployment, the default date is 7 days from today. Remember the following information:

- The relevant time zone is the one that you specified when you set up your DMM appliance. If an administrator set up your DMM appliance and you cannot guess what time zone is in effect at its deployment location, contact its system administrator.

- To conduct a live online event successfully, you must complete either three or four separate deployments in exactly the following sequence:
  
  1. Prepare the pre-event listing to tell Video Portal audience members about the upcoming live event, as described in the “Scheduling a Pre-Event Listing” section on page 4-39.
  2. Prepare the actual live event offering, as described in the “Scheduling a Live Event” section on page 4-40
  3. Prepare the post-event listing to tell Video Portal audience members that the live event has concluded and is no longer available, as described in the “Scheduling a Post-Event Listing” section on page 4-40.
  4. **(Optional)** Prepare the on-demand offering, which is a recorded version of the live event, as described in the “Scheduling an On-Demand Deployment” section on page 4-41.

**Step 9**

To save your work and schedule the deployment, click **Create Deployment**.

---

**Scheduling a Pre-Event Listing**

You can schedule a pre-event listing. We recommend that you use targeted e-mail messages or a web site to preannounce your live events. The notifications that you prepare can describe, for example, the event date and time, its subject matter, the speaker, and the moderator. A notification can also link directly to the pre-event listing on your Video Portal.

**Note**

Ensure that your video part metadata is set appropriately for a pre-event listing.
Using Features Under the Video Portal Tab

Chapter 4      Managing Desktop Video

Step 1  If you configured your browser to block popup windows, reenable popup windows now. You cannot complete this procedure successfully if your browser blocks popup windows.

Step 2  Complete Steps 1–6 in the “Scheduling a New Deployment” procedure on page 4-38.

Step 3  In the “Deployment Time” area, select the deployment date and time when your pre-event listing should become available on your Video Portal. The deployment date is by default today.

Note  The relevant time zone is the one that you specified when you set up your DMM appliance. If an administrator set up your DMM appliance and you cannot guess what time zone is in effect at its deployment location, contact the system administrator.

Step 4  To schedule the deployment, click Create Deployment.

Scheduling a Live Event

You can schedule a live event.

Note  Ensure that your video part metadata is set appropriately for a pre-event listing.

Step 1  If you configured your browser to block popup windows, reenable popup windows now. You cannot complete this procedure successfully if your browser blocks popup windows.

Step 2  Complete Steps 1–6 in the “Scheduling a New Deployment” procedure on page 4-38.

Step 3  In the “Deployment Time” area, select the deployment date and time when your live event should become available on your Video Portal. The default date is 7 days from today.

Note  The relevant time zone is the one that you specified when you set up your DMM appliance. If an administrator set up your DMM appliance and you cannot guess what time zone is in effect at its deployment location, contact the system administrator.

Tip  We recommend that your Video Portal show a countdown to the live event for 10-15 minutes and then replace the countdown with the audio-video stream when the live event actually starts.

Step 4  To schedule the deployment, click Create Deployment.

Scheduling a Post-Event Listing

You can schedule a post-event listing.

Note  Ensure that your video part metadata is set appropriately for a post-event listing.
Step 1 If you configured your browser to block popup windows, reenable popup windows now. You cannot complete this procedure successfully if your browser blocks popup windows.

Step 2 Complete Steps 1–6 in the “Scheduling a New Deployment” procedure on page 4-38.

Step 3 In the “Deployment Time” area, select the deployment date and time when the post-event listing should become available on your Video Portal. The default date is 7 days from today.

Note The relevant time zone is the one that you specified when you set up your DMM appliance. If an administrator set up your DMM appliance and you cannot guess what time zone is in effect at its deployment location, contact the system administrator.

Step 4 To schedule the deployment, click Create Deployment.

Scheduling an On-Demand Deployment

You can schedule an on-demand deployment.

Note Ensure that your video part metadata is set appropriately for an on-demand deployment.

Step 1 If you configured your browser to block popup windows, reenable popup windows now. You cannot complete this procedure successfully if your browser blocks popup windows.

Step 2 Complete Steps 1–6 in “Scheduling a New Deployment” procedure on page 4-38.

Step 3 In the “Deployment Time” area, select the deployment date and time when the on-demand deployment should become available on your Video Portal. The default date is 7 days from today.

Note The relevant time zone is the one that you specified when you set up your DMM appliance. If an administrator set up your DMM appliance and you cannot guess what time zone is in effect at its deployment location, contact the system administrator.

Step 4 To schedule the deployment, click Create Deployment.

Learning the URL for a Deployed Video Part

There is no need for you to navigate through your Video Portal to find a video part after you deploy it successfully because DMM-VPM links directly to it as a convenience to you. The link is not specific to any particular media format because your Video Portal determines automatically which format to deliver to each audience member according to his or her system configuration.

Step 1 Select Video Portal > Programs.

Step 2 Find the row that describes the relevant program, and click Active Videos ( ) in that row.

Step 3 Find the row that describes the relevant video, and click Active Video Parts ( ) in that row.

Step 4 Find the row that describes the relevant video part; then, do one of the following:
• To play the video part, click Preview ( ) in that row.
• To learn the actual URL for the video part, click Modify ( ) in that row, and click Show Direct Portal Link.

Using Features Under the Encoders Tab

Administrators and configuration managers use the features in the Encoders tab to manage DME 1000 and DME 2000 encoders in DMM-VPM.

This section includes the following topics:
• Adding an Encoder to DMM-VPM, page 4-42
• Testing the Ability to Publish Streams, page 4-43
• Capturing a Live Stream and Publishing the Output File as Video On-Demand, page 4-44
• Managing Push Configurations, page 4-45
• Creating and Working with Encoding Formats, page 4-46
• Managing Transcoding Jobs, page 4-47

Adding an Encoder to DMM-VPM

You can add an encoder to DMM-VPM.

Step 1  Set up and connect the encoder according to the procedures in its documentation.
Step 2  Select Video Portal from the untitled list at the top far-right of any page.
Step 3 Determine whether the encoder will push streams to the streaming server or the streaming server will pull streams from the encoder; then, complete the steps Table 4-16 on page 4-43, as needed.

**Table 4-16 Push and Pull Procedures**

<table>
<thead>
<tr>
<th>Stream Type</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Push</td>
<td>In push configurations, the encoder pushes streams to the streaming server. Push configurations apply only to Windows Media streams.</td>
</tr>
<tr>
<td></td>
<td><strong>Step 1</strong> Select <strong>Encoders &gt; Push Configurations</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>Step 2</strong> Enter the required values, including the streaming server URL and port number.</td>
</tr>
<tr>
<td></td>
<td><strong>Step 3</strong> Click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Pull</td>
<td>In pull configurations, the streaming server pulls streams from the encoder.</td>
</tr>
<tr>
<td>Step 1</td>
<td>Select <strong>Encoders &gt; Encoders and Pull Configurations</strong>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>If you do not know the encoder IP address or DNS-resolvable hostname, go to the encoder front panel, then select <strong>Menu &gt; Setup System &gt; Network &gt; 100 Mbit (or 1,000 Mbit) &gt; View Settings &gt; IP Address(es)</strong>.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Enter the encoder IP address or hostname in the <strong>Encoder IP Address/Hostname</strong> field. We recommend that you use a port number that is in the range from 6000 to 7000.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Click <strong>Discover Encoder</strong>. The button changes color and animates until the discovery process is finished.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Enter the encoder name and description in their respective fields. For example, you might identify or describe the owner, location, or purpose of the encoder, or enter exactly the serial number text from a sticker on the encoder chassis.</td>
</tr>
<tr>
<td>Step 6</td>
<td>Select options in the “Default Encoder Input Settings” area to choose the video input, audio input, and video input standard settings that you will use most often.</td>
</tr>
<tr>
<td>Step 7</td>
<td>Select <strong>Push</strong> or <strong>Pull</strong> as your most common method to publish live events, and do one of the following:</td>
</tr>
<tr>
<td></td>
<td>• If you selected Push, select an option from the <strong>Default Push Configuration</strong> list to choose the default push configuration for this encoder. Alternatively, click <strong>Add New Push Options Here</strong> (see the “Managing Push Configurations” section on page 4-45).</td>
</tr>
<tr>
<td></td>
<td>• If you selected Pull, click <strong>Add a Pull Configuration</strong> to add the streaming server pull configurations for this encoder.</td>
</tr>
<tr>
<td></td>
<td>When you select Pull, DMM-VPN automatically creates a pull configuration called “test only (encoder-direct, port 6990),” which you can use to test streams that originate directly from the encoder.</td>
</tr>
<tr>
<td>Step 8</td>
<td>To save your selections, click <strong>Save this Encoder</strong>. You should see a green box at the top of the page with the message “Successfully saved '{Encoder Name}'.”</td>
</tr>
</tbody>
</table>

**Testing the Ability to Publish Streams**

You can use DMM-VPN to test whether your encoder can publish a stream.

**Step 1** To see the encoder dashboard, select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2** Click the **Encoders** tab.
Using Features Under the Encoders Tab

Step 3  In the encoder selection tree, find the encoder that you want to test, click Expand Encoder (expand) to see the *ad hoc streaming controls* for it, and click Encoder Setup.

Step 4  From the Video Format list, select the bit rate that you want to test, and select the Publish as a Streaming Video check box.

Step 5  Select a Push publishing configuration or a Pull publishing configuration.

**Tip**  To test a stream directly from the encoder, select the test only (encoder-direct, port 6990) pull configuration.

Step 6  Confirm that a live video source is connected to your encoder; then, select the options from the following lists that match your video source:

- Video Input
- Audio Input
- Video Input Standard

Step 7  Click Start Encoder.

**Tip**  If the Start Encoder option is not visible, check the Stop Event date for the live event video part.

The button becomes animated and the animation continues until the encoder starts. A delay that ranges from 10 to 25 seconds is normal.

Step 8  After the encoder starts, click Close in the Encoder Setup window.

Step 9  Do either or both of the following to test the video stream:

- Click View Live Video. A popup window plays your current live stream.
- To test the video stream as a static image that is updated periodically, click Click to start preview. Your encoder serves the static image directly, independent of your streaming server.

Step 10  Click Stop Encoder.

Capturing a Live Stream and Publishing the Output File as Video On-Demand

Your encoder can capture and save a live stream as a file, which you can publish as video on-demand.

Step 1  Select Video Portal from the untitled list at the top far-right of any page.

Step 2  Click the Encoders tab to see the encoder dashboard.

Step 3  In the encoder selection tree, find the encoder that you will use, click Expand Encoder (expand) to see the *ad hoc streaming controls* for it, and click Encoder Setup.

Step 4  Select the Store as File check box; then, enter a filename for the saved file.

Step 5  Confirm that a live video source is connected to your encoder and select the options from the following lists that match your video source:

- Video Input
- Audio Input
• Video Input Standard

**Step 6**
Click **Start Encoder**.
The button becomes animated and the animation continues until the encoder starts. A delay that ranges from 10 to 25 seconds is normal.

**Step 7**
After the encoder starts, click **Close** in the Encoder Setup window.

**Step 8**
When you are ready to stop adding video from the stream to the output file that you are creating, click **Stop Encoder**.

**Note**
The VoD file is overwritten each time that you click the Start/Stop button.

**Step 9**
To retrieve the output file from your encoder, point your web browser to 
ftp://<encoder_IP_address>/AVFiles/Out.

**Step 10**
Right-click the filename in the directory listing and select the option to download the file.

**Step 11** *(Optional)*
Use third-party software to edit the file.

**Note**
If you use a third-party software to edit the VoD file, the slide synch commands that were created during the live event will be erased, and the slides will not be synchronized for the VoD.

**Step 12**
Before you can deliver the downloaded output file to your Video Portal audiences as a video on-demand offering, you must deploy it as a VoD video part. See the “Working with Programs, Videos and Video Parts” section on page 4-9, and the “Scheduling an On-Demand Deployment” section on page 4-41.

---

### Managing Push Configurations

You can manage push configurations, which apply only to Windows Media streams.

**Step 1**
Select **Video Portal** from the untitled list at the top far-right of any page.

**Step 2**
Select **Encoders > Push Configurations**.

**Step 3**
Enter the push configuration name and description in their respective fields.

**Tip**
The push configuration name that you enter now will be an option that you can select from a list before you start your encoder.

**Step 4**
Enter and confirm the other values:

- **Format**—Windows Media is the only supported option in this release.
- **Streaming Server Base URL**—Enter the base URL and port number for your streaming server.
- **Name of Publishing Point**—Enter the name of your Publishing Point.
- **Full Stream URL**—Confirm that the URL is the valid URL for your publishing point.
- **User ID and Password**—*(Optional)* Enter the username and password to push a stream to your streaming server if it requires authentication.
Creating and Working with Encoding Formats

An encoding format is a collection of settings to specify a particular combination of media type and video dimensions and to limit video bandwidth consumption and video quality.

DMM-VPM is preconfigured with the recommended encoding formats for your Video Portal. You can recognize these predefined and preferred formats in the Encoding Formats list when you first start to use DMM-VPM because it appends the word “default” to their names. If you select other encoding formats as your defaults, the “default” label no longer signifies that any encoding format is one that Cisco defined.

You can select only one default encoding format apiece for each supported media type. For example, you might select one encoding format as the default for Windows Media and a different encoding format as the default for Flash Video.

You can add or edit an encoding format.

Step 1  Select Video Portal from the untitled list at the top far-right of any page.

Step 2  Select Encoders > Encoding Formats, and do one of the following:

- To create and define a new encoding format, click Add a new Encoding Format.
- To edit an encoding format that you saved, click its name in the list.

Step 3  Enter or select the required values to define the encoding format:

- **Encoding Format Name**—Enter a unique and meaningful name for this encoding format.
- **Profile Description**—Enter a description.
- **Set as a Default Format**—Select the check box if DMM-VPM should use this encoding format automatically when you select the Use Default Streaming Settings option on the {Add New | Modify} Video Part page.
- **Format**—Click a radio button to select its corresponding media format as the one that this encoding format should use.
- **Dimensions**—Select an option from the list or select Custom to use dimensions that the list does not contain.
- **Pixel Proportion**—Standard (square pixel) is the correct choice for most applications.
- **Audio Capture {On | Off}**—Enable or disable audio capture.
- **Windows Media Capture Profiles**—Select an option to limit bandwidth usage.

Step 4  Click Save.
Managing Transcoding Jobs

Transcoding is a process of deriving digital media files that use one codec from digital media files that use a different codec; the source file is not changed or destroyed. Because codecs are typically lossy, you might notice that the fidelity of the output file is not as high as the fidelity of the source file.

Your encoders can transcode AVI and MPEG2 files into Windows Media files. You can use DMM-VPM to manage your transcoding jobs. We recommend that you schedule your transcoding jobs so that they do not run at the same time as any other encoder tasks, such as streaming a live event or saving a live stream to a file. A transcoding job might take as long as, or possibly longer than, the duration of the source file, depending on multiple factors that include which codecs you use.

Step 1
Copy the source file to your encoder.
   a. Plug a keyboard, mouse, and monitor into your encoder.
   b. Add the file to a USB 2.0 hard drive or flash drive.
   c. Use Windows Explorer to copy the source file from the USB drive to D:\AVFiles\In.

Step 2
Log in to DMM-VPM, and select Video Portal from the untitled list at the top far-right of any page.

Step 3
Select Encoders > Transcoding, and click Add a New Transcoding Task.

Step 4
Enter or select the required values to define the transcoding job:
   • Transcoding Task Name—Enter a unique and meaningful name.
   • Encoder Name—Select the encoder that will transcode the source file.
   • Start Date/Time—Select the date and time when the transcoding job should start.
   • Input Encoding Format—Select the media format that the source file uses (AVI or MPEG2).
   • Input Directory Path—Select Input - Local Encoder Drive.
      – Edit—Modify the input directory path.
      – Clone—Copy the input directory path so that you can modify and add it to the list.
      – Add a Path—Add a new input directory path to the list.
   • Input File Name—Enter the source filename. Do not include a path.
   • Output Encoding Format—Select a format that includes the word “transcode” in its title.
   • Output Directory Path—Select Output - Local Encoder Drive.
   • Output File Name—Enter the output filename, which must use WMV as its extension. Do not include a path.

Step 5
Click Save.

Tip
In the list, a color-coded icon next to the name of your transcoding job helps you to track its status. The icon is blue (scheduled or postponed); animated green (in progress); solid green (completed); or red (error). To learn more, mouse over the icon.

Step 6
To copy the output file from your encoder, do one of the following:
   • If you plugged a keyboard, mouse, and monitor into your encoder, use Windows Explorer to copy the output file from D:\AVFiles\Out to the USB drive.
Workflows for Setting Up Live Events

This section includes the following workflow checklists to help you set up live events:

- **Using Your DME 1000 or DME 2000 to Set Up a Live Event, page 4-49**
- **Modifying the Scheduled Times for DME Live Events, page 4-51**
- **Setting Up Live Events Using Third-Party Live Streams, page 4-52**

Point your web browser to `ftp://<encoder_IP_address>/AVFiles/Out`, right-click the filename in the directory listing, and select the option to download the file.
## Using Your DME 1000 or DME 2000 to Set Up a Live Event

Use the following checklist to guide you through the required tasks to use your DME 1000 or 2000 to set up live events.

<table>
<thead>
<tr>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Add a live event to DMM-VPM, and enter the required values by completing the following steps:</td>
</tr>
<tr>
<td>a. Select <strong>Video Portal</strong> from the untitled list at the top far-right of any page; then, click the <strong>Video Portal</strong> tab. The Video Portal Programs page appears.</td>
</tr>
<tr>
<td>b. Create or edit the program and the video that should include the live event, as described in the “Working with Programs, Videos and Video Parts” section on page 4-9.</td>
</tr>
<tr>
<td>c. In the Add New Video Part page, enter the following values:</td>
</tr>
<tr>
<td>- <strong>Type of Video</strong>—Select <strong>Live Event</strong>; you must use Windows Media as the video format.</td>
</tr>
<tr>
<td>- <strong>Encoder</strong>—From the list, select the encoder to use, then do <strong>one</strong> of the following: If you previously configured default streaming settings for the relevant encoder and those default settings are appropriate for this event, click <strong>Use Default Streaming Settings</strong>. If any of the default settings are <strong>not</strong> appropriate for this event or if you have not configured default settings for the relevant encoder, click <strong>Advanced Settings</strong>, and then make selections and enter values to define the settings for this stream:</td>
</tr>
<tr>
<td>- <strong>Encoding Format</strong>—From the list, select the method to use for encoding or transcoding the live stream.</td>
</tr>
<tr>
<td>- <strong>DME 2000 Input Channel</strong>—Click or.</td>
</tr>
<tr>
<td>- <strong>Publish via Push</strong>—Select whether the encoder should push the live stream to a streaming server.</td>
</tr>
<tr>
<td>- <strong>Publish via Pull</strong>—Select whether the streaming server should pull the live stream from the encoder.</td>
</tr>
<tr>
<td>- <strong>Video Input</strong>—From the list, select either <strong>Composite</strong> or <strong>SVideo</strong>.</td>
</tr>
<tr>
<td>- <strong>Audio Input</strong>—Select the option to use balanced or unbalanced audio in the live stream.</td>
</tr>
<tr>
<td>- <strong>Video Input Standard</strong>—From the list, select the standard that is relevant to your country and the equipment that you use.</td>
</tr>
<tr>
<td>- <strong>Store as a File</strong>—Select the check box to enable automatic archiving or deselect the check box to disable automatic archiving.</td>
</tr>
<tr>
<td>- <strong>Storage Bookmark</strong> and <strong>File Name</strong>—To later deploy the event as a VoD, select from the list the location on the encoder to store the file, and enter the filename, specifying .wmv as the file type.</td>
</tr>
<tr>
<td>- <strong>Play Order in Video</strong>—From the list, select where in the video to show this video part.</td>
</tr>
<tr>
<td>- <strong>Release Date/Time</strong> and <strong>End of Life Date/Time</strong>—Enter a date in the format shown or click Show Calendar to select a date from a calendar. Then, select the hour, the minute, and AM or PM. You must explicitly enter the End of Life Date/Time value. DMS does not obtain it automatically from the Release Date/Time value. If you do not enter a End of Life Date/Time value, your live event will not occur.</td>
</tr>
<tr>
<td>- <strong>Duration</strong>—Indicates the duration of the live event, based on the start and stop times that you set.</td>
</tr>
</tbody>
</table>
Workflows for Setting Up Live Events

### Chapter 4  Managing Desktop Video

#### Task

2. **(Optional)** In the Add New Video Part page, enter or select these additional values:
   - **Preview Content File URL** — The location of a SWF file or nonprogressive JPEG file (100 pixels wide and 75 pixels high, or any proportionate multiple of those dimensions) that your Video Portal should show as the preview image for this video part. To select and upload a local file, click **Upload new preview video file**. If you use a SWF file, we recommended that you program it to pause after 10 seconds and not loop.
   - **{Pre-Event | Post-Event} JPEG URL** — Upload the JPEG image to show before or after the live event.
   - **Enable Questions from the Audience** — Click **On** or **Off** to enable or disable support for questions.
   - **Slide Show** — Select and upload the SWF file or ZIP archive of slides to show next to the video stream.
   - **Preview Description** — A text description that your Video Portal shows to your audiences but truncates after 160 characters. If you do not enter a preview description, your Video Portal shows the first 160 characters from the video part description instead.
   - **Keywords** — Descriptive words to make this video part searchable on your Video Portal.

3. Save your configuration entries for the live event and show a program listing for it, as follows:
   - a. Click **Save**.
   - b. When you want your Video Portal to show a program listing for this live event, see the deployment instructions in the “Scheduling a New Deployment” section on page 4-38.

4. Test the live stream and start the live event by completing the following steps:
   - **Note** To modify the time of a live event, see the “Modifying the Scheduled Times for DME Live Events” section on page 4-51.
   - a. Approximately 30 minutes before the live event, click the **Encoders** tab. The Encoder Dashboard page appears.
   - b. In the encoder selection tree, find the encoder that you will use for this live event, and then click **Expand Encoder** to see the ad hoc streaming controls for the encoder.
   - c. Click **Encoder Setup**, enter the relevant values, click **Start Encoder** and wait 10-to-20 seconds for it to start. The Start or Stop Encoder button starts or stops the VoD file creation, and you can start or stop the encoder multiple times to adjust cameras, test connections, and so on.
   - **Caution** Each time that you start or stop the encoder, you overwrite the existing file. To save the file, you must rename it before you start the encoder again.
   - d. After an encoder setup message confirms that the encoder started, click **Close**.
   - e. To open a preview window that shows the live stream from your encoder, click **View Live Video**. If you see the live stream, your streaming server is successfully streaming output from the encoder.
   - f. When you are ready for the live event to start, click **Start Broadcast**. The Start Broadcast button makes the stream visible on the Video Portal and replaces the pre-event graphic. Approximately 5-to-20 seconds after you start the broadcast, the live stream should start for anyone who selected to see it.
   - g. When you are ready to end the event, click **Stop Broadcast**, and then click **Stop Encoder**. The Stop Broadcast button replaces the video stream with the post-event graphic, and the Stop Encoder button stops the VoD file creation.
   - **Tip** If you stop the broadcast accidentally or too soon, but the encoder is still running, click **Start Broadcast** to start showing the live stream again.
Modifying the Scheduled Times for DME Live Events

Use this procedure to modify the Release Date/Time on existing video parts for DME live events.

Before You Begin
Stop the encoder before you modify a pre-defined live event video part.

Procedure

1. In DMM-VP, click Video Portal > Programs.
2. Locate the Program and navigate to the Active Video Part for the live event.
3. Click Modify next to the name of the video part.
4. Change the Release Date/Time and click Save.
5. Click Video Portal > Deployments and schedule new deployment of the video part.
6. Thirty minutes before the event, test the live stream. For information about testing, see the “Using Your DME 1000 or DME 2000 to Set Up a Live Event” section on page 4-49.
### Setting Up Live Events Using Third-Party Live Streams

Use the following checklist to guide you through the required tasks to use streams from a third-party encoder to set up live events.

<table>
<thead>
<tr>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Create a pre-event listing to notify your audience about the upcoming event offering, as described in the “Scheduling a Pre-Event Listing” section on page 4-39.</td>
</tr>
<tr>
<td>2. Show the actual live offering, as described in the “Scheduling a Live Event” section on page 4-40. In the “Add New Video Part” page where you configure the metadata attributes for this video part, you must select Non-DME Live Event because the Live Event option is reserved for use with the Cisco Digital Media Encoder 1000 and Digital Media Encoder 2000. Then, you must deploy this video part before the start at the event. For a Non-DME Live Event to be visible on the Video Portal, you must also click Start the Broadcast on the video part page. The offering should include information for end users to use during the live event, such as an agenda or downloadable materials.</td>
</tr>
<tr>
<td>3. (Optional) Create a post-event listing to notify your audience that they missed the event, and it is no longer available, as described in the “Scheduling a Post-Event Listing” section on page 4-40.</td>
</tr>
<tr>
<td>4. (Optional) Publish a recorded copy of the event for delivery on demand to audience members who missed the live stream, as described in the “Scheduling an On-Demand Deployment” section on page 4-41.</td>
</tr>
</tbody>
</table>

**Note** We recommend that you schedule the live event to start 10-to-15 minutes before the published start date and time. It is customary to offer live “hold” music for users who attend the event early to indicate that the event will start soon.
Using Video Portal Reports

Tip

Features in Video Portal Reports are available to you if you purchased and installed the required license. For information about licensing, see Chapter 2, “Managing Administrative Settings for Cisco DMS Components and Users.”

Video Portal Reports software is preinstalled on your Video Portal appliance. It maintains a record for the number of page views, the number of video streams, the exact referrers, and the number of unique visitors per day.

- **Page view** — Any click in the Video Portal that causes the displayed information to change, but does not play a video stream or change a playlist.
- **Video stream** — Any click of the Play button in your Video Portal.
- **Unique visitor** — The total number of browser cookies in use on any particular day. Each browser that loads your Video Portal receives a browser cookie for tracking purposes. Any day when a browser connects to your Video Portal, it is a unique visitor on that day. Even if a browser reconnects multiple times in one day, your Video Portal counts it as only one unique visitor on that day.
- **Referrer** — The HTTP URL for whatever page was active in a browser immediately before the browser loaded your Video Portal.

Before You Begin

- Video Portal Reports uses *scalable vector graphics* in its charting. For browser requirements to use Video Portal Reports, see the *Release Notes for Cisco Digital Media System 5.0* on Cisco.com.
- Records of VOD and live events are not included in reports until they are viewed in the Video Portal.

Procedure

**Step 1**
To see a report, point your browser to `http://<video_portal_IP_address>:8080/CvpMetrics/`.

**Step 2**
If user authentication is enabled and Video Portal Reports prompts you to log in, enter your login credentials and log in.
If you are confident that you entered your login credentials correctly, but an error message tells you, “You entered an invalid username or password, or your password has expired. Please try again,” we recommend that you contact the administrator for your LDAP server. It is possible that your Video Portal Reports user account is derived from an LDAP user account for which you are required to use a unique and dynamically generated password each time that you log in.

**Step 3**  Click the link that loads a particular type of report. In many cases, you can use the “Export” feature to export a table to a spreadsheet and save it in a file. In many graphs, you can mouse over a graph point to see an exact count.

**Table 0-1**

<table>
<thead>
<tr>
<th>Site-Wide Traffic</th>
<th>Any of these:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Summary</strong> — A line graph and table that cross-correlates page views, unique visitors, and video streams.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Page Views</strong> — A line graph and table that correlates dates with traffic levels.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unique Visitors</strong> — A line graph and table that correlates dates with the number of unique visitors.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Video Streams</strong> — A line graph and table that correlates dates with the number of streams.</td>
</tr>
<tr>
<td></td>
<td><strong>Referrers</strong> — A list of all HTTP URLs for the pages that were active in browsers immediately before they loaded your Video Portal, sorted by the number of browsers that each page delivered to you. Click a URL to see the corresponding page in your browser.</td>
</tr>
<tr>
<td></td>
<td><strong>User System Info</strong> — A bar graph that shows how many visitors used particular browsers, particular operating systems, and particular plugins when they used your Video Portal.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Per-Video Traffic</th>
<th>Any of these:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Video Streams</strong> — A line graph and table that correlates dates with the number of streams.</td>
</tr>
<tr>
<td></td>
<td><strong>Page Views</strong> — A line graph and table that correlates dates with traffic levels.</td>
</tr>
<tr>
<td></td>
<td><strong>More Info</strong> — Shows how many Video Portal visitors clicked More Info. You can specify a particular video stream to filter the results.</td>
</tr>
</tbody>
</table>

**Step 4**  Enter or select the range of dates that the report should describe.

**Step 5**  Click **Go**.